VC5090 Vehicle Computer
Product Reference Guide
© 2015 ZIH Corp

No part of this publication may be reproduced or used in any form, or by any electrical or mechanical means, without permission in writing from Zebra. This includes electronic or mechanical means, such as photocopying, recording, or information storage and retrieval systems. The material in this manual is subject to change without notice.

The software is provided strictly on an “as is” basis. All software, including firmware, furnished to the user is on a licensed basis. Zebra grants to the user a non-transferable and non-exclusive license to use each software or firmware program delivered hereunder (licensed program). Except as noted below, such license may not be assigned, sublicensed, or otherwise transferred by the user without prior written consent of Zebra. No right to copy a licensed program in whole or in part is granted, except as permitted under copyright law. The user shall not modify, merge, or incorporate any form or portion of a licensed program with other program material, create a derivative work from a licensed program, or use a licensed program in a network without written permission from Zebra. The user agrees to maintain Zebra’s copyright notice on the licensed programs delivered hereunder, and to include the same on any authorized copies it makes, in whole or in part. The user agrees not to decompile, disassemble, decode, or reverse engineer any licensed program delivered to the user or any portion thereof.

Zebra reserves the right to make changes to any software or product to improve reliability, function, or design.

Zebra does not assume any product liability arising out of, or in connection with, the application or use of any product, circuit, or application described herein.

No license is granted, either expressly or by implication, estoppel, or otherwise under any Zebra, intellectual property rights. An implied license only exists for equipment, circuits, and subsystems contained in Zebra products.

Warranty

Subject to the terms of Zebra’s hardware warranty statement, the VC5090 Vehicle Computer products are warranted against defects in workmanship and materials for a period of one year from the date of shipment. For the complete Zebra hardware product warranty statement, go to: http://www.zebra.com/warranty.
Revision History

Changes to the original manual are listed below:

<table>
<thead>
<tr>
<th>Change</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-01 Rev A</td>
<td>5/31/06</td>
<td>Initial release.</td>
</tr>
<tr>
<td>-02 Rev A</td>
<td>08/10/07</td>
<td>Updates including: Fusion 2.5, latest OS, AZERTY keyboard, mounting instructions, SCM and registry settings, maintenance release (BSP26).</td>
</tr>
<tr>
<td>-03 Rev. A</td>
<td>08/15/10</td>
<td>Add support for new built-in power supply and optional touch screen heater.</td>
</tr>
</tbody>
</table>
# Table of Contents

Warranty ............................................................................................................................................... ii  
Revision History .................................................................................................................................... iii  

## About This Guide

- Introduction ........................................................................................................................................... xiii  
- Documentation Set ............................................................................................................................... xiii  
- Configurations ....................................................................................................................................... xiv  
  - Software Versions ............................................................................................................................. xiv  
  - Chapter Descriptions ......................................................................................................................... xv  
  - Notational Conventions ....................................................................................................................... xv  
  - Related Documents and Software ....................................................................................................... xvi  
  - Service Information ............................................................................................................................ xvi  
    - Returning the Vehicle Computer for Service ................................................................................... xvii  

## Chapter 1: Getting Started

- Introduction ........................................................................................................................................... 1-1  
- Unpacking the VC5090 ........................................................................................................................ 1-1  
- Features ............................................................................................................................................... 1-2  
- Accessories ......................................................................................................................................... 1-4  

## Chapter 2: Installation

- Introduction ........................................................................................................................................... 2-1  
- Installing the Desiccant Door ............................................................................................................. 2-1  
- Installing the Optional UPS ............................................................................................................... 2-2  
- Installing a Memory Card ..................................................................................................................... 2-3  
- Installing the Mounting Bracket ......................................................................................................... 2-4  
- Installing the VC5090 in a Forklift ..................................................................................................... 2-5  
  - Positioning the Vehicle Computer ................................................................................................... 2-5  
  - Mounting the Vehicle Computer ..................................................................................................... 2-7  
    - Mounting Bracket Template ........................................................................................................... 2-8  
    - Mounting onto an Over-Head Cross-Beam Example ................................................................... 2-9  
    - Mounting onto an Over-Head Cage Example ............................................................................. 2-10
Chapter 3: Operating the VC5090

Introduction .......................................................................................................................... 3-1
Quick Access Panel .............................................................................................................. 3-1
  Power Button ..................................................................................................................... 3-1
  Power LED ......................................................................................................................... 3-2
  COMM LED ....................................................................................................................... 3-2
  Backlight Control Button ................................................................................................. 3-3
  Programmable (“P”) Keys ............................................................................................... 3-3
    Launch Application ........................................................................................................ 3-4
    Simulate KeyPress .......................................................................................................... 3-4
    Play Key Sequence ........................................................................................................ 3-5
Using the Keyboard .............................................................................................................. 3-5
  Keyboard Functionality .................................................................................................... 3-5
  Soft Keyboards ............................................................................................................... 3-6
Adjusting the Brightness ..................................................................................................... 3-9
  Controlling Screen Brightness ......................................................................................... 3-9
  Controlling Keyboard Backlight ..................................................................................... 3-10
Chapter 4: Wireless Applications

Introduction ................................................................. 4-1
Signal Strength Icon .................................................... 4-2
Turning the WLAN Radio On and Off ......................... 4-2
  With Fusion 2.0 ......................................................... 4-2
  With Fusion 2.5 ......................................................... 4-3
Find WLANs Application .............................................. 4-4
Profile Editor Wizard .................................................... 4-5
  Profile ID ................................................................. 4-5
  Operating Mode ....................................................... 4-6
  Ad-Hoc ................................................................. 4-7
  Authentication ......................................................... 4-8
  Tunneled Authentication ......................................... 4-9
  User Certificate Selection ....................................... 4-11
    User Certificate Installation .................................. 4-11
  Server Certificate Selection ................................... 4-11
  Credential Cache Options ....................................... 4-12
    User Name ........................................................ 4-14
  Password ............................................................ 4-15
  Advanced Identity ................................................. 4-15
  Encryption .......................................................... 4-16
    Key Entry Page ................................................. 4-17
    Passkey Dialog ................................................. 4-17
  IP Mode .............................................................. 4-18
  IP Address Entry .................................................. 4-18
  Transmit Power ..................................................... 4-19
  Battery Usage ....................................................... 4-21
  Manage Profiles Application ................................. 4-22
## Chapter 5: Using Bluetooth

**Introduction** .................................................. 5-1

**Adaptive Frequency Hopping** .................................. 5-1

**Security** .......................................................... 5-2

**Turning the Bluetooth Radio Mode On and Off** .................. 5-2

  - **Disabling Bluetooth** ........................................... 5-2
  - **Enabling Bluetooth** ........................................... 5-2

**Bluetooth Power States** ........................................... 5-3

  - **Cold Boot** ...................................................... 5-3
  - **Warm Boot** ...................................................... 5-3
  - **Suspend** .......................................................... 5-3
  - **Resume** .......................................................... 5-3

**Bluetooth Profiles** ............................................... 5-3

**Modes** ............................................................. 5-5

  - **Wizard Mode** .................................................. 5-5
  - **Explorer Mode** ................................................ 5-7

**Discovering Bluetooth Device(s)** ................................. 5-8

  - **Bonding with Discovered Device(s)** ...................... 5-9
Chapter 6: ActiveSync

Introduction ........................................................................................................................................... 6-1
Installing ActiveSync ............................................................................................................................... 6-2
Mobile Computer Setup ........................................................................................................................... 6-2
Setting Up an ActiveSync Connection on the Host Computer ................................................................. 6-3
  Setting up a Partnership .......................................................................................................................... 6-3

Chapter 7: Application Development and Deployment

Introduction .................................................................................................................................................. 7-1
Software Installation on Development PC (Application Development) ....................................................... 7-1
  Device Configuration Package .................................................................................................................. 7-1
  Platform SDK ......................................................................................................................................... 7-2
  Enterprise Mobility Developer Kit ........................................................................................................ 7-2
  Installing Other Development Software ............................................................................................... 7-3
Software Installation on Vehicle Computer ............................................................................................... 7-3
  ActiveSync ........................................................................................................................................... 7-3
  SD Card .................................................................................................................................................. 7-4
  IPL .......................................................................................................................................................... 7-4
Creating and Loading Hex Images ............................................................................................................... 7-6
  Starting Terminal Configuration Manager ............................................................................................. 7-6
Appendix B: Software Configuration

Introduction ................................................................................................................. B-1
Wavelink TelnetCE ...................................................................................................... B-1
Citrix ICA Client ........................................................................................................ B-1
Setting Up Remote Desktop Client in AppCenter ....................................................... B-2
Disabling the VC5090 Heater ..................................................................................... B-3
Scanning through Remote Desktop ............................................................................ B-3

Chapter 8: Staging and Provisioning

Introduction .................................................................................................................. 8-1
Rapid Deployment (RD) Client ..................................................................................... 8-1
AirBEAM Smart Client ................................................................................................. 8-1
MSP 3 Agent ................................................................................................................ 8-1

Chapter 9: Maintenance and Troubleshooting

Introduction .................................................................................................................. 9-1
Maintaining the Vehicle Computer ............................................................................. 9-1
Returning the Vehicle Computer for Service .............................................................. 9-2
Troubleshooting ......................................................................................................... 9-2

Appendix A: Specifications

Technical Specifications ............................................................................................. A-1
Vehicle Computer ....................................................................................................... A-1
Vehicle Computer Connectors .................................................................................... A-3

Appendix B: Software Configuration

Introduction .................................................................................................................. B-1
Wavelink TelnetCE ...................................................................................................... B-1
Citrix ICA Client ........................................................................................................ B-1
Setting Up Remote Desktop Client in AppCenter ....................................................... B-2
Disabling the VC5090 Heater ..................................................................................... B-3
Scanning through Remote Desktop ............................................................................ B-3

Chapter 8: Staging and Provisioning

Introduction .................................................................................................................. 8-1
Rapid Deployment (RD) Client ..................................................................................... 8-1
AirBEAM Smart Client ................................................................................................. 8-1
MSP 3 Agent ................................................................................................................ 8-1

Chapter 9: Maintenance and Troubleshooting

Introduction .................................................................................................................. 9-1
Maintaining the Vehicle Computer ............................................................................. 9-1
Returning the Vehicle Computer for Service .............................................................. 9-2
Troubleshooting ......................................................................................................... 9-2

Appendix A: Specifications

Technical Specifications ............................................................................................. A-1
Vehicle Computer ....................................................................................................... A-1
Vehicle Computer Connectors .................................................................................... A-3

Appendix B: Software Configuration

Introduction .................................................................................................................. B-1
Wavelink TelnetCE ...................................................................................................... B-1
Citrix ICA Client ........................................................................................................ B-1
Setting Up Remote Desktop Client in AppCenter ....................................................... B-2
Disabling the VC5090 Heater ..................................................................................... B-3
Scanning through Remote Desktop ............................................................................ B-3
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Often Used Registry Settings</td>
<td>B-5</td>
</tr>
<tr>
<td>AutoHide Task Bar</td>
<td>B-5</td>
</tr>
<tr>
<td>Toggle Function Key</td>
<td>B-5</td>
</tr>
<tr>
<td>Toggle Shift Key</td>
<td>B-5</td>
</tr>
<tr>
<td>Power Suspend</td>
<td>B-6</td>
</tr>
<tr>
<td>External Antenna</td>
<td>B-6</td>
</tr>
<tr>
<td>Ignition Timeout</td>
<td>B-7</td>
</tr>
<tr>
<td>Registry Values for P1/P2/P3 Keys</td>
<td>B-7</td>
</tr>
<tr>
<td>System Configuration Manager</td>
<td>B-9</td>
</tr>
<tr>
<td>File Types</td>
<td>B-9</td>
</tr>
<tr>
<td>User Interface</td>
<td>B-9</td>
</tr>
<tr>
<td>Menu Functions</td>
<td>B-10</td>
</tr>
<tr>
<td>Parameter State Indicators</td>
<td>B-11</td>
</tr>
<tr>
<td>Window Status Bar</td>
<td>B-12</td>
</tr>
<tr>
<td>File Deployment</td>
<td>B-12</td>
</tr>
</tbody>
</table>

Glossary

Index
# About This Guide

## Introduction

The VC5090 **Product Reference Guide** provides information about the VC5090 vehicle computer using Microsoft® Windows® CE 5.0 operating system and its accessories.

✔️ **NOTE** Screens and windows pictured in this guide are samples and can differ from actual screens.

## Documentation Set

The documentation set for the VC5090 is divided into guides that provide information for specific user needs.

- **VC5090 Quick Reference Guide** - describes how to install and use the VC5090 vehicle computer.
- **VC5090 Product Reference Guide** - provides an in-depth description on how to use and setup the VC5090 vehicle computer and its accessories.
- **Microsoft Application Guide** - describes how to use Microsoft developed applications that reside on the VC5090 vehicle computer.
- **Application Guide** - describes how to use Zebra developed applications available for the VC5090 vehicle computer.
- **SMDK Help File** - provides API information for writing applications.
Configurations

This guide covers the following configurations:

<table>
<thead>
<tr>
<th>Configuration</th>
<th>Radios</th>
<th>Display</th>
<th>Memory</th>
<th>Data Capture</th>
<th>OS</th>
<th>Keypad</th>
</tr>
</thead>
<tbody>
<tr>
<td>VC5090 Full Screen</td>
<td>WLAN: 802.11a/b/g WPAN: Bluetooth</td>
<td>12.1” SVGA color</td>
<td>128 MB SDRAM/128 MB NAND Flash</td>
<td>Optional Scanner</td>
<td>Windows CE 5.0 Professional</td>
<td>Optional USB QWERTY or AZERTY keyboard</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>and 64 MB NOR Flash</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VC5090 Half Screen</td>
<td>WLAN: 802.11a/b/g WPAN: Bluetooth</td>
<td>10.4” Half SVGA color</td>
<td>128 MB SDRAM/128 MB NAND Flash</td>
<td>Optional Scanner</td>
<td>Windows CE 5.0 Professional</td>
<td>Built-In QWERTY or AZERTY keyboard</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>and 64 MB NOR Flash</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Software Versions

This guide covers various software configurations and references are made to operating system or software versions for:

- OEM version
- Fusion version

**OEM Software**

To determine the OEM software version:

Tap Start > Settings > Control Panel > System Information icon > System tab.

![System Info](image)

**Fusion Software**

To determine the Fusion software version:

Tap Wireless Strength icon > Wireless Status > Versions.
Chapter Descriptions

Topics covered in this guide are as follows:

- **Chapter 1, Getting Started**, provides information on getting the vehicle computer up and running for the first time.

- **Chapter 2, Installation**, provides instructions for installing the vehicle computer in a forklift, on a wall or on a desktop. Provides instructions for installing accessories.

- **Chapter 3, Operating the VC5090**, explains how to use the vehicle computer. This includes instructions for powering on and resetting the vehicle computer, entering and capturing data.

- **Chapter 4, Wireless Applications**, provides instructions for using and configuring the mobile computer on a wireless network.

- **Chapter 5, Using Bluetooth**, explains how to use Bluetooth functionality on the vehicle computer.

- **Chapter 6, ActiveSync**, provides instructions for installing and configuring ActiveSync.

- **Chapter 7, Application Development and Deployment**, provides instructions for installing the Device Configuration Package (DCP) for the VC5090 and the SMDK for C on the host computer and downloading software files to the mobile computer.

- **Chapter 8, Staging and Provisioning**, provides instructions for staging and provisioning the vehicle computer.

- **Chapter 9, Maintenance and Troubleshooting**, includes instructions on cleaning and storing the vehicle computer, and provides troubleshooting solutions for potential problems during vehicle computer operation.

- **Appendix A, Specifications**, includes a table listing the technical specifications for the vehicle computer.

- **Appendix B, Software Configuration**, includes special configuration instruction for third party software used with the vehicle computer.

Notational Conventions

The following conventions are used in this document:

- “Vehicle computer” refers to the VC5090 series of vehicle computers.
• **Italics** are used to highlight the following:
  • Chapters and sections in this and related documents.

• **Bold** text is used to highlight the following:
  • Key names on a keyboard
  • Button names on a screen
  • Dialog box, window and screen names
  • Drop-down list and text box names
  • Check box and radio button names
  • Icons on a screen.

• Bullets (•) indicate:
  • Action items
  • Lists of alternatives
  • Lists of required steps that are not necessarily sequential.

• Sequential lists (e.g., those that describe step-by-step procedures) appear as numbered lists.

---

**Related Documents and Software**

The following documents provide more information about the VC5090 vehicle computers.

• **VC5090 Quick Reference Guide**, p/n 72-76346-xx

• **Application Guide**, p/n 72E-68197-xx

• **Microsoft Application Guide for Mobile and CE 5.0 User Guide**, p/n 72E-78456-xx

• **MSP 2.9 user’s Guide**, p/n 72E-91844-xx


• **Enterprise Mobility Developer Kit (EMDK) Help File**, p/n 72E-38880-03

• **Enterprise Mobility Developer Kits**, available at: [http://www.zebra.com/support](http://www.zebra.com/support)

• **Device Configuration Package for VC5090 (DCP for VC5090)**, available at: [http://www.zebra.com/support](http://www.zebra.com/support)

• **ActiveSync software**, available at: [http://www.microsoft.com](http://www.microsoft.com)

For the latest version of this guide and all guides, go to: [http://www.zebra.com/support](http://www.zebra.com/support).

---

**Service Information**

If you have a problem with your equipment, contact Zebra support for your region. Contact information is available at: [http://www.zebra.com/support](http://www.zebra.com/support).

When contacting support, please have the following information available:

• Serial number of the unit

• Model number or product name

• Software type and version number.
Zebra responds to calls by email, telephone or fax within the time limits set forth in support agreements.

If your problem cannot be solved by Zebra Support, you may need to return your equipment for servicing and will be given specific directions. Zebra is not responsible for any damages incurred during shipment if the approved shipping container is not used. Shipping the units improperly can possibly void the warranty.

If you purchased your business product from a Zebra business partner, contact that business partner for support.

### Returning the Vehicle Computer for Service

**NOTE**  
Zebra has taken great care to ensure environmental conditions such as humidity will not affect the stability of the vehicle computer. This is accomplished by means of desiccant bags which can be inserted by the user upon receipt of the vehicle computer. In the event, the vehicle computer needs to be shipped by air carrier to Zebra for repair or maintenance, it is essential that the user remove the desiccant door cover before the vehicle computer is packaged for shipment. The reason for this step is to avoid compromising the vehicle computer as a result of pressurization during air transit. The user must simply remove the screws associated with the desiccant door on the back of the unit. Discard the used desiccant bags. Upon receipt of the repaired vehicle computer, the user should insert new desiccant bags (if used) and reseal the doors using new screws.
Chapter 1 Getting Started

Introduction

The VC5090 vehicle-mounted mobile computer is a rugged device for use on heavy equipment, especially forklifts. Designed for distribution centers, factory floors and warehouses, the VC5090 supports real-time receiving, tracking, put-away, picking and shipping applications. Sealed to IP66 standards for protection against dust and water and shock-tested, the VC5090 offers reliable performance in the most extreme temperatures and environmental conditions. It tolerates sub-zero freezers, as well as the vibration and shock of forklift operations, increasing the reach of your enterprise solution.

The VC5090 consists of two configurations: a full-screen computer with optional keyboard and a half screen configuration with a integrated keyboard. Users can enter data using the touch screen, the keyboard, an optional bar code scanner, or a combination of these. The data is transmitted wirelessly to a host computer. The VC5090 features include:

- Ergonomic design with color LCD touch screen
- Internal wide-range power supply (10 - 72 VDC) to accommodate propane, gasoline, and electric-powered forklifts
- Internal antennas with external antenna port
- Interfaces for scanners, printers, audio devices and other peripherals
- Continuous operation at -30 °C (-22 °F)
- Optional touch screen heater for freezer applications
- Pre-loaded with terminal emulation software.

Unpacking the VC5090

When you remove the vehicle computer from its box, save the box and shipping material in case you need to ship or store the vehicle computer. Check the contents of the box against the invoice for completeness and contact your local Zebra service representative if there is a problem.

The VC5090 shipping box contains:

- vehicle computer
The VC5090 has the following features:

- integrated 802.11a/b/g wireless LAN radio
- Windows® CE 5.0 Professional Operating System
- Intel® PXA270 624 MHz CPU
- 128 MB SDRAM, 192 MB Flash (128 MB NAND Flash and 64 MB NOR Flash)
- 10.4" half-SVGA (800 x 320) or 12.1" full-SVGA (800 x 600) color display
- wireless and wired printing
- integrated antennas
- integrated speakers.
Figure 1-2 VC5090 (Half Screen) Front View

Display
Quick Access Panel
Power LED
Power Button
COMM LED
Backlight Control Button
Backlight Control LED
Keyboard

Figure 1-3 VC5090 Back View

UPS/Memory Card Door
Desiccant Door
Speaker
Antenna Port for Optional External Antenna
Main Power Switch
Speaker
Accessories

Table 1-2 lists the accessories available from Zebra for the VC5090:

<table>
<thead>
<tr>
<th>Accessory</th>
<th>Description</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>UPS</td>
<td>Battery used to maintain operation for at least 15 minutes, and then for</td>
<td>BTRY-VC50IAB00</td>
</tr>
<tr>
<td>Uninterruptable Power Supply</td>
<td>graceful shutdown when power is temporarily interrupted (for example:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>vehicle battery changes or poor power conditions).</td>
<td></td>
</tr>
<tr>
<td>Keyboards</td>
<td></td>
<td></td>
</tr>
<tr>
<td>External Keyboard</td>
<td>Optional USB QWERTY keyboard with 64 keys, backlit, IP66 sealed and heated</td>
<td>VC5090KYBD-02R</td>
</tr>
<tr>
<td></td>
<td>for full-screen configuration.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Optional USB AZERTY keyboard with 64 keys, backlit, IP66 sealed and heated</td>
<td>VC5090KYBD-03R</td>
</tr>
<tr>
<td></td>
<td>for full-screen configuration.</td>
<td></td>
</tr>
</tbody>
</table>
### Table 1-1  Accessories (Continued)

<table>
<thead>
<tr>
<th>Accessory</th>
<th>Description</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Cables</strong></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| LS3408 Scanner Serial Cable        | Coiled 9 ft. extended RS232 cable with rugged Amphenol connector. Recommended for Wavelink terminal emulation. Use to connect the following Zebra serial scanners to the VC5090 serial port:  
  • LS3408 laser scanner  
  • DS3408 imager  
  • LS3478 Bluetooth laser scanner (with cradle)  
  • DS3478 Bluetooth imager (with cradle). | 25-71917-02R         |
| LS3408 Scanner USB Cable           | Coiled 9 ft. extended USB cable with rugged Amphenol connector. Use to connect the following Zebra laser scanners or imagers to the VC5090 USB/Keyboard port:  
  • LS3408 laser scanner  
  • DS3408 imager  
  • LS3478 Bluetooth laser scanner (with cradle)  
  • DS3478 Bluetooth imager (with cradle). | 25-71918-01R         |
| Vehicle Power Cable                | DC power cable without filter. Use to replace a non-filtered power cable for connecting the VC5090 to the vehicle battery. Use with all VC5090 with built-in filtered power supply or for non-filtered VC5090 installed on vehicle/forklift with 12V battery. | 25-71919-03R         |
|                                   | DC power cable with filter  
  Use to replace a filtered power cable for connecting the VC5090 to the vehicle battery. Use with non-filtered VC5090 installed on electric-powered forklift with 24-48V battery. | 25-71919-04R         |
<p>|                                   | Right-angled DC power cable with filter. | 25-119756-01R         |
| DC Power Cable                     | DC power cable for use with power supply 50-14000-241R (fixed station use). Use to connect the AC power supply to the VC5090.                                                                           | 25-71920-01R         |
| Serial ActiveSync Cable            | RS232 cable, 9-pin Female (active Sync), 5’ straight, rugged Amphenol connector. Use to connect the VC5090 to a host computer to perform serial ActiveSync communication.                                            | 25-71914-01R         |
| USB Host Cable                     | USB Host cable, USB A Jack, 6’ straight, rugged amphenol connector. Use to connect the VC5090 as a host device.                                                                                        | 25-71915-01R         |</p>
<table>
<thead>
<tr>
<th>Accessory</th>
<th>Description</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>LS3203 Scanner Serial Cable</td>
<td>RS232 cable, coiled, 9’ extended, rugged Amphenol connector. Use to connect the Zebra LS3203 serial scanner to the VC5090 serial port.</td>
<td>25-71916-01R</td>
</tr>
<tr>
<td>RS232 Cable</td>
<td>RS232 Cable, 9-Pin Male, 5’ straight, rugged Amphenol connector. Use to connect the VC5090 to a serial device.</td>
<td>25-71924-01R</td>
</tr>
<tr>
<td>Printer cable</td>
<td>Printer cable, VC5090 O’Neil MF2T</td>
<td>25-71921-01R</td>
</tr>
<tr>
<td></td>
<td>Zebra QL Series Printer Cable</td>
<td>25-71922-01R</td>
</tr>
<tr>
<td></td>
<td>Printer cable, VC5090 ZEBRA ROADWARRIOR</td>
<td>25-71923-01R</td>
</tr>
<tr>
<td>In-Motion Detector Cable</td>
<td>Motion Detector Cable (without motion sensor switch). Use to connect the VC5090 and the vehicle accelerator pedal that detects when the vehicle is moving and blanks the screen so that the operator is not distracted while driving.</td>
<td>25-82420-01R</td>
</tr>
<tr>
<td>Screen Protectors</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Screen Protector</td>
<td>Replacement screen protector film for the half screen VC5090 configurations. Pack of 5.</td>
<td>90500113-R</td>
</tr>
<tr>
<td></td>
<td>Replacement screen protector film for the full screen VC5090 configurations. Pack of 5.</td>
<td>90500114-R</td>
</tr>
<tr>
<td>Miscellaneous</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mounting Hardware</td>
<td>VC5090 Spare Mounting bracket w/ hardware (handles not included)</td>
<td>90500116-R</td>
</tr>
<tr>
<td></td>
<td>VC5090 Mounting bracket for use with RAM mount</td>
<td>21-99288-01R</td>
</tr>
<tr>
<td></td>
<td>Optional Mounting Handles, washers, friction pads and bolts (2 each). Use to replace the standard screws for adjusting the VC5090 position of on the mounting bracket.</td>
<td>90500115-R</td>
</tr>
<tr>
<td></td>
<td>Spare screws for UPS and Desiccant compartment covers (package of 12)</td>
<td>90500117-R</td>
</tr>
<tr>
<td>Keyboard Cover</td>
<td>Cover for VC5090 keyboard, Clear, Pack of 5. Use to provide added protection for the external keyboard.</td>
<td>KT-141972-01R</td>
</tr>
</tbody>
</table>
## Desiccant Kits
- VC5090 Valve and desiccant kit: KT-115510-01R
- Replacement desiccant bag: KT-81524-01R
- Replacement desiccant bags (pack of 5): KT-81524-05R

## Power Supply
- AC Power Supply: Power supply for use in wall or desktop mounted applications. Order country specific three wire grounded AC line cord separately: 50-14000-241R

## Grounded Line Cords
- AC Line Cords: US AC line cord, grounded, three wire for power supplies KT-14000-148R and 50-14000-241R: 23844-00-00R
- AC Line Cord, 1.8M, three wire, grounded BS1363 plug. Associated Countries: Hong Kong, Iraq, Malaysia, Singapore, United Kingdom. For power supplies KT-14000-148R and 50-14000-241R: 50-16000-219R
- AC Line Cord, 1.8M, grounded, three wire CEE 7/7 plug. Associated Countries: Europe, Abu Dhabi, Bolivia, Dubai, Egypt, Iran, Korea, Russia, Vietnam. For power supplies KT-14000-148R and 50-14000-241R: 50-16000-220R
- AC Line Cord, 1.8M, grounded, USA NEMA 5-15P. Associated Countries: Brazil, United States. For power supplies KT-14000-148R and 50-14000-241R: 50-16000-221R
<table>
<thead>
<tr>
<th>Accessory</th>
<th>Description</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>AC Line Cord, 1.8M grounded, three wire, S132 Plug. Associated Country: Israel.</td>
<td>50-16000-672R</td>
</tr>
<tr>
<td></td>
<td>AC Line Cord, 36&quot;L grounded, three wire. Associated Countries: Brazil, United States. For power supplies KT-14000-148R and 50-14000-241R.</td>
<td>50-16000-678R</td>
</tr>
</tbody>
</table>

**Scanners**

| Scanners           | LS3203 serial laser scanner  
|                    | LS3408 serial/USB laser scanner  
|                    | DS3408 serial/USB imager  
|                    | LS3478 Bluetooth serial/USB laser scanner (with cradle)  
|                    | DS3478 Bluetooth serial/USB imager (with cradle)  
|                    | LS3578 Bluetooth laser scanner  
|                    | RS507 Bluetooth Hands-Free Imager (requires a downloadable cab file)  |
### Table 1-1  Accessories (Continued)

<table>
<thead>
<tr>
<th>Accessory</th>
<th>Description</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SD Cards</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Secure Digital Card</td>
<td>• 128 MB&lt;br&gt;• ATP Industrial 128MB Memory Card (AF128SDI-AG)&lt;br&gt;• 256 MB&lt;br&gt;• ATP Industrial 256MB Memory Card (AF256SDI-AG)&lt;br&gt;• 512 MB&lt;br&gt;• ATP Industrial 512MB Memory Card (AF512SDI-AG)&lt;br&gt;• 1 GB&lt;br&gt;• ATP Industrial 1GB Memory Card (AF1GBSDI-AG)&lt;br&gt;• SanDisk Extreme III SD 1GB Memory Card (SDSDX3-1024)&lt;br&gt;• SimpleTech Industrial 1GB Memory Card (SYMNYSD1GBAE)&lt;br&gt;• 2GB&lt;br&gt;• SanDisk Ultra-II Non-Industrial 2GB Memory Card (SDSDH-2048)&lt;br&gt;• SanDisk Extreme III SD 2GB Memory Card (SDSDX3-2048)&lt;br&gt;• Shea Integration 2GB Memory card (1SSD/2GB)</td>
<td>3rd Party</td>
</tr>
<tr>
<td>Audio Handset</td>
<td>Sinbon's VC5090 remote speaker/microphone handset featuring sealed speaker and microphone with PTT switch is available for voice communications solution. For updated information refer to <a href="http://www.sinbontech.com">www.sinbontech.com</a></td>
<td>Sinbon P/N 80634SPM2100 Contact Sinbon Technologies to order headset and adapter cables: <a href="mailto:sales@sinbontech.com">sales@sinbontech.com</a> Tel: 877-974-6266</td>
</tr>
</tbody>
</table>
Chapter 2 Installation

Introduction

This chapter describes how to install the vehicle computer in a vehicle or on a desktop and connecting the vehicle computer to a power source. There are different installation options depending on the type of vehicle. This chapter also describes how to install the various accessories for the vehicle computer. Read all of the following instructions before you begin.

**WARNING!** The vehicle computer and bracket must be firmly secured to a surface that can support the vehicle computer’s weight.

**CAUTION** A competent engineer must perform the installation in a vehicle. Improper installation can damage your vehicle and/or the VC5090.

Do not install the vehicle computer in a location that will affect vehicle safety, driveability, or visibility.

Installing the Desiccant Door

**NOTE** Zebra recommends installing the desiccant bag in environments where extreme temperature changes occur, such as applications where the device may be continuously moved between a freezer and a hot/humid area. Temperature changes would occur more often in the hot/humid months of summer and less frequently in cold/dry months of winter. If desiccant is not used, the desiccant door must still be installed and secured.

1. The VC5090 ships with a desiccant bag installed and a replacement bag in the VC5090 shipping container. The installer may wish to replace the desiccant in the VC5090 with the new bag prior to installing the VC5090 on the vehicle, as transit and storage may have saturated the desiccant.

2. Open the desiccant package and remove the desiccant bag.

3. Fold the four corners of the bag under to form a pillow.

4. Place the desiccant bag in the desiccant well.
5. Ensure that the door seal is in place.
6. Carefully place the desiccant door onto the back housing. Ensure that the desiccant bag does not interfere with door seal.

⚠️ **CAUTION**  Be sure to torque the screws to seal the device properly. Otherwise, sealing can be compromised.

7. Secure the door to the back housing using the four screws. Torque to 9 ± 0.5 kgf.cm (7.8 ± 0.4 in-lbs).

### Installing the Optional UPS

✔️ **NOTE**  The use of the optional UPS battery is recommended in every case the power to the VC5090 can be unintentionally interrupted during operation. It is strongly recommended when AC power source susceptible to power failures is used to power the VC5090.

To install the optional UPS:

⚠️ **CAUTION**  Use ESD precautions when installing the UPS.

1. Place the Main Power switch on top of the vehicle computer to the off position.
2. Remove and discard the eight screws securing the UPS/Memory Card door on the back of the vehicle computer.
3. Connect the UPS cable connectors to the connector on the printed circuit board (PCB) and on the UPS.
4. Place the UPS into the well.

5. Place the UPS/Memory Card door over the UPS and secure using the eight new screws supplied with the UPS kit.

⚠️ **CAUTION** Be sure to torque the screws to seal the device properly. Otherwise, sealing can be compromised.

6. Torque the screws to 9 +/- 0.5 kgf.cm (7.8 ± 0.4 in-lbs).

7. Place the Main Power switch to the on position. It takes four hours to fully charge the UPS.

---

### Installing a Memory Card

A memory card (Secure Digital) provides secondary non-volatile storage. The card holder is located on the back of the VC5090 under the UPS/Memory Card door.

To install the memory card:

1. Place the Main Power switch on the top of the vehicle computer to the off position.

2. Remove and discard the eight screws securing the UPS/Memory Card door.

3. Lift the card holder retaining door.

4. Position the memory card, with the contacts down, into the card holder. The memory card corner notch fits into the holder only one way.
5. Snap the retaining door closed.

6. Replace the UPS/Memory Card door and secure using eight new screws.

⚠️ **CAUTION** Ensure to torque the screws to seal the device properly. Otherwise, sealing can be compromised.

7. Torque the screws to 9 +/- 0.5 kgf.cm (7.8 ± 0.4 in-lbs).

8. Place the Main Power switch to the on position.

---

**Installing the Mounting Bracket**

⚠️ **CAUTION** It is required to use the Zebra provided mounting bracket.

---

Figure 2-4  *Mounting Bracket Installation*

9. Position the friction pads in the friction pad mounting area.

10. Position the mounting bracket over the mounting holes.

11. Place washers onto cap screws.
12. Screw cap screws into mounting holes and tighten. Torque the cap screws to 276 ± 8.7 kgf/cm (239.6 ± 7.6 in-lbs).

Installing the VC5090 in a Forklift

CAUTION A competent engineer must perform the installation in a vehicle. Improper installation can injure the operator and damage your vehicle and/or the VC5090.

Follow the instructions below to properly install the VC5090 in a forklift.

• Determine the best location for mounting the vehicle computer taking into consideration the driver's field of view and ease of accessing the vehicle computer.
• Install the appropriate mounting hardware. The VC5090 ships with four cap screws (3/8" - 16 - 2") for securing the mounting bracket. If the supplied cap screws are not long enough, use 3/8" - 16 - X stainless steel cap screws where X represents the length in inches of the required cap screws.
• Connect the vehicle computer to the vehicle's wiring system.

Positioning the Vehicle Computer

• Determine the best position for the vehicle computer and all the associated components. If a similar vehicle computer was previously installed, check to see if the position it used is suitable for the VC5090.
• Test the installation for at least 30 minutes before installing on another vehicle. Record all details:
  • Check that the position of the vehicle computer does not obstruct vehicle controls.

Figure 2-5 View Obstruction

• Check that the vehicle computer does not obstruct the driver's view.
• Check the position of the vehicle computer for user comfort over long periods.
• Check positioning to avoid extreme wrist angles that may cause injury.
Figure 2-6  Avoid Extreme Wrist Angles

Figure 2-7  Optimum Wrist Positions
Mounting the Vehicle Computer

Forklifts tend to generate very large shock and vibration pulses due to the hydraulics and the lack of suspension coupled with (usually) very hard wheels.

The mounting bracket provided with the VC5090 is designed as an isolator. In order for it to be effective, the bracket base must be securely mounted to a rigid and strong structure that fully supports the entire base of the bracket.

Most forklifts have a very rigid and durable chassis and outer body panels but top facing surfaces may be sheet metal or plastic. These thin sheet metal or plastic surfaces are not suitable for mounting surfaces due to their non-rigid nature.
Mounting Bracket Template

Drill Holes: 10.1 mm ± 0.1 mm
0.43 ± 0.004 in.

160.00 ± 0.20 mm
6.299 ± 0.008 in.

25.40 ± 0.10 mm
1.00 ± 0.004 in.

Figure 2-8  Mounting Template
Important Fixing Information

**CAUTION** Any modification to supplied mounting bracket could cause failure of the unit and/or mountings.

- Mounting surface must be flat and stiff and it must extend evenly for the entire length of the mounting bracket surface.
- All four mounting holes must be used.
- All nuts and bolts must be checked periodically and tightened if required.
- When installing the vehicle computer, care must be taken to ensure that the mounting bracket footprint is fully supported. Additional plates may be required to achieve this.
- Do not mount the vehicle computer with the mounting bracket perpendicular to a wall as shown in Figure 2-9.

![Incorrect Mounting](image)

**Figure 2-9 Incorrect Mounting**

Mounting onto an Over-Head Cross-Beam Example

The diagram below illustrates a typical installation where the vehicle computer is mounted onto a cross-beam.
Mounting onto an Over-Head Cage Example

The diagrams below illustrate a typical installation where the vehicle computer is mounted on an overhead cage. A customer supplied mounting plate must be used that can withstand the weight of the vehicle computer under vibration and shock. The plate must be made of stainless steel or hardened steel with the following dimensions: 3.0 in. (76.0 mm) wide, 8.66 in. (220.0 mm) long and 0.2 in. (5.0 mm) thick. The plate must be secured with hardware or to the underside of the cage by welding.
Mounting on a Dashboard or Horizontal Surface Example

The diagram below illustrates a typical installation where the vehicle computer is mounted on a dashboard or horizontal flat surface.

**NOTE** If mounting to a thin surface, a reinforcing plate maybe required.
Routing Electrical Cables

• Establish a neat route for the cable, staying clear of moving parts or hot surfaces whenever possible.

• Fix the cable to existing cable runs inside the vehicle using cable ties, but make sure they are away from any moving or hot surfaces.

• When the cabling must go through a panel, use a suitable gland.

• When fixing the conduit or cable on the outside of a vehicle, use P-Clips. Either drill and tap the hole or use a nut and bolt to secure the clip.

• Ensure the cable does not have tight bends. The minimum recommended radius is 63.5 mm (2.5 in.). Do not allow power cable to bend against mounting hardware. Use the optional right angled DC power cable.

• Ensure cables do not swing or chafe on the structure. This often requires using cable ties approximately every foot, and ensuring the cables do not flex often, especially where they connect to the VC5090. However, if you must re-position the VC5090 occasionally, ensure there is enough slack in the cable to accommodate movement without putting tension on the cable.

• DO NOT wind a cable in and out of the mesh on a cage.

• On electric vehicles, take the power from as close to the battery as possible, but not directly from the battery terminals, and not before any main fuse.

• On gasoline, diesel or propane vehicles, take the power from as close to the battery terminals as possible, and avoid using existing wiring.

• Ensure that all fuses are as close as possible to the power source.
Gasoline, Diesel or Propane Forklifts

**NOTE** The vehicle computer contains an Ignition Sense feature that detects when the ignition switch is turned off and shuts the vehicle computer down after a preprogrammed timeout. This feature allows the operator to use the vehicle computer for a predetermined time period after the ignition switch is turned off, then shuts the vehicle computer down automatically to prevent over-discharge of the forklift battery. The timeout period is adjustable by the user (see *Ignition Sensing on page 3-22* for setting the timeout value). The normal current draw of a suspended vehicle computer is approximately 500mA. When the vehicle computer shuts down using the Ignition Sense feature, current draw is reduced to approximately 5 mA. This feature provides the automatic shutoff functionality of an external relay, without requiring an actual relay and has the added benefit of allowing the user to work for a preset time period before shutting down.

- All power wiring must use the supplied power cable.
- Fuses:
  - two 3AG, 20A, 250V, SLO BLO fuses
  - one 3AG, 1A, 250V, SLO BLO fuse.
- Keep the path between the battery and the vehicle computer as short as possible, and away from any part of the ignition high tension system.

![Diagram](attachment://diagram.png)

**Figure 2-14  Wiring Diagram**

**NOTE** See the vehicle Owner’s Manual for specific wiring information.

1. Disconnect the vehicle battery.
2. Connect the green wire to the vehicle’s chassis.
3. Shorten cable to desired length.
4. Place a fuse and fuse holder in-line of the red, black and yellow wires approximately four inches from the cable end, as shown below.
Slide shrink tubing over wires.

6. Strip wires (0.4 in./10 mm) and insert into the fuse holder. Crimp fuse holder ends to ensure a proper electrical connection (use Thomas & Betts WT-11-M crimp tool or equivalent).


8. Connect the red wire to the vehicle's positive power source. Connect the black wire to the vehicle's negative power source.

9. Connect the yellow wire to the vehicle's ignition switch. If you do not plan on using the Ignition Sense feature, connect the yellow wire to the vehicle's positive power source.

10. Ensure the wiring connections created are sufficiently insulated from each other.

11. Re-connect the vehicle battery.

12. Insert the power cable connector into the vehicle computer's Power port. Align the keyway on the power connector with the notch on the vehicle computer's power port.

Electric Forklifts

- **NOTE** This VC5090 is supplied with a power cable and does not require an external DC power filter. However, it can also be used with the filtered power cable (25-71919-04R).

The VC5090 requires either internal or external power filtering. Do not replace a VC5090 equipped with a filtered power supply with a VC5090 equipped with a non-filtered power supply on electric fork trucks that use the non-filtered power cable (25-71919-03R).

VC5090 devices equipped with a filtered power supply have an orange rim added around the power connector to easily recognize it. Use only non-filtered power cable (25-71919-03R) which contains an orange label that matches the orange rim on the power connector.

- **NOTE** See the vehicle Owner's Manual for specific wiring information.
1. Disconnect the vehicle battery.

2. Connect the green wire to the vehicle’s chassis.

3. Shorten cable to desired length.

4. Place a fuse and fuse holder in-line of the red, black and yellow wires approximately four inches from the cable end, as shown in Figure 2-9 on page 2-9.

5. Slide shrink tubing over wires.

6. Strip wires (0.4 in./10 mm) and insert into the fuse holder. Crimp fuse holder ends to ensure a proper electrical connection (use Thomas & Betts WT-11-M crimp tool or equivalent).


8. Connect the red wire to the vehicle’s positive power source. Connect the black wire to the vehicle’s negative power source.

   **NOTE** The vehicle computer contains an Ignition Sense feature that detects when the ignition switch is turned off and shuts the vehicle computer down after a preprogrammed timeout. This feature allows the operator to use the vehicle computer for a predetermined time period after the ignition switch is turned off, then shuts the vehicle computer down automatically to prevent over-discharge of the forklift battery. The timeout period is adjustable by the user (see Ignition Sensing on page 3-22 for setting the timeout value). The normal current draw of a suspended vehicle computer is approximately 500mA. When the vehicle computer shuts down using the Ignition Sense feature, current draw is reduced to approximately 5 mA. This feature provides the automatic shutoff functionality of an external relay, without requiring an actual relay and has the added benefit of allowing the user to work for a preset time period before shutting down.

9. Connect the yellow wire to the vehicle’s ignition switch. If you do not plan on using the Ignition Sense feature, connect the yellow wire to the vehicle’s positive power source.

10. Ensure the wiring connections created are sufficiently insulated from each other.

11. Re-connect the vehicle battery.

12. Insert the power cable connector into the vehicle computer’s Power port. Align the keyway on the power connector with the notch on the vehicle computer’s power port.

**Removing Power to the Vehicle Computer**

   **NOTE** Place the vehicle computer in suspend mode prior to removing power.

If it is required to remove the vehicle computer from a power source (replace a vehicle’s battery):

1. Ensure that all the Forklift Ignition Off wakeup settings are set to No. Tap > Settings > Control Panel > Power icon > Wakeup tab to view the wakeup settings.

2. Press the Power button on the Quick Access Panel to place the vehicle computer in suspend mode.

3. Turn the vehicle ignition switch to the off position, if applicable.

4. Remove power to the vehicle computer.

5. After re-applying power, turn the vehicle ignition switch to the on position, if applicable.

6. Press the Power button on the Quick Access Panel to resume normal operation.
Installing the VC5090 on a Desktop

To use the vehicle computer in a desk-mounted application:

- Install the mounting bracket to the desktop.
- Connect the vehicle computer to the AC power supply.

Mounting the Bracket on a Desktop

⚠️ **CAUTION** If mounting to a thin surface such as drywall or plywood, a reinforcing plate is required.

✔️ **NOTE** The VC5090 ships with four cap screws (3/8” - 16 - 2”) for securing the mounting bracket. If the supplied cap screws are not long enough, use 3/8” - 16 - X stainless steel cap screws where X represents the length in inches of the required cap screws.

![Figure 2-16 Mounting on a Desktop](image-url)
Connecting the Vehicle Computer to AC Power

**NOTE** Use only an approved power supply, output rated 12 VDC and minimum 9A (part number 50-14001-004 or 50-14001-004R). The power supply is certified to EN60950 with SELV outputs.

**HINWEIS** Benutzen Sie nur eine genehmigt Stromversorgung in den Ausgabe: 12 VDC und minimum 9A (part number 50-14001-004 or 50-14001-004R). Die Stromversorgung ist bescheinigt nach EN60950 mit SELV Ausgaben.

To provide power from an AC source:

1. Insert the AC line cord into the AC connector on the universal power supply.

2. Plug the other end of the AC power cable into a wall outlet.

3. Insert the DC power cable into the DC connector on the universal power supply.

4. Plug the other end of the cable into the vehicle computer’s Power port.

**Figure 2-17  Connecting AC power**
Installing the Optional Keyboard

NOTE The optional keyboard is only available on the full-screen configuration.

The keyboard kit contains the following items:

- keyboard
- two keyboard brackets
- four cap screws with captive washers
- two locking knobs, two flat and two lock washers.

1. Attach the keyboard brackets to both sides of the VC5090, using the cap screws with captive washers. Only tighten the cap screws three turns.

![Diagram of keyboard installation](image)

**Figure 2-18 Attaching the Keyboard to the VC5090**

2. Insert the keyboard locking knobs through the washers and brackets and screw into the keyboard. Tighten fully to lock into place.

3. Torque the bracket cap screws to 230 kgf/cm (200 in-lbs).

4. Plug the keyboard cable into the USB/Keyboard connector and carefully screw the locking barrel until hand tight. Ensure that you do not cross-thread the barrel.
Adjusting the Keyboard

1. To adjust keyboard position, loosen the right and left locking knobs two full turns and rotate the keyboard to the desired position. The keyboard snaps into possible positions as it is rotated.

2. Tighten the keyboard locking knobs to secure the keyboard into position.
Installing a Scanner

The following Zebra scanners can be connected to the vehicle computer:

- LS3203 serial laser scanner
- LS3408 serial/USB laser scanner
- DS3408 serial/USB imager
- LS3478 Bluetooth laser scanner (with serial/USB cradle)
- DS3478 Bluetooth imager (with serial/USB cradle)
- LS3578 Bluetooth laser scanner.

Connecting an LS3203 or a DS/LS3408 Serial Scanner

**NOTE** Refer to the scanner Product Reference Guide for information on configuring the scanner.

To connect an LS3203, DS3408 or LS3408 serial scanner to the VC5090:

1. Connect the serial scanner cable to the scanner.
2. Connect the serial scanner cable to the COM1 or COM2 port.
3. Scan the **Set All Defaults** bar code.

![Connecting Serial Scanner to COM1 and COM2 Connectors](image)

![Set All Defaults Bar Code](image)
4. Double-tap the SerialWedge icon on the desktop to launch the application.

5. Tap the SerialWedge icon in the task tray.

6. Select Configuration > Port Selection from the pop-up menu. The Port Selection window appears.

7. Select the COM port radio button to match the COM port that you connected the scanner cable to (COM1 or COM2).

8. Tap OK.

9. Verify that the scanner is connected properly. See Verifying the Scanner is Working Properly on page 2-31.

Connecting an DS/LS3408 USB Scanner

To connect a DS3408 or LS3408 USB scanner to the VC5090:

**NOTE** Refer to the scanner Product Reference Guide for information on configuring the scanner.

The USB scanner cable connects to the USB/Keyboard connector. If the optional keyboard is used on the VC5090 Full-screen configuration, you are not allowed to connect a USB scanner on the rugged USB port. Connecting a USB scanner to the USB A port is not recommended.

1. Connect the appropriate USB scanner cable to the scanner.

2. Connect the USB scanner cable to the USB/Keyboard connector.
3. Scan the Simple COM Port Emulation bar code.

![Simple COM Port Emulation Bar Code](image)

4. Double-tap the SerialWedge icon on the desktop to launch the application.

5. Tap the SerialWedge icon in the task tray.

6. Select Configuration > Port Selection from the pop-up menu. The Port Selection window appears.

![Port Selection Window](image)

7. Select the COM6 (USB port) radio button.

8. Tap OK.

9. Verify that the scanner is connected properly. See Verifying the Scanner is Working Properly on page 2-31.
Connecting an DS/LS3478 Serial Scanner

To connect a DS378 or LS3478 serial scanner to the VC5090:

1. Connect the appropriate serial scanner cable to the scanner.
2. Connect the serial scanner cable to the COM1 or COM2 port.
3. Double-tap the SerialWedge icon on the desktop to launch the application.
4. Tap the SerialWedge icon in the task tray.
5. Select Configuration > Port Selection from the pop-up menu. The Port Selection window appears.
6. Select the COM6 (USB port) radio button.
7. Tap OK.
8. Verify that the scanner is connected properly. See Verifying the Scanner is Working Properly on page 2-31.

NOTE Refer to the scanner Product Reference Guide for information on configuring the scanner.

The USB scanner cable connects to the USB/Keyboard connector. If the optional keyboard is used on the VC5090 Full-screen configuration, you are not allowed to connect a USB scanner on the rugged USB port. Connecting a USB scanner to the USB A port is not recommended.

Figure 2-27  Connecting Serial Scanner to COM1 and COM2 Connectors

Figure 2-28  Port Selection Window
Connecting a DS/LS3478 USB Scanner

NOTE Refer to the scanner Product Reference Guide for information on configuring the scanner.

To connect a DS3478 or LS3478 USB scanner to the VC5090:

1. Connect the USB scanner cable to the FL3478 cradle.
2. Connect the USB scanner cable to the USB/Keyboard connector.
3. Scan the Pair bar code on the cradle.
4. Scan the Set All Defaults bar code.
5. Scan the HID Keyboard Emulation bar code.
6. Scan the Simple COM Port Emulation bar code.
7. Double-tap the SerialWedge icon on the desktop to launch the application.

8. Tap the SerialWedge icon in the task tray.

9. Select Configuration > Port Selection from the pop-up menu. The Port Selection window appears.

![Port Selection Window](image)

10. Select the COM6 (USB port) radio button.

11. Tap OK.

12. Verify that the scanner is connected properly. See Verifying the Scanner is Working Properly on page 2-31.

**Connecting an LS3578 Bluetooth Scanner**

*NOTE* Refer to the scanner Product Reference Guide for information on configuring the scanner.

To connect an LS3578 Bluetooth scanner to the VC5090:

1. Ensure that the scanner battery is fully changed.

2. Scan the Set All Defaults bar code.

![Set All Defaults Bar Code](image)

3. Scan the HID Profile (Slave) bar code.

![HID Profile (Slave) Bar Code](image)

4. Tap > Enable Bluetooth. The Bluetooth icon changes to indicate that Bluetooth is enabled.
5. Tap **> Show BTExplorer.** The BTExplorer window displays.

![BTExplorer Window](image1)

**Figure 2-37  BTExplorer Window**

6. Select **View > Explorer Mode.**

7. Select **Tools > Discover Devices.** The VC5090 searches for Bluetooth devices in the area. The LS3578 appears in the Untrusted Devices list.

![LS3478 Scanner - Untrusted Devices List](image2)

**Figure 2-38  LS3478 Scanner - Untrusted Devices List**

8. Press and hold on the LS3578 item until the menu appears.

10. Enter: 12345.

11. Tap OK.

12. The LS3578 appears in the Trusted Devices list.

13.

14. Tap and hold on the Zebra Bluetooth HID item until the menu appears.

15. Select Connect.

16. The scanner beeps indicating that it successfully connected to the VC5090.

17. Open WordPad.

18. Scan a bar code. The bar code data appears in the WordPad window.

**Scanner Setup**

To configure the VC5090 to communicate with the scanner:

1. Double-tap the SerialWedge icon on the desktop to launch the application.
2. Tap the SerialWedge icon in the task tray.

3. Select Configuration > Port Selection from the pop-up menu. The Port Selection window appears.

![Port Selection Window](image)

**Figure 2-40** Port Selection Window

4. Select the COM port radio button to match the COM port that you connected the scanner cable to.

5. Tap OK.

   The scanner beeps to indicate that it is receiving power.

6. Tap the SerialWedge icon in the task tray.

7. For serial connections, select Configuration > Port Configuration from the pop-up menu. The Communication Parameters window appears.

![Communication Parameters Window](image)

**Figure 2-41** Communications Parameters Window

8. Use the drop-down lists to select the parameter values to match the scanner. Refer to the scanner Product Reference Guide for more information.

9. Tap OK.

10. Tap the SerialWedge icon in the task tray.

11. Select Configuration > Barcode Settings from the pop-up menu. The Barcode Settings window appears.
12. Enter or select configuration parameters as required:
   • Prefix - Appends the data entered in this field to the beginning of the bar code data.
   • Suffix - Appends the data entered in this field to the end of the bar code data.
   • Allow Escapes in prefix/suffix - Allows the prefix and suffix data to contain escape keys.
   • Send barcode data - when enabled, the barcodes data is sent to the vehicle computer.
   • Send barcode data as ASCII - when enabled, the barcodes data is sent in the ASCII format.
   • Send Enter key after suffix - when enabled, an Enter character is appended to the end of the bar code data.
   • Send TAB key after suffix - when enabled, an Tab character is appended to the end of the bar code data.

13. Tap **OK**.

**Enable/Disable the Scanner**

To enable or disable the scanner:

1. Tap the **SerialWedge** icon in the task tray.

   Select **Scan > Enable** from the pop-up menu to enable the scanner if it had previously been disabled. The scanner beeps to indicate that it is receiving power.

   or

   Select **Scan > Disable** from the pop-up menu to disable the scanner if it had previously been enabled.
Verifying the Scanner is Working Properly

To display scanner bar code data on the display:

1. Tap the SerialWedge icon in the task tray.
2. Select Show UI. The Show Barcode data window appears.

![Show Barcode Data Window](image)

3. Aim the scanner at a bar code and press the scan trigger. The bar code data appears in the window.

Pairing Bluetooth Scanner and Cradle

The Bluetooth scanner cradle receives power from the vehicle computer. When the vehicle computer goes into suspend mode the vehicle computer removes power to the cradle. When the vehicle computer resumes normal operation, power is re-applied to the cradle. If power to the cradle was removed for more than 30 seconds, the scanner needs to re-connect (pair) to the cradle. Press the scanner trigger to re-connect the scanner to the cradle. The scanner emits a lo-high beep when re-connecting.

Connecting an RS507 Hands-free Imager

Before connecting the RS507, download the VC5090 CE5.0 Enhancement CAB for RS507 Hands-Free Imager v.R3 software from the Zebra Support Central Web site. Follow the instructions provided with the software to install the software onto the VC5090.

To establish Bluetooth connection:

1. Ensure that the Imager is within a range of 10 meters (30 feet) from the VC5090.
2. Launch the Pair application on the VC5090 Demo screen. The BD Address application displays a pairing bar code image on the screen.
3. Scan the pairing bar code. When scanning, the Imager emits one string of high/low/high/low beeps.
4. Launch the Scan application from the VC5090 Demo screen.
5. Select Bluetooth SSI Scanner and tap OK.
6. Scan a bar code to test the RS507 Imager.

Refer to the RS507 Hands-free Imager Product Reference Guide for more information.
Installing a External Antenna

**NOTE** Zebra recommends using the Centurion™ antenna, model number: WTS2450-RPSMA. See *Table 1-1 on page 1-4* for supplier information.

An external antenna can be used when placement of the vehicle computer prohibits reception; i.e., inside a vehicle cab.

To install an external antenna:

1. Lift the antenna connector cap on top of the vehicle computer.
2. Screw the cable connector onto the antenna connector.
3. Torque to 5 ± 0.5 kgf/cm (4.3 ± 0.4 in-lbs).
4. Screw the antenna to the antenna base.
5. Tap > Settings > Control Panel > VC5090 System Management icon. The System Management window displays.

![Antenna Installation Example](image)

*Note: The antenna and antenna base drawing is an example and actual antennas and bases may vary.*
6. Tap the **RF Settings** tab.

7. Tap the **External Antenna** radio button.

8. Tap **OK**.

---

**Installing the Vehicle In-Motion Detector**

The optional Vehicle In-Motion Detector cable blanks the screen and disables use of the vehicle computer when the vehicle is in motion.

**Normally Closed Switch**

The customer must install a switch that is engaged when the vehicle accelerator pedal is not depressed (See **Figure 2-46 on page 2-34**). When the pedal is not depressed, the switch is activated (closed) and sends a signal to the vehicle computer indicating that the pedal is not depressed. When the accelerator pedal is depressed the switch disengages and the signal removed. The screen blanks and the touch screen and keyboard are disabled.

**Normally Open Switch**

This feature is only available on vehicle computers with OEM version 05.26.0000 or higher. See **Configurations on page xiv** for instructions to determine the OEM version of the software.

The customer must install a switch that is disengaged when the vehicle accelerator pedal is not depressed (See **Figure 2-47 on page 2-35**). When the pedal is not depressed, the switch is inactive (open) and no signal is sent to the vehicle computer indicating that the pedal is not depressed. When the accelerator pedal is depressed the switch engages and a signal is sent to the vehicle computer. The screen blanks and the touch screen and keyboard are disabled.

**Operation**

Whenever the vehicle is in motion (accelerator pedal is depressed) and the Terminal Locking feature is enabled, the vehicle computer display blanks. When the accelerator pedal is not depressed, the vehicle computer does not unlock immediately. Instead, the **Complete Lockup Timeout** timer initiates during which the vehicle computer continues to remain locked. This ensures that the vehicle computer doesn’t unlock and lock during any momentary disengagement of the accelerator pedal. While the **Complete Lockup Timeout** timer is running, the touch screen, backlight and keyboard are disabled. After this timer expires, the **Screen Blank Timeout** timer initiates. While this
timer is running, the touch screen is enabled but the backlight and keyboard are still disabled. If during this time the user touches the screen, the backlight comes on and the vehicle computer unlocks fully. Otherwise after this timer expires, the backlight comes on and the vehicle computer unlocks fully. If, while any of these timers are running, the vehicle pedal is pressed, the vehicle computer locks again.

If the cable is cut or removed, the vehicle computer responds as if the pedal is depressed.

**Switches**

There are two types of switches that can be used; a solid state switch and a mechanical switch. Typically solid state switches have a much longer life cycle than mechanical switches. Solid state switches require power while mechanical switches do not.

The switch must be rated at 5V, 10 mA and it should have a operating temperature, sealing and life cycle applicable for the environment that it is used in.

The mechanical switch must be a Normally Open type of switch.

The supply voltage for the solid state switch is 5 VDC (500 mA max.). When the switch is depressed the OUT pin is pulled low.

The switch must be mounted permanently and must be positioned in such a way so that the switch is depressed when the accelerator pedal is not pressed (vehicle at rest). When the accelerator pedal is pressed, the switch should open and stay open until the pedal is released completely.

**Figure 2-46**  *Switch Installation Example (Switch Normally Closed)*
Figure 2-47  Switch Installation Example (Switch Normally Open)

Cable Installation

One end of the cable connects to a customer provided switch and the other end connects to the COM1 or COM2 port on the vehicle computer.

To install the Vehicle In-Motion Detector cable:

1. Follow these recommendations when installing the cable:
   - Establish a neat route for the cable, staying clear of moving parts or hot surfaces.
   - Place the cable in a rigid sleeve or conduit to protect the cable.
   - When the cabling must go through a panel, use a suitable gland.
   - When fixing the conduit or cable on the outside of a vehicle, use P-Clips. Either drill and tap the hole or use a nut and bolt to secure the clip.
   - Ensure the cable does not have tight bends. The minimum recommended radius is 2.5”.
   - Solder all wire connections.

2. Wire the cable and switch as shown in Figure 2-48.
3. Connect the connector of the Vehicle In-Motion Detector cable to either the COM1 or COM2 connector on the back of the VC5090.


5. Tap the Terminal Lock tab. The Terminal Lock Password window appears.

6. Enter the assigned password and tap OK. The default password is “vc5090”.

7. Select the Enable Terminal Locking check box.
8. When using a normally open switch, select both the Enable Terminal Locking and For DeadManPedal check boxes.

9. In the Select control for terminal locking drop-down list, select the COM port that the In-Motion Detector cable is connected to (either COM1 or COM2).

10. In the Complete Lockup Timeout drop-down list, select the amount of time that the VC5090 waits before it unlocks once the switch is deactivated (pedal is disengaged). During this time period, the touch screen, backlight and keyboard are disabled.

11. In the Screen Blank Timeout drop-down list, select the amount of time after the Complete Lockup Timeout that the touch screen is active. The touch screen is enabled but the backlight and keyboard are disabled.

12. Tap OK.

To change the Terminal Lock password:

1. On the vehicle computer, tap > Settings > Control Panel > VC5090 System Management icon. The System Management window displays.

2. Tap the Terminal Lock tab. The Terminal Lock Password window appears.

3. Enter the assigned password and tap OK. The password is case sensitive. The default password is “vc5090”.

4. Tap Set New PASSWORD. The Set New Password window appears.
5. In the **Old Password** text box, enter the old password.

6. In the **New Password** text box, enter the new password. The password must have a minimum of five characters.

7. In the **Confirm Password**, re-enter the new password.

8. Tap **OK**.

**Over-Ride**

If the cable is cut or breaks, you can over-ride the lock out by tapping the screen three times. A dialog box appears. In the **Unlock Password** field, enter the password and tap **OK**.

---

**Figure 2-53**  *Set New Password Window*

**Figure 2-54**  *Terminal Lock Over-Ride*
**Connecting Accessories**

Connect an optional scanner, ActiveSync serial cable, or USB device (such as a keyboard or mouse) using the appropriate port on the bottom of the VC5090.

You should use either COM1 or COM2 port for serial ActiveSync or the USB Client port for USB ActiveSync.

A standard USB keyboard or mouse can be connected to the USB A connector (Host).

![Connection Ports](image)

**Connecting an External Speaker to the Vehicle Computer**

It may be necessary to install an external speaker in noisy environments. To connect an external speaker, a special cable must be created to connect the vehicle computer to the external speaker. *Figure 2-56* illustrates the cable requirements. See *Audio Connector Pin-Outs on page A-5* for the connector pin-outs and required connector.

![External Speaker Wiring Diagram](image)

The speaker must be a minimum of 4 ohms (4 or 8 ohms is preferred). The speaker must be rated for 2.5W continuous at 4 ohms or 1.5W continuous at 8 ohms.
Chapter 3 Operating the VC5090

Introduction

This chapter explains the buttons, status icons and controls on the VC5090 and provides basic instructions for using the VC5090, including powering on and resetting. It also included instructions for entering and capturing data.

Quick Access Panel

The Quick Access Panel contains buttons and LEDs to control the operation of the vehicle computer.

![VC5090 Quick Access Panel](image)

Figure 3-1 VC5090 Quick Access Panel

Power Button

Press the Power button to place the vehicle computer into suspend mode. When in suspend mode, press the Power button to resume normal operation.
Power LED

Table 3-1 lists the states of the Power LED.

Table 3-1  Power LED Indicator

<table>
<thead>
<tr>
<th>LED State</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solid Green</td>
<td>Vehicle computer is operating from external power.</td>
</tr>
<tr>
<td>Flashing Green</td>
<td>UPS battery is charging.</td>
</tr>
<tr>
<td>Solid Yellow</td>
<td>Vehicle computer is operating from the UPS battery.</td>
</tr>
<tr>
<td>Flashing Yellow</td>
<td>Vehicle computer is operating from the UPS battery and the UPS battery power is low.</td>
</tr>
</tbody>
</table>

COMM LED

The COMM LED blinks to indicate WLAN radio activity. Table 3-2 lists the states of the COMM LED. By default, the COMM LED is enabled. To disable the COMM LED:

2. Tap the Enable Comm Led check box.
3. Tap OK.

NOTE These settings are not persistent across a cold boot.

Table 3-2  COMM LED Indicator

<table>
<thead>
<tr>
<th>LED State</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fast Blinking (once every 0.4 seconds)</td>
<td>Excellent WLAN signal.</td>
</tr>
<tr>
<td>Medium Blinking (once every 0.8 seconds)</td>
<td>Very Good WLAN signal.</td>
</tr>
</tbody>
</table>
Table 3-2  COMM LED Indicator (Continued)

<table>
<thead>
<tr>
<th>LED State</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slow Blinking (once every 1.6 seconds)</td>
<td>Good WLAN signal.</td>
</tr>
<tr>
<td>Off</td>
<td>Poor WLAN signal. Radio is not associates with an AP. Radio is disabled. COMM LED is disabled.</td>
</tr>
</tbody>
</table>

**Backlight Control Button**

The Backlight Control button places the Quick Access Panel’s P1, P2 and P3 buttons into the backlight control mode where you can adjust the brightness of the display or turn on/off the keyboard backlight. See *Adjusting the Brightness on page 3-9* for more information.

**Programmable (“P”) Keys**

The programmable keys on the Quick Access Panel (P1, P2, P3) can be set to perform certain functions, such as:

- launching an application
- simulating a key press
- toggling the SIP keyboard
- enabling and disabling the touch screen
- toggling the keyboard backlight
- playing a key sequence
- launching the calibration screen.

![NOTE](image)

These settings are not persistent across a cold boot.

To set a programmable key:


![Configure Programmable Keys](image)

2. In the Key: drop-down menu, select the P key you would like to program.

3. In the Action drop-down menu, select the function you would like the P key to perform.
4. In the action fields, enter the required data, if applicable. See the following paragraph for more information.

5. Tap OK.

**Launch Application**

To set a programmable key to launch an application:

1. In the **Action** drop-down list, select **Launch Application**.

![Configure Programmable Keys - Launch Application](image)

Figure 3-4  Configure Programmable Keys - Launch Application

2. In the **Application Path** field enter the path and application or tap the button to browse through the folders to find the application file.

3. In the **Command Line** field, enter any specific commands for the selected application.

4. Tap OK.

**Simulate KeyPress**

To set a programmable key to simulate a key press:

1. In the **Action** drop-down list, select **Simulate KeyPress**.

![Configure Programmable Keys - Simulate KeyPress](image)

Figure 3-5  Configure Programmable Keys - Simulate KeyPress

2. In the **Modifiers** field, select one of the check boxes.

3. In the **Key Press** drop-down list, select a key (character).

4. Select the **Repeat Key** check box to allow the key press to continuously repeat as long as the P button is pressed.

5. Tap OK.
Play Key Sequence

To set a programmable key to play a sequence of characters:

1. In the Action drop-down list, select Play Key Sequence.

![Configure Programmable Keys - Play Key Sequence](image)

2. In the Key Sequence field, enter a character string (up to 1,040 characters).

3. Tap OK.

Using the Keyboard

Optional QWERTY and AZERTY keyboards can be used with the full-screen vehicle computer. Refer to Figure 3-7 and Table 3-3 for a description of the keys. The half-screen vehicle computer has a built-in keyboard. Both keyboards function identically.

Keyboard Functionality

Table 3-3 describes the general functions of the keyboard.
The VC5090 contains two on-screen Soft Input Panel (SIP) keyboards. The Microsoft SIP looks and functions like a standard keyboard. The VC5090 SIP looks and functions like the optional keyboard or the half-screen configuration’s built-in keyboard.

### Soft Keyboards

**Table 3-3 Key Descriptions**

<table>
<thead>
<tr>
<th>Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SHIFT</td>
<td>Press the SHIFT key followed by a alpha key to create uppercase alphabetic characters.</td>
</tr>
<tr>
<td>CTRL</td>
<td>Press the CTRL key to activate alternate control functions. Use CTRL - ESC key combination to access the menu.</td>
</tr>
<tr>
<td>ALT</td>
<td>Press the ALT key to activate alternate keyboard functions.</td>
</tr>
<tr>
<td>FUNC</td>
<td>Press the FUNC key to activate alternate functions that are shown on the keyboard in blue text. The key lights to indicate that the keyboard is locked in the function mode. Press the FUNC key again to return to normal keyboard mode.</td>
</tr>
<tr>
<td>A through Z</td>
<td>Produces the lowercase alphabetic character shown on the key. Produces uppercase alphabetic character shown on the key when preceded by the SHIFT key.</td>
</tr>
<tr>
<td>0 through 9</td>
<td>Produces the numeric character shown on the key.</td>
</tr>
<tr>
<td>&lt; &gt; ← →</td>
<td>Moves the cursor around the screen or highlights the items in a menu.</td>
</tr>
<tr>
<td>F1 through F24</td>
<td>Programmable function keys. The application determines the use; see the software or application documentation.</td>
</tr>
<tr>
<td>Enter</td>
<td>Moves the cursor to the next data field or screen.</td>
</tr>
<tr>
<td>Del</td>
<td>Deletes the character to the right of the cursor.</td>
</tr>
<tr>
<td>Backspace</td>
<td>Deletes the character to the left of the cursor.</td>
</tr>
<tr>
<td>Space</td>
<td>Enters a space between characters or words.</td>
</tr>
</tbody>
</table>
To display the Microsoft SIP keyboard, tap the **Input Panel** icon in the task tray and select **Keyboard** from the pop-up menu.

![Microsoft Soft Input Panel Keyboard](image)

**Figure 3-9** Microsoft Soft Input Panel Keyboard

To display the VC5090 SIP keyboard, tap the **Input Panel** icon in the task tray and select either **VC5090 Soft Input Panel** or **AZERTY Input Panel** from the pop-up menu.

![Input Panel Pop-up Menu](image)

**Figure 3-10** Input Panel Pop-up Menu

To hide or show the numeric keys tap the **Alpha-Numeric Toggle** button.

![QWERTY VC5090 Soft Input Panel Keyboards - Normal Size](image)

**Figure 3-11** QWERTY VC5090 Soft Input Panel Keyboards - Normal Size

Tap the Enlarge or Reduce Keyboard button to scale the keyboard. The three sizes are small, normal and large with normal being the default size.

To hide or show the numeric keys tap the **Alpha-Numeric Toggle** button.
Figure 3-13  *Keyboard with Numeric Key Hidden*

To only display the numeric keys tap the **Numeric Key Toggle** button.

Figure 3-14  *Numeric Only Keys*

The **FUNC** key, when depressed, displays a second layer of characters. The second layer stays visible until the **FUNC** key is pressed again.

Figure 3-15  *QWERTY FUNC Keys*
The **SHIFT** key, when depressed, displays the shifted alpha characters on the keyboard. The shifted letters remain until the **SHIFT** key is pressed again.

**Adjusting the Brightness**

**Controlling Screen Brightness**

To adjust the brightness of the screen, press the **Backlight Control** button on the Quick Access Panel. The amber **Backlight Control** LED lights indicating that the VC5090 is in the brightness control mode. Press the **P1** button to decrease the brightness or the **P2** button to increase the brightness. Press the **Backlight Control** button to exit this mode (or after five seconds of inactivity the VC5090 automatically returns to normal operation).
Controlling Keyboard Backlight

To toggle the keyboard backlight, press the Backlight Control button on the Quick Access Panel. The amber Backlight Control LED lights indicating that the VC5090 is in the brightness control mode. Press the P3 button to toggle the keyboard backlight. Press the Backlight Control button to exit this mode (or after five seconds of inactivity the VC5090 automatically returns to normal operation).

Adjusting the Volume

1. Tap the 📡 > Settings > Control Panel > Volume & Sounds icon. The Volume & Sounds Properties window appears.

2. Adjust the volume slider as necessary using the pointer or the up and down arrow keys. Check the Enable sounds for check boxes as desired.

3. Tap OK to save the setting or tap X to exit without saving.

Taskbar

The Taskbar at the bottom of the window displays the active programs, current time, battery status and communication status.
Status icons are shown in the taskbar to indicate present status of the vehicle computer. Double tapping each status icon displays the corresponding setup window and enables you to change or adjust its settings from the window.

- Status Icons: The status icons indicate the function key status. If the **FUNC**, **SHIFT**, **CTRL** or **ALT** functions are active the appropriate status icon is displayed.

- Active Programs Icons: The active applications icons are displayed on the taskbar. If more than one program is active, icons can be used to toggle between the open programs (applications). Tap on a taskbar application to maximize the application.

- AC Power/Battery Status Icons: The AC Power/Battery Status icons are shown in the taskbar to indicate the present power supply status of the vehicle computer.

### Table 3-4  Status Icons

<table>
<thead>
<tr>
<th>Status Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="10:30 AM" /></td>
<td>Indicates the current time.</td>
</tr>
<tr>
<td><img src="image" alt="pen" /></td>
<td>Indicates that the VC5090 Soft Input Panel keyboard is selected.</td>
</tr>
<tr>
<td><img src="image" alt="folder" /></td>
<td>Indicates that the soft keyboards are hidden.</td>
</tr>
<tr>
<td><img src="image" alt="Input Panel" /></td>
<td>Indicates that the Input Panel soft keyboard is selected.</td>
</tr>
<tr>
<td><img src="image" alt="battery" /></td>
<td>Indicates that the vehicle computer is receiving power from a forklift battery or from an AC power supply. If a UPS is installed, it also indicates that the UPS is fully charged. Double tapping on this icon opens the <strong>Power Settings</strong> window.</td>
</tr>
<tr>
<td><img src="image" alt="battery Charging" /></td>
<td>Indicates that the vehicle computer is receiving power from a forklift battery or from an AC power supply, the UPS is installed and charging. Double tapping on this icon opens the <strong>Power Settings</strong> window.</td>
</tr>
<tr>
<td><img src="image" alt="Battery Level" /></td>
<td>Indicates that the vehicle computer is running on UPS power and indicates the percentage of battery charge left in 10% increments from 10% to 100%. Double tapping on this icon opens the <strong>Power Settings</strong> window.</td>
</tr>
<tr>
<td><img src="image" alt="host" /></td>
<td>Indicates that the vehicle computer is connected to a host computer via ActiveSync.</td>
</tr>
<tr>
<td><img src="image" alt="WLAN" /></td>
<td>Indicates WLAN signal strength.</td>
</tr>
</tbody>
</table>
Table 3-4  Status Icons (Continued)

<table>
<thead>
<tr>
<th>Status Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Bluetooth on" /></td>
<td>Indicates that the Bluetooth radio is on.</td>
</tr>
<tr>
<td><img src="image" alt="Bluetooth off" /></td>
<td>Indicates that the Bluetooth radio is off.</td>
</tr>
<tr>
<td><img src="image" alt="Bluetooth communication" /></td>
<td>The Bluetooth Communication icon appears in the task tray and indicates that the mobile computer is communicating with another Bluetooth device.</td>
</tr>
<tr>
<td><img src="image" alt="SerialWedge" /></td>
<td>Indicates that the SerialWedge application is running.</td>
</tr>
<tr>
<td>🚣</td>
<td>Indicates that the <strong>SHIFT</strong> button function is selected.</td>
</tr>
<tr>
<td>🚣</td>
<td>Indicates that the <strong>FUNC</strong> button function is selected.</td>
</tr>
<tr>
<td>🚣</td>
<td>Indicates that the <strong>CTRL</strong> button function is selected.</td>
</tr>
<tr>
<td>🚣</td>
<td>Indicates that the <strong>ALT</strong> character selection is selected.</td>
</tr>
</tbody>
</table>

**Start Button**

Tap the **Start** button (or press **CTRL > ESC**) to launch the **Start** menu.

- **Programs**: Use to access available programs.
- **Favorites**: Displays files in **Favorites** directory.
- **Documents**: Displays files in **Documents** directory.
- **Settings**: Accesses the Control Panel, the Network and Dial-up Connections and the Taskbar and Start menu.
- **Help**: Accesses the Windows CE Help.
- **Run . . .**: Runs a program or application.
- **Suspend**: Places the mobile computer in the suspend state.

![Start Menu](image)
Programs Menu

From the Start menu, tap Programs to open the Programs menu. The programs provided with Windows CE .NET 5.0 Professional are displayed in the Programs menu. Refer to the Application Guide, p/n 72-68901-xx and the Microsoft® Applications User Guide for Zebra Devices, p/n 72E-68197-xx for application information.

![Programs Menu](image)

Desktop Button

Use the Desktop button to minimize all open programs and display the desktop.

Task Manager and Properties

Use the Task Manager to control an application’s use and use the Properties functions to set display and clock options.

Task Manager

1. Select ALT - TAB, to display the Task Manager window.

![Task Manager Window](image)

2. Tap a task in the Active Tasks list and tap Switch To to make that task the primary task, or tap End Task to end the selected task.

3. Tap X to exit the Task Manager window.
Properties

1. Tap Start > Control Panel > Taskbar and Start Menu ... . The Task Manager and Start Menu window displays.

2. This menu provides taskbar options:
   - Check the Always on Top checkbox to keep the taskbar on top of all other windows.
   - Check the AutoHide checkbox to make the taskbar disappear, touch the bottom of the display to make the taskbar return.
   - Check the Show Clock checkbox to display the clock on the taskbar.

3. Tap OK to save the settings and exit the window.

![Figure 3-25 Taskbar and Start Menu, General Tab](image)

Advanced Tab

1. Tap the Advanced tab.

2. Tap the Clear button to delete all of the documents listed in the Start - Documents entry, see Start Button on page 3-12. Typically this list is empty, but if there were documents in the list the Clear button would delete them.

3. Tap the Expand Control Panel checkbox to display the entire contents of the control panel in list form.

![Figure 3-26 Taskbar and Start Menu - Advanced Tab](image)

4. Tap OK to save the settings and exit the window.
Using Voice Communication

You can use voice communication with a remote speaker/microphone handset from 3rd party (see chapter 1-11 above).

Plug the handset jack into the mating connector on the adapter cable. Plug the adapter cable into the audio connector on the bottom of the vehicle computer. Ensure that the vehicle computer’s volume is set appropriately before putting the headset on. When a headset is plugged into the jack, the speaker is muted.

Zebra’s Team Express solution provides an entry-level voice solution, offering PTT voice communication with a quick, easy to deploy path to interoperability. The Team Express solution leverages existing WLAN infrastructure and requires no servers or PBX integration.

Team Express client EWC1005-MC should be downloaded onto the VC5090 to facilitate Team Express voice communication. Refer to Team Express information on http://developer.zebra.com for demonstration and purchasing information.
Resetting the Vehicle Computer

There are two reset functions, warm boot and cold boot.

Performing a Warm Boot

A warm boot restarts the vehicle computer and saves all stored records and entries. In the Windows CE environment.

✓ **NOTE** Files that remain open during a warm boot may not be retained.

To perform a warm boot:

- press the Power button and the P2 button on the Quick Access Panel simultaneously
- or
- tap > Programs > Warm Boot.

Performing a Cold Boot

A cold boot restarts the vehicle computer. To perform a cold boot turn off the Main Power switch on the top of the vehicle computer, simultaneously press the P1, P3 and the Power button on the Quick Access Panel then turn on the Main Power switch.

A cold boot also restarts the vehicle computer, but erases all stored records and entries in RAM. Data saved in flash memory or a memory card is not lost. In addition it returns formats, preferences and other settings to the factory default settings.

✓ **NOTE** Any data previously synchronized with a computer can be restored during the next ActiveSync operation.

Methods of Suspension

VC5090 operation can be suspended in three ways:

- **Manual suspension**: the operator presses the Power button when the vehicle computer is on.
- **API suspension**: the application requests a suspend via an API call.
- **Time-out suspension**: suspends after the vehicle computer is not used for a set amount of time. Tap > Settings > Control Panel > Power icon > Power Off tab to set the time-out value.

Critical Suspension

Critical suspension occurs when input power is not available and the UPS is either not installed or is discharged to a very low state. During critical suspension all circuitry is shutdown except for memory retention and the real-time clock. During critical suspension the VC5090 is receiving power from the backup battery or residual power from the UPS. The backup battery retains data for at least 72 hours. Critical suspension occurs when:

- a VC5090 without a UPS is in suspend mode and external power is removed.
- the VC5090 is receiving power from the UPS and the UPS discharges.
Waking the Vehicle Computer

The wakeup conditions define what actions wakeup the vehicle computer after it has gone into suspend mode. The vehicle computer can go into suspend mode by either pressing the Power button on the Quick Access Panel or automatically by control panel timeout settings. Tap <Settings > Control Panel > Power icon > Wakeup tab.

These settings are configurable and the factory default settings are shown in Table 3-5.

The Condition for Wakeup table shows the default settings for each condition:

<table>
<thead>
<tr>
<th>Condition for Wakeup</th>
<th>Power Button</th>
<th>Automatic TimeOut</th>
</tr>
</thead>
<tbody>
<tr>
<td>AC power is applied.</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Forklift Ignition turns on.</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Forklift Ignition turns off.</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>VC5090 is connected to a serial device.</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>VC5090 is connected to a USB device.</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>VC5090 is disconnected from a USB device.</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>A key is pressed.</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>An attached scanner is triggered.</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Screen is touched.</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Wireless LAN activity is detected.</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>A headset is connected to the VC5090.</td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Calibrating the Screen

Using the Display

**CAUTION** Do not use sharp objects when touching the screen. Use your finger tip or a stylus when touching the screen.

This section describes how to calibrate the VC5090 touch screen. If the current calibration does not allow for easy touch screen input or you want to recalibrate the screen at any time, refer to *Using the Keyboard on page 3-19*.

To calibrate your VC5090:

1. Tap 📧 > Settings > Control Panel > Stylus icon > Calibration tab.

![Stylus Properties - Calibration Tab Window](image)

**Figure 3-27**  *Stylus Properties - Calibration Tab Window*

2. Tap the Recalibrate button. The calibration screen displays.

![Carefully press and briefly hold stylus on the center of the target. Repeat as the target moves around the screen. Press the Esc key to cancel.](image)

**Figure 3-28**  *Calibration Screen*
3. As the screen instructs, carefully touch and briefly hold on the center of each target that appears on the screen. Repeat as the target moves around the screen.

4. Tap the screen to accept the new calibration.

\[ \text{NOTE} \quad \text{If the calibration screen fails to respond, contact Support Central for assistance.} \]

**Using the Keyboard**

If the present calibration does not allow you to use the touch screen, use the keyboard (or any standard USB keyboard) to calibrate:

1. Press Ctrl + Esc keys to access the Start menu.
2. Using the arrow keys, select Settings > Control Panel.
3. Press Enter to display the Control Panel window.

![Control Panel Window](image)

**Figure 3-29  Control Panel Window**

4. Using the arrow keys, move to the Stylus icon and press Enter. The Stylus Properties window appears.
5. Using the Tab key (key with double arrows), select the Calibration tab.

6. Using the Tab key, select the Recalibrate button.

7. Press the space key to start the calibration process. The calibration screen appears.
8. As the screen instructs, carefully touch and briefly hold on the center of each target that appears. Repeat as the target moves around the screen.

9. Tap the screen to accept the new calibration.

✓ **NOTE** If the calibration screen fails to respond, contact Support Central for assistance.
Checking Battery Status

To check whether the backup battery in the vehicle computer is charged, tap $\Rightarrow$ > Settings > Control Panel > Power icon to display the Power Settings window.

To save battery power, set the vehicle computer to turn off after a specified number of minutes.

Ignition Sensing

The vehicle computer contains an Ignition Sense feature that detects when the ignition switch is turned off and shuts the vehicle computer down after a preprogrammed timeout. This feature allows the operator to use the vehicle computer for a predetermined time period after the ignition switch is turned off, then shuts the vehicle computer down automatically to prevent over-discharge of the forklift battery. The timeout period is adjustable by the user. The normal current draw of a suspended vehicle computer is approximately 500mA. When the vehicle computer shuts down using the Ignition Sense feature, current draw is reduced to approximately 5 mA. This feature provides the automatic shutoff functionality of an external relay, without requiring an actual relay and has the added benefit of allowing the user to work for a preset time period before shutting down.

The power cable must be connected to the ignition switch. See on page 2-14 for information on connecting the power cable to enable the Ignition Sense feature.

NOTE These settings are not persistent across a cold boot.

1. Tap $\Rightarrow$ > Settings > Control Panel > VC5090 System Management icon. The System Management window displays.

2. Select the Miscellaneous tab.

![Figure 3-33 Miscellaneous Tab Window]

3. In the Forklift Ignition Timeout drop-down list, select the amount of time before the vehicle computer shuts down after the ignition switch is turned off.

4. Tap OK.
Chapter 4 Wireless Applications

Introduction

Wireless Local Area Networks (WLANs) allow mobile computers to communicate wirelessly and send data to a host device in real time. Before using the vehicle computer on a WLAN, the facility must be set up with the required hardware to run the wireless LAN and the vehicle computer must be configured. Refer to the documentation provided with the access points (APs) for instructions on setting up the hardware.

To configure the vehicle computer, a set of wireless applications provide the tools to configure and test the wireless radio in the vehicle computer. The **Wireless Application** menu on the task tray provides the following wireless applications:

- Wireless Status
- Wireless Diagnostics
- Find WLANs
- Manage Profiles
- Options
- Log On/Off
- Enable/Disable Radio (Fusion 2.5 and above only).

Tap the **Signal Strength** icon to display the **Wireless Applications** menu.
Signal Strength Icon

The Signal Strength icon in the task tray indicates the mobile computer’s wireless signal strength as follows:

Table 4-1  Wireless Applications Icons, Signal Strength Descriptions

<table>
<thead>
<tr>
<th>Icon</th>
<th>Status</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Excellent signal strength</td>
<td>Wireless LAN network is ready to use.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Very good signal strength</td>
<td>Wireless LAN network is ready to use.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Good signal strength</td>
<td>Wireless LAN network is ready to use.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Fair signal strength</td>
<td>Wireless LAN network is ready to use. Notify the network administrator that the signal strength is only “Fair”.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Poor signal strength</td>
<td>Wireless LAN network is ready to use. Performance may not be optimum. Notify the network administrator that the signal strength is “Poor”.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Out-of-network range (not associated)</td>
<td>No wireless LAN network connection. Notify the network administrator.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>No wireless LAN network card detected.</td>
<td>No wireless LAN network card detected or radio disabled. Notify the network administrator.</td>
</tr>
</tbody>
</table>

Turning the WLAN Radio On and Off

With Fusion 2.0

To turn off the WLAN radio:

1. Tap 📱 > Settings > Control Panel > Power icon > PwrDevices tab.
2. In the text box, scroll down until WLP1: displays.
3. Select **WLP1**: WLP1 displays in the text box at the top of the window.
4. In the drop-down list, select **D4**.
5. Tap **Set**.
6. Tap **OK**.

To turn on the radio:

1. Tap 📱 > **Settings** > **Control Panel** > **Power** icon > **PwrDevices** tab.
2. In the text box, scroll down until **WLP1** displays.
3. Select **WLP1**: WLP1 displays in the text box at the top of the window.
4. In the drop-down list, select **D0**.
5. Tap **Set**.
6. Tap **OK**.

**With Fusion 2.5**

To turn the WLAN radio off tap the **Signal Strength** icon and select **Disable Radio**.

![Figure 4-2 Disable Radio](image)

To turn the WLAN radio on tap the **Signal Strength** icon and select **Enable Radio**.

![Figure 4-3 Enable Radio](image)
Find WLANs Application

Use the Find WLANs application to discover available networks in the vicinity of the user and mobile computer. To open the Find WLANs application, tap the Signal Strength icon - Find WLANs. The Find WLANs window displays.

![Find WLANs Window](image)

**Figure 4-4 Find WLANs Window**

*NOTE* Find WLAN display is limited to 32 items (ESSIDs or MAC addresses). A combination of up to 32 ESSIDs/APs may be displayed.

Manually enter valid ESSIDs not displayed in the Find WLANs window. See Figure 4-5 on page 4-5.

The Find WLANs list displays:

- WLAN Networks - Available wireless networks with icons that indicate signal strength and encryption type. The signal strength and encryption icons are described in Table 4-2 and Table 4-3.
- Network Type - Type of network.
- Channel - Channel on which the AP is transmitting.
- Signal Strength - The signal strength of the signal from the AP.

### Table 4-2 Signal Strength Icon

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Excellent signal</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Very good signal</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Good signal</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Fair signal</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Poor signal</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Out of range or no signal</td>
</tr>
</tbody>
</table>
Tap-and-hold on a WLAN network to open a pop-up menu which provides two options: **Connect** and **Refresh**. Select **Refresh** to refresh the WLAN list. Select **Connect** to create a wireless profile from that network. This starts the **Profile Editor Wizard** which allows you to set the values for the selected network. After editing the profile, the vehicle computer automatically connects to this new profile.

---

### Profile Editor Wizard

Use the **Profile Editor Wizard** to create a new profile or edit an existing profile. If editing a profile, the fields reflect the current settings for that profile. If creating a new profile, the known information for that WLAN network appears in the fields.

Navigate through the wizard using the **Next** and **Back** buttons. Tap **X** to quit. On the confirmation dialog box, tap **No** to return to the wizard or tap **Yes** to quit and return to the **Manage Profiles** window. See *Manage Profiles Application on page 4-22* for instructions on navigating the **Profile Editor Wizard**.

### Profile ID

In the **Profile ID** dialog box in the **Profile Editor Wizard**, enter the profile name and the ESSID.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🕵️‍♂️</td>
<td>No encryption. WLAN is an infrastructure network.</td>
</tr>
<tr>
<td>🕵️‍♂️</td>
<td>WLAN is an Ad-Hoc network.</td>
</tr>
<tr>
<td>🕵️‍♂️</td>
<td>WLAN access is encrypted and requires a password.</td>
</tr>
</tbody>
</table>

![Figure 4-5 Profile ID Dialog Box](image)

**Table 4-4 Profile ID Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name and (WLAN) identifier of the network connection. Enter a user friendly name for the mobile computer profile used to connect to either an AP or another networked computer. Example: The Public LAN.</td>
</tr>
<tr>
<td>ESSID</td>
<td>The ESSID is the 802.11 extended service set identifier. The ESSID is 32-character (maximum) string identifying the WLAN, and must match the AP ESSID for the vehicle computer to communicate with the AP.</td>
</tr>
</tbody>
</table>

**NOTE** Two profiles with the same user friendly name are acceptable but not recommended.
Tap Next. The Operating Mode dialog box displays.

Operating Mode

Use the Operating Mode dialog box to select the operating mode (Infrastructure or Ad-Hoc) and the country location.

![Operating Mode Dialog Box](image)

Figure 4-6 Operating Mode Dialog Box

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating Mode</td>
<td>Select <strong>Infrastructure</strong> to enable the vehicle computer to transmit and receive data with an AP. Infrastructure is the default mode. Select <strong>Ad Hoc</strong> to enable the vehicle computer to form its own local network where mobile computers communicate peer-to-peer without APs using a shared ESSID.</td>
</tr>
</tbody>
</table>
Wireless Applications 4 - 7

Table 4-5 Operating Mode Fields (Continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Country</td>
<td><strong>Country</strong> determines if the profile is valid for the country of operation. The profile country must match the country in the options page or it must match the acquired country if 802.11d is enabled.</td>
</tr>
<tr>
<td></td>
<td><strong>Single Country Use:</strong></td>
</tr>
<tr>
<td></td>
<td>When the device is only used in a single country, set every profile country to <strong>Allow Any Country</strong>. In the <strong>Options &gt; Regulatory</strong> dialog box (see <strong>Figure 4-46 on page 4-34</strong>), select the specific country the device is used in, and deselect the <strong>Enable 802.11d</strong> option. This is the most common and efficient configuration, eliminating the initialization overhead associated with acquiring a country via 802.11d.</td>
</tr>
<tr>
<td></td>
<td><strong>Multiple Country Use:</strong></td>
</tr>
<tr>
<td></td>
<td>When the device is used in more than one country, select the <strong>Enable 802.11d</strong> option in the <strong>Options &gt; Regulatory</strong> dialog box (see <strong>Figure 4-46 on page 4-34</strong>). This eliminates the need for reprogramming the country (in <strong>Options &gt; Regulatory</strong>) each time you enter a new country. However, this only works if the infrastructure (i.e., APs) supports 802.11d (some infrastructures do not support 802.11d, including some Cisco APs). When the Enable 802.11d option is selected, the <strong>Options &gt; Regulatory &gt; Country</strong> setting is not used. For a single profile that can be used in multiple countries, with infrastructure that supports 802.11d (including Symbol infrastructure), set the Profile Country to <strong>Allow Any Country</strong>. Under <strong>Options &gt; Regulatory</strong>, select <strong>Enable 802.11d</strong>. The <strong>Options &gt; Regulatory &gt; Country</strong> setting is not used.</td>
</tr>
</tbody>
</table>

Country (Continued)

For a single profile that can be used in multiple countries, but with infrastructure that does not support 802.11d, set the profile country to **Allow Any Country**, and de-select (uncheck) **Enable 802.11d**. In this case, the **Options > Regulatory > Country** setting must always be set to the country the device is currently in. This configuration option is the most efficient and may be chosen for use with any infrastructure. However, the **Options > Regulatory > Country** setting must be manually changed when a new country is entered. Note that using a single profile in multiple countries implies that there is a common ESSID to connect to in each country. This is less likely than having unique ESSIDs in each country, this requires unique profiles for each country.

For additional efficiency when using multiple profiles that can be used in multiple countries, the country setting for each profile can be set to a specific country. If the current country (found via 802.11d or set by **Options > Regulatory > Country** when 802.11d is disabled) does not match the country set in a given profile, then that profile is disabled. This can make profile roaming occur faster. For example, if two profiles are created and configured for Japan, and two more profiles are created and configured for USA, then when in Japan only the first two profiles are active, and when in USA only the last two are active. If they had all been configured for **Allow Any Country**, then all four would always be active, making profile roaming less efficient.

Tap **Next**. If **Ad-Hoc** mode was selected the **Ad-Hoc** dialog box displays. If **Infrastructure** mode was selected the **Authentication** dialog box displays. See **Authentication on page 4-8** for instruction on setting up authentication.

**Ad-Hoc**

Use the **Ad-Hoc** dialog box to select the required information to control **Ad-Hoc** mode. This dialog box does not appear if you selected **Infrastructure** mode. The channels listed are dependent upon the band selected in the **Options > Band Selection** window. See **Band Selection on page 4-34** for more information. To select **Ad-Hoc** mode:
1. Select a channel number from the Channel drop-down list.

Table 4-6  Ad-Hoc Channels

<table>
<thead>
<tr>
<th>Band</th>
<th>Channel</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.4 GHz</td>
<td>1</td>
<td>2412 MHz</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>2417 MHz</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>2422 MHz</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>2427 MHz</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>2432 MHz</td>
</tr>
<tr>
<td></td>
<td>6</td>
<td>2437 MHz</td>
</tr>
<tr>
<td></td>
<td>7</td>
<td>2442 MHz</td>
</tr>
<tr>
<td></td>
<td>8</td>
<td>2447 MHz</td>
</tr>
<tr>
<td></td>
<td>9</td>
<td>2452 MHz</td>
</tr>
<tr>
<td></td>
<td>10</td>
<td>2457 MHz</td>
</tr>
<tr>
<td></td>
<td>11</td>
<td>2462 MHz</td>
</tr>
<tr>
<td>5 GHz</td>
<td>36</td>
<td>5180 MHz</td>
</tr>
<tr>
<td></td>
<td>40</td>
<td>5200 MHz</td>
</tr>
<tr>
<td></td>
<td>44</td>
<td>5220 MHz</td>
</tr>
<tr>
<td></td>
<td>48</td>
<td>5240 MHz</td>
</tr>
</tbody>
</table>

Figure 4-7  Ad-Hoc Settings Dialog Box

2. Tap Next. The Encryption dialog box displays. See Encryption on page 4-16 for encryption options.

Authentication

Use the Authentication dialog box to configure authentication. If you selected Ad-Hoc mode, this dialog box is not available and authentication is set to None by default.

Select an authentication type from the drop-down list and tap Next. Selecting PEAP or TTLS displays the Tunneled dialog box. Selecting None, EAP TLS, or LEAP displays the Encryption dialog box. See Encryption on page 4-16 for encryption options. Table 4-7 lists the available authentication options.
Use the Tunneled Authentication dialog box to select the tunneled authentication options. There are different selections available for PEAP or TTLS authentication.

**Table 4-7  Authentication Options**

<table>
<thead>
<tr>
<th>Authentication</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>Default setting when authentication is not required on the network.</td>
</tr>
<tr>
<td>EAP-TLS</td>
<td>Select this option to enable EAP-TLS authentication. EAP-TLS is an authentication scheme through IEEE 802.1x. It authenticates users and ensures only valid users can connect to the network. It also restricts unauthorized users from accessing transmitted information by using secure authentication certificates.</td>
</tr>
<tr>
<td>PEAP</td>
<td>Select this option to enable PEAP authentication. This method uses a digital certificate to verify and authenticate a user's identity.</td>
</tr>
<tr>
<td>LEAP</td>
<td>Select this option to enable LEAP authentication, which is based on mutual authentication. The AP and the connecting mobile computer require authentication before gaining access to the network.</td>
</tr>
<tr>
<td>TTLS</td>
<td>Select this option to enable TTLS authentication.</td>
</tr>
</tbody>
</table>

**Tunneled Authentication**

To select a tunneled authentication type:

1. Select a tunneled authentication type from the drop-down list. See Table 4-8 and Table 4-9.

2. Select the User Certificate check box if a certificate is required. If you selected the TLS tunnel type that requires a user certificate, the check box is already selected.

3. Tap Next. The Installed User Certificates dialog box appears.
Table 4-8 lists the PEAP tunneled authentication options.

### Table 4-8: PEAP Tunneled Authentication Options

<table>
<thead>
<tr>
<th>PEAP Tunneled Authentication</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MS CHAP v2</td>
<td>Microsoft Challenge Handshake Authentication Protocol version 2 (MS CHAP v2) is a password-based, challenge-response, mutual authentication protocol that uses the industry-standard Message Digest 4 (MD4) and Data Encryption Standard (DES) algorithms to encrypt responses. The authenticating server challenges the access client and the access client challenges the authenticating server. If either challenge is not correctly answered, the connection is rejected. MS CHAP v2 was originally designed by Microsoft as a PPP authentication protocol to provide better protection for dial-up and virtual private network (VPN) connections. With Windows XP SP1, Windows XP SP2, Windows Server 2003, and Windows 2000 SP4, MS CHAP v2 is also an EAP type.</td>
</tr>
<tr>
<td>TLS</td>
<td>EAP TLS is used during phase 2 of the authentication process. This method uses a user certificate to authenticate.</td>
</tr>
</tbody>
</table>

Table 4-9 lists the TTLS tunneled authentication options.

### Table 4-9: TTLS Tunneled Authentication Options

<table>
<thead>
<tr>
<th>TTLS Tunneled Authentication</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CHAP</td>
<td>Challenge Handshake Authentication Protocol (CHAP) is one of the two main authentication protocols used to verify the user name and password for PPP Internet connections. CHAP is more secure than PAP because it performs a three way handshake during the initial link establishment between the home and remote machines. It can also repeat the authentication anytime after the link is established.</td>
</tr>
<tr>
<td>MS CHAP</td>
<td>Microsoft Challenge Handshake Authentication Protocol (MS CHAP) is an implementation of the CHAP protocol that Microsoft created to authenticate remote Windows workstations. MS CHAP is identical to CHAP, except that MS CHAP is based on the encryption and hashing algorithms used by Windows networks, and the MS CHAP response to a challenge is in a format optimized for compatibility with Windows operating systems.</td>
</tr>
<tr>
<td>MS CHAP v2</td>
<td>MS CHAP v2 is a password based, challenge response, mutual authentication protocol that uses the industry standard Message Digest 4 (MD4) and Data Encryption Standard (DES) algorithms to encrypt responses. The authenticating server challenges the access client and the access client challenges the authenticating server. If either challenge is not correctly answered, the connection is rejected. MS CHAP v2 was originally designed by Microsoft as a PPP authentication protocol to provide better protection for dial-up and virtual private network (VPN) connections. With Windows XP SP1, Windows XP SP2, Windows Server 2003, and Windows 2000 SP4, MS CHAP v2 is also an EAP type.</td>
</tr>
<tr>
<td>PAP</td>
<td>Password Authentication Protocol (PAP) has two variations: PAP and CHAP PAP. It verifies a user name and password for PPP Internet connections, but it is not as secure as CHAP, since it works only to establish the initial link. PAP is also more vulnerable to attack because it sends authentication packets throughout the network. Nevertheless, PAP is more commonly used than CHAP to log in to a remote host like an Internet service provider.</td>
</tr>
<tr>
<td>MD5</td>
<td>Message Digest-5 (MD5) is an authentication algorithm developed by RSA. MD5 generates a 128-bit message digest using a 128-bit key, IPSec truncates the message digest to 96 bits.</td>
</tr>
</tbody>
</table>
**User Certificate Selection**

If you checked the User Certificate check box on the Tunneled Authentication dialog box or if TLS is the selected authentication type, the Installed User Certificates dialog box displays. Select a certificate from the drop-down list of currently installed certificates before proceeding. The selected certificate's name appears in the drop-down list. If the required certificate is not in the list, install it.

![Installed User Certificates Dialog Box](image)

**Figure 4-10  Installed User Certificates Dialog Box**

**User Certificate Installation**

To install a user certificate (EAP TLS only) and a server certificate for EAP TLS and PEAP authentication:

1. Tap Install Certificate. The Credentials dialog box appears.

![Credentials Dialog Box](image)

**Figure 4-11  Credentials Dialog Box**

2. Enter the User:, Pwd: (password), and Server: information in their respective text boxes.

3. Tap Retrieve. A Progress dialog indicates the status of the certificate retrieval.

4. Tap ok to exit.

After the installation completes, the Installed User Certs dialog box displays and the certificate is available in the drop-down for selection.

> **NOTE** To successfully install a user certificate, the vehicle computer must already be connected to a network from which the server is accessible.

**Server Certificate Selection**

If you select the Validate Server Certificate check box, a server certificate is required. Select a certificate on the Installed Server Certificates dialog box. An hour glass may appear as the wizard populates the existing certificate list. If the required certificate is not listed, install it:

1. Tap the Install Certificate button.
Figure 4-12  Installed Server Certificates Dialog Box

A dialog box appears that lists the currently loaded certificate files found in the default directory (Application) with the default extension.

Figure 4-13  Browse Server Certificates

2. Navigate to the folder where the certificate is stored. Tap the certificate filename and then tap ok.

3. A confirmation dialog verifies the installation. If the information in this dialog is correct, tap the Yes button, If the information in this dialog is not correct tap the No button. The wizard returns to the Installed Server Certs dialog box.

Figure 4-14  Confirmation Dialog Box

Credential Cache Options

If you selected any of the password-based authentication types, you can select different credential caching options. These options specify when the network credential prompts appear: at connection, on each resume, or at a specified time.
Entering the credentials directly into the profile permanently caches the credentials. In this case, the vehicle computer does not require user login. If a profile does not contain credentials entered through the configuration editor, you must log in to the vehicle computer before connecting.

Caching options only apply on credentials entered through the login dialog box.

![Figure 4-15 Prompt for Login at Dialog Box](image)

If the vehicle computer does not have the credentials, you are prompted to enter a username and password. If the vehicle computer has the credentials (previous entered via a login dialog box), it uses these credentials unless the caching options require the vehicle computer to prompt for new credentials. If you entered the credentials via the profile, the vehicle computer does not prompt for new credentials. Table 4-10 lists the caching options.

<table>
<thead>
<tr>
<th>Cache Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>At Connect</td>
<td>Select this option to prompt for credentials whenever the mobile computer tries to connect to a new profile. Deselect this to use the cached credentials to authenticate. If the credentials are not cached, you are prompted to enter credentials. This option only applies when logged in.</td>
</tr>
<tr>
<td>On Resume</td>
<td>Selecting this reauthenticates an authenticated user when a suspend/resume occurs. Once reauthenticated, the user is prompted for credentials. If the user does not enter the same credentials that were entered prior to the suspend/resume within three attempts, the user is disconnected from the network. This option only applies when logged in.</td>
</tr>
<tr>
<td>At Time</td>
<td>Select this option to perform a local verification on an authenticated user at a specified time. The time can be an absolute time or a relative time from the authentication, and should be in at least 5 minute intervals. Once the time has passed, the user is prompted for credentials. If the user does not enter the correct credentials within three attempts, the user is disconnected from the network. This option only applies when logged in.</td>
</tr>
</tbody>
</table>

Entering credentials applies these credentials to a particular profile. Logging out clears all cached credentials. Editing a profile clears all cached credentials for that profile.

The following authentication types have credential caching:

- EAP TLS
- PEAP
- LEAP
- TTLS.

Selecting the **At Time** check box displays the **Time Cache Options** dialog box.
Figure 4-16   Time Cache Options Dialog Box

1. Tap the Interval radio button to check credentials at a set time interval.
2. Enter the value in minutes in the Min box.
3. Tap the At (hh:mm) radio button to check credentials at a set time.
4. Tap Next. The At Time dialog box appears.

Figure 4-17   At Time Dialog Box

5. Enter the time using the 24 hour clock format in the (hh:mm) box.
6. Tap > to move the time to the right. Repeat for additional time periods.
7. Tap Next. The User Name dialog box displays.

User Name

The user name and password can be entered (but is not required) when the profile is created. When a profile authenticates with credentials that were entered in the profile, caching rules do not apply. Caching rules only apply on credentials that are entered through the login dialog box.
Password

Use the Password dialog box to enter a password. If EAP/TLS is the selected authentication type, the password is not required and the field is disabled.

![Password Dialog Box](image)

Figure 4-19 Password Dialog Box

1. Enter a password in the Password field.
2. Select the Advanced ID check box, if advanced identification is required.
3. Tap Next. The Encryption dialog box displays. See Encryption on page 4-16.

Advanced Identity

Use the Advanced ID dialog box to enter the 802.1X identity to supply to the authenticator. This value can be 63 characters long and is case sensitive. In TTLS and PEAP, it is recommended entering the identity anonymous (rather than a true identity) plus any desired realm (e.g., anonymous@myrealm). A user ID is required before proceeding.

✓ **NOTE** When authenticating with a Microsoft IAS server, do not use advanced identity.

![Advanced Identity Dialog Box](image)

Figure 4-20 Advanced Identity Dialog Box

Tap Next. The Encryption dialog box displays.
Encryption

Use the Encryption dialog box to select an encryption type. The drop-down list includes encryption types available for the selected authentication type. See Table 4-12 for these encryption types.

![Encryption Dialog Box](image)

**Table 4-11 Encryption Options**

<table>
<thead>
<tr>
<th>Encryption</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>Select <strong>Open</strong> (the default) when no data packet encryption is needed over the network. Selecting this option provides no security for data transmitting over the network.</td>
</tr>
<tr>
<td>40-Bit WEP</td>
<td>Select 40-Bit WEP to use 40-bit key length WEP encryption. WEP keys are manually entered in the edit boxes. Only the required number of edit boxes for a key length is displayed (10 Hex digit value for 40-bit keys). Use the <strong>Key Index</strong> drop-down list to configure the four WEP keys. The adapter uses the selected key. Note: The default Hex digit keys are visible any time they are used. As a security precaution after setting the key values for the network, the digits are replaced with asterisks * in the encryption key fields. If the associated AP uses an optional passkey, the active adapter WLAN profile must use one as well. The passkey is a plain text representation of the WEP keys displayed in the encryption dialog box. The passkey provides an easy way to enter WEP key data without having to remember the entire 40-bit (10 character) Hex digit string.</td>
</tr>
<tr>
<td>128-Bit WEP</td>
<td>Select 128-Bit WEP to use 128-bit key length WEP encryption. WEP keys are manually entered in the edit boxes. Only the required number of edit boxes for a key length is displayed (26 Hex digit value for 128-bit keys). Use the <strong>Key Index</strong> drop-down list to configure the four WEP keys. The adapter uses the selected key. Note: The default Hex digit keys are visible any time they are used. As a security precaution after setting the key values for the network, the digits are replaced with asterisks * in the encryption key fields. If the associated AP uses an optional passkey, the active adapter WLAN profile must use one as well. The passkey is a plain text representation of the WEP keys displayed in the encryption dialog box. The passkey provides an easy way to enter WEP key data without having to remember the entire 128-bit (26 character) Hex digit string.</td>
</tr>
<tr>
<td>TKIP</td>
<td>Select this option to use Wireless Protected Access (WPA) via TKIP. Manually enter the shared keys in the passkey field. Tap <strong>Next</strong> to display the passkey dialog box. Enter an 8 to 63 character string.</td>
</tr>
<tr>
<td>AES (Fusion 2.5 only)</td>
<td>Select this option to use Advanced Encryption Standard (AES). Manually enter the shared keys in the passkey field. Tap <strong>Next</strong> to display the passkey dialog box. Enter an 8 to 63 character string.</td>
</tr>
</tbody>
</table>
Table 4-12  Encryption / Authentication Matrix

<table>
<thead>
<tr>
<th>Authentication</th>
<th>Open</th>
<th>WEP</th>
<th>TKIP</th>
<th>AES (Fusion 2.5 only)</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>EAP TLS</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>PEAP</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>LEAP</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>TTLS</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

**Key Entry Page**

If you select either 40-Bit WEP or 128-Bit WEP the wizard proceeds to the key entry dialog box unless the Use Passkey check box was selected in the Encryption dialog box (see Figure 4-21 on page 4-16). The Key Entry dialog box will be shown only if the authentication is set to None. To enter the key information:

1. Enter the 40-bit or 128-bit keys into the fields.
2. Tap Next.

![40-Bit WEP Keys Dialog Box](image)

**Figure 4-22  40-Bit and 128-Bit WEP Keys Dialog Boxes**

**Passkey Dialog**

When you select None as an authentication and WEP as an encryption, you can choose to enter a passkey by checking the Use PassKey check box. The user is prompted to enter the passkey. For WEP, the Use PassKey checkbox is only available if the authentication is None.

When you select None as an authentication and TKIP as an encryption, you must enter a passkey. The user cannot enter a passkey if the encryption is TKIP and the authentication is anything other than None.

When you select None as an authentication and AES as an encryption, you must enter a passkey. The user cannot enter a passkey if the encryption is AES and the authentication is anything other than None.
Figure 4-23  Passkey Dialog Box

Tap Next. The IP Mode dialog box displays.

IP Mode

Use the IP Mode dialog box to configure network address parameters: IP address, subnet, gateway, DNS, and WINS.

Figure 4-24  IP Config Tab (DHCP)

Table 4-13  IP Mode Options

<table>
<thead>
<tr>
<th>Encryption</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DHCP</td>
<td>Select Dynamic Host Configuration Protocol (DHCP) from the IP Mode drop-down list to obtain a leased IP address and network configuration information from a remote server. DHCP is the default setting for the vehicle computer profile. When DHCP is selected, the IP address fields are read-only.</td>
</tr>
<tr>
<td>Static</td>
<td>Select Static to manually assign the IP, subnet mask, default gateway, DNS, and WINS addresses the vehicle computer profile uses.</td>
</tr>
</tbody>
</table>

Select either DHCP or Static from the drop-down list and tap Next. Selecting Static IP displays the IP Address Entry dialog box. Selecting DHCP displays the Transmit Power dialog box.

IP Address Entry

Use the IP Address Entry dialog box to enter the IP address and subnet information.

Figure 4-25  Static IP Address Entry Dialog Box
Select the Advanced check box, then tap NEXT to display the Advanced Address Entry dialog box. Enter the Gateway, DNS, and WINS address. Tap NEXT without selecting the Advanced check box to display the Transmit Power dialog box.

Table 4-14 Static IP Address Entry Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP Address</td>
<td>The Internet is a collection of networks with users that communicate with each other. Each communication carries the address of the source and destination networks and the particular machine within the network associated with the user or host computer at each end. This address is called the IP address (Internet Protocol address). Each node on the IP network must be assigned a unique IP address that is made up of a network identifier and a host identifier. Enter the IP address as a dotted-decimal notation with the decimal value of each octet separated by a period, for example, 192.168.7.27.</td>
</tr>
<tr>
<td>Subnet Mask</td>
<td>Most TCP/IP networks use subnets to manage routed IP addresses. Dividing an organization's network into subnets allows it to connect to the Internet with a single shared network address, for example, 255.255.255.0.</td>
</tr>
</tbody>
</table>

Select the Advanced check box, then tap NEXT to display the Advanced Address Entry dialog box. Enter the Gateway, DNS, and WINS address. Tap NEXT without selecting the Advanced check box to display the Transmit Power dialog box.

Figure 4-26 Advanced Address Entry Dialog Box

The IP information entered in the profile is only used if you selected the Enable IP Mgmt check box in the Options > System Options dialog box (System Options on page 4-35). If you didn’t select this, the IP information in the profile is ignored and the IP information entered in the Microsoft interface applies.

Table 4-15 IP Config Advanced Address Entry Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>G/W</td>
<td>The default gateway forwards IP packets to and from a remote destination.</td>
</tr>
<tr>
<td>DNS</td>
<td>The Domain Name System (DNS) is a distributed Internet directory service. DNS translates domain names and IP addresses, and controls Internet email delivery. Most Internet services require DNS to operate properly. If DNS is not configured, Web sites cannot be located and/or email delivery fails.</td>
</tr>
<tr>
<td>WINS</td>
<td>WINS is a Microsoft® Net BIOS name server. WINS eliminates the broadcasts needed to resolve computer names to IP addresses by providing a cache or database of translations.</td>
</tr>
</tbody>
</table>

Tap Next. The Transmit Power dialog box displays.

**Transmit Power**

The Transmit Power drop-down list contains different options for Ad-Hoc and Infrastructure mode. Automatic (i.e., use the current AP settings) and Power Plus (use higher than the current AP settings) are available for Infrastructure mode.
Adjusting the radio transmission power level enables the user to expand or confine the transmission area with respect to other wireless devices that could be operating nearby. Reducing coverage in high traffic areas improves transmission quality by reducing the amount of interference in that coverage area.

Figure 4-27  Transmit Power Dialog Box (Infrastructure Mode)

Table 4-16  Transmit Power Dialog Box (Infrastructure Mode)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatic</td>
<td>Select <strong>Automatic</strong> (the default) to use the AP power level.</td>
</tr>
<tr>
<td>Power Plus</td>
<td>Select <strong>Power Plus</strong> to set the vehicle computer transmission power one level higher than the level set for the AP.</td>
</tr>
</tbody>
</table>

Figure 4-28  Transmit Power Dialog Box (Ad-Hoc Mode)

Table 4-17  Power Transmit Options (Ad-Hoc Mode)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full</td>
<td>Select <strong>Full</strong> power for the highest transmission power level. Select <strong>Full</strong> power when operating in highly reflective environments and areas where other devices could be operating nearby, or when attempting to communicate with devices at the outer edge of a coverage area.</td>
</tr>
<tr>
<td>30 mW</td>
<td>Select <strong>30 mW</strong> to set the transmit power level to 30 mW.</td>
</tr>
<tr>
<td>15 mW</td>
<td>Select <strong>15 mW</strong> to set the transmit power level to 15 mW.</td>
</tr>
<tr>
<td>5 mW</td>
<td>Select <strong>5 mW</strong> to set the transmit power level to 5 mW.</td>
</tr>
<tr>
<td>1 mW</td>
<td>Select <strong>1 mW</strong> for the lowest transmission power level. Use this level when communicating with other devices in very close proximity, or in instances where you expect little or no radio interference from other devices.</td>
</tr>
</tbody>
</table>

Tap **Next** to display the **Battery Usage** dialog box.
Battery Usage

Use the **Battery Usage** dialog box to select power consumption of the wireless LAN. There are three settings available: CAM, Fast Power Save, and MAX Power Save. Battery usage cannot be configured in Ad-Hoc profiles.

![Battery Usage Dialog Box](image)

**Figure 4-29  Battery Usage Dialog Box**

- **NOTE**  
  Power consumption is also related to the transmit power settings.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CAM</td>
<td>Continuous Aware Mode (CAM) provides the best network performance, but yields the shortest battery life.</td>
</tr>
<tr>
<td>Fast Power Save</td>
<td><em>Fast Power Save</em> (the default) performs in the middle of CAM and MAX Power Save with respect to network performance and battery life.</td>
</tr>
<tr>
<td>MAX Power Save</td>
<td><em>Max Power Save</em> yields the longest battery life while potentially reducing network performance. In networks with minimal latency, Max Power Save performs as well as Fast Power Save, but with increased battery conservation.</td>
</tr>
</tbody>
</table>
Manage Profiles Application

The Manage Profiles window provides a list of user-configured wireless profiles. Define up to 32 profiles at any one time. To open the Manage Profiles window, tap the Signal Strength icon > Manage Profiles.

![Figure 4-30: Manage Profiles Window](image)

Icons next to each profile identify the profile’s current state.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="No Icon" /></td>
<td>Profile is not selected, but enabled.</td>
</tr>
<tr>
<td><img src="image" alt="Profile Disabled" /></td>
<td>Profile is disabled.</td>
</tr>
<tr>
<td><img src="image" alt="Profile Cancelled" /></td>
<td>Profile is cancelled. A cancelled profile is disabled until a connect or login function is performed through the configuration editor.</td>
</tr>
<tr>
<td><img src="image" alt="Profile Infrastructure No Encryption" /></td>
<td>Profile is in use and describes an infrastructure profile not using encryption.</td>
</tr>
<tr>
<td><img src="image" alt="Profile Infrastructure Encryption" /></td>
<td>Profile is in use and describes an infrastructure profile using encryption.</td>
</tr>
<tr>
<td><img src="image" alt="Profile Ad-Hoc No Encryption" /></td>
<td>Profile is in use and describes an ad-hoc profile not using encryption.</td>
</tr>
<tr>
<td><img src="image" alt="Profile Ad-Hoc Encryption" /></td>
<td>Profile is in use and describes an ad-hoc profile using encryption.</td>
</tr>
<tr>
<td><img src="image" alt="Profile Invalid" /></td>
<td>Profile is not valid in the device current operating regulatory domain.</td>
</tr>
</tbody>
</table>

The profiles are listed in priority order for use by the automatic roaming feature. Change the order by moving profiles up or down. To edit existing profiles, tap and hold one in the list and select an option from the menu to connect, edit, disable (enable), or delete the profile. (Note that the Disable menu item changes to Enable if the profile is already disabled.)
Changing Profiles

A completed profile is a set of configuration settings that can be used in different locations to connect to a wireless network. Create different profiles to have pre-defined operating parameters available for use in various network environments. When the WLAN Profiles window displays, existing profiles appear in the list.

Editing a Profile

Tap and hold a profile and select Edit from the pop-up menu to display the Profile Wizard where you can set the ESSID and operating mode for the profile. Use the Profile Wizard to edit the profile power consumption and security parameters. See Profile Editor Wizard on page 4-5.

Creating a New Profile

To create new profiles from the Manage Profiles window, tap-and-hold anywhere in this window.
Select **Add** to display the **Profile Wizard** wherein you can set the profile name and ESSID. Set security, network address information, and power consumption level for the new profile.

### Deleting a Profile

To delete a profile from the list, tap and hold and select **Delete** from the pop-up menu. A confirmation dialog box appears.

### Ordering Profiles

Tap and hold a profile from the list and select **Move Up** or **Move Down** to order the profile. If the current profile association is lost, the vehicle computer attempts to associate with the first profile in the list, then the next, until it achieves a new association.

> **NOTE** Profile Roaming must be enabled.

### Export a Profile

To export a profile to a registry file, tap and hold a profile from the list and select **Export** from the pop-up menu. The **Save As** dialog box displays with the **Application** folder and a default name of WCS_PROFILE\{profile GUID\}.reg (Globally Unique Identifier).

If required, change the name in the **Name** field and tap **Save**. A confirmation dialog box appears after the export completes.
Wireless Status Application

To open the Wireless Status window, tap the Signal Strength icon > Wireless Status. The Wireless Status window displays information about the wireless connection.

![Wireless Status Window]

Figure 4-35 Wireless Status Window

The Wireless Status window contains the following options. Tap the option to display the option window.

- Signal Strength - provides information about the connection status of the current wireless profile.
- Current Profile - displays basic information about the current profile and connection settings.
- IPv4 Status - displays the current IP address, subnet, and other IP related information assigned to the vehicle computer.
- Wireless Log - displays a log of important recent activity, such as authentication, association, and DHCP renewal completion, in time order.
- Versions - displays software, firmware, and hardware version numbers.
- Quit - exits the Wireless Status window.

Option windows contain a back button to return to the main Wireless Status window.

Signal Strength Window

The Signal Strength window provides information about the connection status of the current wireless profile including signal quality, missed beacons, and transmit retry statistics. The BSSID address (shown as AP MAC Address) displays the AP currently associated with the connection. In Ad-Hoc mode, the AP MAC Address shows the BSSID of the Ad-Hoc network. Information in this window updates every 2 seconds.

To open the Signal Status window, tap Signal Strength in the Wireless Status window.
After viewing the Signal Strength window, tap the back button to return to the Wireless Status window.

Table 4-20  Signal Strength Status

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Signal</td>
<td>Displays the Relative Signal Strength Indicator (RSSI) of the signal transmitted between the AP and vehicle computer. As long as the Signal Quality icon is green the AP association is not jeopardized. If the icon is red (poor signal), an association with a different AP could be warranted to improve the signal. The signal strength icon changes depending on the signal strength.</td>
</tr>
<tr>
<td></td>
<td><img src="signal_strength_icons.png" alt="Signal Strength Icons" /></td>
</tr>
<tr>
<td>Status</td>
<td>Indicates if the vehicle computer is associated with the AP.</td>
</tr>
<tr>
<td>Signal Quality</td>
<td>Displays a text format of the Signal icon.</td>
</tr>
<tr>
<td>Tx Retries</td>
<td>Displays a percentage of the number of data packets the vehicle computer retransmits. The fewer transmit retries, the more efficient the wireless network is.</td>
</tr>
<tr>
<td>Missed Beacons</td>
<td>Displays a percentage of the amount of beacons the vehicle computer missed. The fewer transmit retries, the more efficient the wireless network is. Beacons are uniform system packets broadcast by the AP to keep the network synchronized.</td>
</tr>
<tr>
<td>Signal Level</td>
<td>The AP signal level in decibels per milliwatt (dBm).</td>
</tr>
<tr>
<td>Noise Level</td>
<td>The background interference (noise) level in decibels per milliwatt (dBm).</td>
</tr>
<tr>
<td>SNR</td>
<td>The access point/vehicle computer Signal to Noise Ratio (SNR) of signal strength to noise (interference) in decibels per milliwatt (dBm).</td>
</tr>
<tr>
<td>Association Count</td>
<td>Displays the number of APs the vehicle computer connects to while roaming.</td>
</tr>
<tr>
<td>AP MAC Address</td>
<td>Displays the MAC address of the AP to which the vehicle computer is connected.</td>
</tr>
<tr>
<td>Transmit Rate</td>
<td>Displays the current rate of the data transmission.</td>
</tr>
</tbody>
</table>
Current Profile Window

The Current Profile window displays basic information about the current profile and connection settings. This window updates every two seconds.

To open the Current Profile window, tap Current Profile in the Wireless Status window.

![Current Profile Window](image)

Table 4-21 Current Profile Window

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile Name</td>
<td>Displays the current profile name the vehicle computer uses to communicate with the AP.</td>
</tr>
<tr>
<td>ESSID</td>
<td>Displays the current profile ESSID name.</td>
</tr>
<tr>
<td>Mode</td>
<td>Displays the current profile mode, either Infrastructure or Ad-Hoc.</td>
</tr>
<tr>
<td>Authentication</td>
<td>Displays the current profile’s authentication type.</td>
</tr>
<tr>
<td>Encryption</td>
<td>Displays the current profile’s encryption type.</td>
</tr>
<tr>
<td>Channel</td>
<td>Displays the current profile’s channel setting.</td>
</tr>
<tr>
<td>Country</td>
<td>Displays the current profile’s country setting.</td>
</tr>
<tr>
<td>Transmit Power</td>
<td>Displays the radio transmission power level.</td>
</tr>
</tbody>
</table>

IPv4 Status Window

The IPv4 Status window displays the current IP address, subnet, and other IP related information assigned to the vehicle computer. It also allows renewing the address if the profile is using DHCP to obtain the IP information. Tap Renew to initiate a full DHCP discover. The IPv4 Status window updates automatically when the IP address changes.

To open the IPv4 Status window, tap IPv4 Status in the Wireless Status window.
Table 4-22  IPv4 Status Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP Type</td>
<td>Displays the IP type for the current profile: <strong>DHCP</strong> or <strong>Static</strong>. If the IP type is DHCP, leased IP address and network address data appear for the vehicle computer. If the IP type is Static, the values displayed were input manually in the <strong>IP Config</strong> tab. See <strong>IP Mode on page 4-18</strong>.</td>
</tr>
<tr>
<td>IP Address</td>
<td>Displays the vehicle computer’s IP address. The Internet is a collection of networks with users that communicate with each other. Each communication carries the address of the source and destination networks and the particular machine within the network associated with the user or host computer at each end. This address is called the IP address. Each node on the IP network must be assigned a unique IP address that is made up of a network identifier and a host identifier. The IP address as a dotted-decimal notation with the decimal value of each octet separated by a period, for example, 192.168.7.27.</td>
</tr>
<tr>
<td>Subnet</td>
<td>Displays the subnet address. Most TCP/IP networks use subnets to manage routed IP addresses. Dividing an organization’s network into subnets allows it to connect to the Internet with a single shared network address, for example, 255.255.255.0.</td>
</tr>
<tr>
<td>Gateway</td>
<td>Displays the gateway address. A gateway forwards IP packets to and from a remote destination.</td>
</tr>
<tr>
<td>DCHP Server</td>
<td>The Domain Name System (DNS) is a distributed Internet directory service. DNS translates domain names and IP addresses, and controls Internet e-mail delivery. Most Internet services require DNS to operate properly. If DNS is not configured, Web sites cannot be located or e-mail delivery fails.</td>
</tr>
<tr>
<td>Lease Obtained</td>
<td>Displays the date that the IP address was obtained.</td>
</tr>
<tr>
<td>Lease Expires</td>
<td>Displays the date that the IP address expires and a new IP address is requested.</td>
</tr>
<tr>
<td>DNS</td>
<td>Displays the IP address of the DNS server.</td>
</tr>
<tr>
<td>WINS</td>
<td>WINS is a Microsoft NetBIOS name server. WINS eliminates the broadcasts needed to resolve computer names to IP addresses by providing a cache or database of translations.</td>
</tr>
<tr>
<td>MAC</td>
<td>An IEEE 48-bit address is assigned to the vehicle computer at the factory to uniquely identify the adapter at the physical layer.</td>
</tr>
<tr>
<td>Host Name</td>
<td>Displays the name of the vehicle computer.</td>
</tr>
</tbody>
</table>
Wireless Log Window

The **Wireless Log** window displays a log of recent activity, such as authentication, association, and DHCP renewal completion, in time order. Save the log to a file or clear the log (within this instance of the application only). The auto-scroll feature automatically scrolls down when new items are added to the log.

To open the **Wireless Log** window, tap **Wireless Log** in the **Wireless Status** window. The **Wireless Log** window displays.

![Wireless Log Window](image)

**Figure 4-39  Wireless Log Window**

**Saving a Log**

To save a Wireless Log:

1. Tap the **Save** button. The **Save As** dialog box displays.
2. Navigate to the desired folder.
3. In the **Name** field, enter a file name and then tap **OK**. A text file is saved in the selected folder.

**Clearing the Log**

To clear the log, tap **Clear**.

**Versions Window**

The **Versions** window displays software, firmware, and hardware version numbers. This window only updates when it is displayed. There is no need to update constantly. The content of the window is determined at runtime, along with the actual hardware and software to display in the list. Executable paths of the software components on the list are defined in registry, so that the application can retrieve version information from the executable. “File not found” appears if the executable cannot be found at the specified path.

To open the **Versions** window, tap **Versions** in the **Wireless Status** window.
The window displays software version numbers for the following:

- Configuration Editor (Fusion 2.0 only)
- Fusion Build
- LoginService
- PublicAPI (Fusion 2.5 and above)
- Photon10
- WCConfigED
- WCDiag
- WCLaunch
- WCSAPI
- WCSRV
- WCStatus.

**Wireless Diagnostics Application**

The **Wireless Diagnostics** application window provides links to perform ICMP Ping, Trace Routing, and Known APs. To open the **Wireless Diagnostics** window, tap the **Signal Strength** icon > **Wireless Diagnostics**.
The **Wireless Diagnostics** window contains the following options. Tap the option to display the option window.

- **ICMP Ping** - tests the wireless network connection.
- **Trace Route** - tests a connection at the network layer between the vehicle computer and any place on the network.
- **Known APs** - displays the APs in range using the same ESSID as the vehicle computer.
- **Quit** - Exits the **Wireless Diagnostics** window.

Option windows contain a back button to return to the **Wireless Diagnostics** window.

### ICMP Ping Window

The **ICMP Ping** window allows testing a connection at the network layer (part of the IP protocol) between the vehicle computer and an AP. Ping tests only stop when you tap the **Stop Test** button, close the **Wireless Diagnostics** application, or if the vehicle computer switches between infrastructure and ad-hoc modes.

To open the **ICMP Ping** window, tap the **ICMP Ping** in the **Wireless Diagnostics** window.

![ICMP Ping Window](image)

**Figure 4-42  ICMP Ping Window**

To perform an ICMP ping:

1. In the **IP** field, enter an IP address or select an IP address from the drop-down list.
2. From the **Size** drop-down list, select a size value.
3. Tap **Start Test**. The ICMP Ping test starts. Information of the ping test displays in the appropriate fields.

### Trace Route Window

**Trace Route** traces a packet from a computer to a host, showing how many hops the packet requires to reach the host and how long each hop takes. The **Trace Route** utility identifies where the longest delays occur.

The **Trace Route** window allows testing a connection at the network layer (part of the IP protocol) between the vehicle computer and any place on the network.

To open the **Trace Route** window, tap **Trace Route** in the **Wireless Diagnostics** window.
Enter an IP address or a DNS Name in the IP combo box, and tap **Start Test**. The IP combo box should match the information shown in the **ICMP Ping** window’s IP combo box. When starting a test, the trace route attempts to find all routers between the vehicle computer and the destination. The Round Trip Time (RTT) between the vehicle computer and each router appears, along with the total test time. The total test time may be longer than all RTTs added together because it does not only include time on the network.

**Known APs Window**

The **Known APs** window displays the APs in range using the same ESSID as the vehicle computer. This window is only available in **Infrastructure** mode. To open the **Known APs** window, tap **Known APs** in the **Wireless Diagnostics** window.

---

### Table 4-23  Current Profile Window

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Icon]</td>
<td>The AP is the associated access point, and is set to mandatory.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>The AP is the associated access point, but is not set to mandatory.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>The vehicle computer is not associated to this AP, but the AP is set as mandatory.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>The vehicle computer is not associated to this AP, and AP is not set as mandatory.</td>
</tr>
</tbody>
</table>
Tap and hold on an AP to display a pop-up menu with the following options: Set Mandatory and Set Roaming.

Select Set Mandatory to prohibit the vehicle computer from associating with a different AP. The letter M displays on top of the icon. The vehicle computer connects to the selected AP and never roams until:

- You select Set Roaming
- The vehicle computer roams to a new profile
- The vehicle computer suspends
- The vehicle computer resets (warm or cold).

Select Set Roaming to allow the vehicle computer to roam to any AP with a better signal. These settings are temporary and never saved to the registry.

Tap Refresh to update the list of the APs with the same ESSID. The highest signal strength value is 32.

---

**Options**

Use the wireless Option dialog box to select one of the following operation options from the drop-down list:

- Operating Mode Filtering
- Regulatory
- Band Selection
- System Options
- Change Password
- Export.

**Operating Mode Filtering**

The Operating Mode Filtering options cause the Find WLANs application to filter the available networks found.

![OP Mode Filtering Dialog Box](image)

The AP Networks and Ad-Hoc Networks check boxes are selected by default.
### Regulatory Options

Use the **Regulatory** settings to configure the country the vehicle computer is in. Due to regulatory requirements (within a country) a vehicle computer is only allowed to use certain channels.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AP Networks</td>
<td>Select the <strong>AP Networks</strong> check box to display available AP networks and their signal strength within the <strong>Available WLAN Networks</strong>. These are the APs available to the vehicle computer profile for association. If this option was previously disabled, refresh the <strong>Available WLAN Networks</strong> window to display the AP networks available to the vehicle computer.</td>
</tr>
<tr>
<td>AD-Hoc Networks</td>
<td>Select the <strong>Ad-Hoc Networks</strong> check box to display available peer (adapter) networks and their signal strength within the <strong>Available WLAN Networks</strong>. These are peer networks available to the vehicle computer profile for association. If this option was previously disabled, refresh the <strong>Available WLAN Networks</strong> window to display the Ad-Hoc networks available to the vehicle computer.</td>
</tr>
</tbody>
</table>

Tap **Save** to save the settings or tap **X** to discard any changes.

### Band Selection

The **Band Selection** settings identify the frequency bands to scan when finding WLANs. These values refer to the 802.11 standard networks.
Wireless Applications

Figure 4-47  Band Selection Dialog Box

Table 4-26  Band Selection Options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.4GHz Band</td>
<td>The <strong>Find WLANs</strong> application list includes all networks found in the 2.4 GHz band (802.11b and 802.11g).</td>
</tr>
<tr>
<td>5GHz Band</td>
<td>The <strong>Find WLANs</strong> application list includes all networks found in the 5 GHz band (802.11a).</td>
</tr>
</tbody>
</table>

Tap **Save** to save the settings or tap **X** to discard any changes.

System Options

Use **System Options** to set miscellaneous system settings.

Table 4-27  System Options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile Roaming</td>
<td>Configures the vehicle computer to roam to the next available WLAN profile when it moves out of range of the current WLAN profile.</td>
</tr>
<tr>
<td>Enable IP Mgmt</td>
<td>Enables the Wireless Companion Services to handle IP address management. The Wireless Companion Service configures the IP based on what is configured in the network profile. Deselect this to manually configure the IP in the standard Windows IP window. Enabled by default.</td>
</tr>
<tr>
<td>Auto Time Config</td>
<td>Enables automatic update of the system time. Network association updates the device time based on the time set in the AP. This proprietary feature is only supported with Symbol infrastructure. Enabled by default.</td>
</tr>
</tbody>
</table>

Change Password

Use **Change Password** to require a password before editing a profile. This allows pre-configuring profiles and prevents users from changing the network settings. The user can use this feature to protect settings from a guest user. By default, the password is not set.
To create a password for the first time, leave the Current: text box empty and enter the new password in the New: and Confirm: text boxes. Tap Save.

To change an existing password, enter the current password in the Current: text box and enter the new password in the New: and Confirm: text boxes. Tap Save.

To delete the password, enter the current password in the Current: text box and leave the New: and Confirm: text boxes empty. Tap Save.

**NOTE**  Passwords are case sensitive and can not exceed 160 characters.

**Export**

Use Export to export all profiles to a registry file, and to export the options to a registry file.

To export options:

1. Tap Export Options. The Save As dialog box displays.

2. Enter a filename in the Name: field. The default filename is WCS_OPTIONS.REG.
3. Tap Save.

To export all profiles:

1. Tap Export All Profiles. The Save As dialog box displays.

![Figure 4-52 Export All Profiles Save As Dialog Box](image)

2. Enter a filename in the Name: field. The default filename is WCS_PROFILES.REG.

3. In the Folder: drop-down list, select the desired folder.

4. Tap Save.

Selecting Export All Profiles saves the current profile. This information is used to determine which profile to connect with after a warm boot or cold boot.

---

**Cold Boot Persistence**

Export options and profiles to provide cold boot persistence. Save the exported registry files in the Application folder to use them on a cold boot and restore previous profile and option settings.

Currently, only server certificates can be saved for cold boot persistence. To save server certificates for cold boot persistence, save the certificate files in the folder (Application/Certs on Fusion 2.0 or Application on Fusion 2.5 and above) to install the certificates automatically on a cold boot.

√ **NOTE** User certificates cannot be saved for cold boot persistence at this time.
## Registry Settings

Use a registry key to modify some of the parameters. The registry path is:

```
HKLM\SOFTWARE\Symbol Technologies, Inc.\Configuration Editor
```

### Register Parameter Settings

<table>
<thead>
<tr>
<th>Key</th>
<th>Type</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CertificateDirectory</td>
<td>REG_SZ</td>
<td>\Application</td>
<td>The default directory to find certificates.</td>
</tr>
<tr>
<td>EncryptionMask</td>
<td>REG_DWORD</td>
<td>0x0000001F</td>
<td>Defines the supported encryption types. See table for encryption types.</td>
</tr>
</tbody>
</table>

**Table 4-28  Registry Parameter Settings**

<table>
<thead>
<tr>
<th>Bit Number</th>
<th>Encryption Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>None</td>
</tr>
<tr>
<td>1</td>
<td>40-Bit WEP</td>
</tr>
<tr>
<td>2</td>
<td>128-Bit WEP</td>
</tr>
<tr>
<td>3</td>
<td>TKIP</td>
</tr>
<tr>
<td>4</td>
<td>AES (Fusion 2.5 and above only)</td>
</tr>
</tbody>
</table>

**NOTE**  
Re-enable cancelled profiles using the Profile Editor Wizard and choosing to connect to the cancelled profile. Canced profiles are also re-enabled when a new user logs on.

## Log On/Off Application

When the user launches the **Log On/Off** application, the vehicle computer may be in two states; the user may be logged onto the vehicle computer by already entering credentials through the login box, or there are no user logged on. Each of these states have a separate set of use cases and a different look to the dialog box.

### User Already Logged In

If already logged into the vehicle computer, the user can launch the login dialog box for the following reasons:

- Connect to and re-enable a cancelled profile. To do this:
  - Launch the Log On/Off dialog.
  - Select the cancelled profile from the profile list.
  - Login to the profile.

**NOTE**  
Re-enable cancelled profiles using the Profile Editor Wizard and choosing to connect to the cancelled profile. Cancelled profiles are also re-enabled when a new user logs on.

- Log off the vehicle computer to prevent another user from accessing the current users network privileges.
- Switch vehicle computer users to quickly logoff the vehicle computer and allow another user to log into the vehicle computer.

### No User Logged In

If no user is logged into the vehicle computer, launch the login dialog box and log in to access user profiles.

The **Login** dialog box varies if it is:

- Launched by Wireless Application, because the service is connecting to a new profile that needs credentials.
• Launched by Wireless Application, because the service is trying to verify the credentials due to credential caching rules.

• Launched by a user, when a user is logged in.

• Launched by a user, when no user is logged in.

Table 4-29 Log On/Off Options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wireless Profile Field</td>
<td>When launching the login application, the Wireless Profile field has available all the wireless profiles that require credentials. This includes profiles that use EAP TLS, PEAP, LEAP, and EAP-TTLS.</td>
</tr>
<tr>
<td>Profile Status Icon</td>
<td>The profile status icon (next to the profile name) shows one of the following states: The selected profile is cancelled. The selected profile is enabled but is not the current profile. The profile is the current profile (always the case for when the Wireless Application is launched).</td>
</tr>
<tr>
<td>Network Username and Password Fields</td>
<td>The Network Username and Network Password fields are used as credentials for the profile selected in the Wireless Profile field. Currently these fields are limited to 159 characters.</td>
</tr>
<tr>
<td>Mask Password Checkbox</td>
<td>The Mask Password checkbox determines whether the password field is masked (i.e., displays only the ‘*’ character) or unmasked (i.e., displays the entered text). Check the box to unmask the password. Uncheck the box to mask the password (the default).</td>
</tr>
<tr>
<td>Status Field</td>
<td>The status field displays status that is important to the login dialog. If the user opens the dialog and needs to prompt for credentials for a particular profile at this time, it can use the status field to let the user know that the network is held up by the password dialog being open.</td>
</tr>
</tbody>
</table>

Tapping OK sends the credentials though Wireless Application API. If there are no credentials entered, a dialog box displays informing the user which field was not entered.

The Log Off button only displays when a user is already logged on. When the Log Off button is tapped, the user is prompted with three options: Log Off, Switch Users, and Cancel. Switching users logs off the current user and re-initialize the login dialog box to be displayed for when there is no user logged on. Logging off logs off the current user and close the login dialog box. Tapping Cancel closes the Log Off dialog box and the Login dialog box displays.

When the user is logged off, the vehicle computer only roams to profiles that do not require credentials or to profiles that were created with the credentials entered into the profile.

The Cancel button closes the dialog without logging into the network. If the login dialog was launched by the Wireless Application and not by the user, tapping Cancel first causes a message box to display a warning that the cancel disables the current profile. If the user still chooses to cancel the login at this point, the profile is cancelled.

Once a profile is cancelled, the profile is suppressed until a user actively re-enables it or a new user logs onto the vehicle computer.
Chapter 5 Using Bluetooth

Introduction

Bluetooth-equipped devices can communicate wirelessly, using frequency-hopping spread spectrum (FHSS) RF to transmit and receive data in the 2.4 GHz Industry Scientific and Medical (ISM) band (802.15.1). Bluetooth wireless technology is specifically designed for short-range (30 feet/10 meters) communications and low power consumption.

Vehicle computers with Bluetooth capabilities can exchange information (e.g., files and tasks) with other Bluetooth enabled devices such as scanners and printers.

Vehicle computers with Bluetooth technology use the StoneStreet One Bluetooth stack. To program Bluetooth within the vehicle computer refer to the StoneStreet One SDK.

Adaptive Frequency Hopping

Adaptive Frequency Hopping (AFH) is a method of avoiding fixed frequency interferers. AFH can be used with Bluetooth voice. All devices in the piconet (Bluetooth network) must be AFH-capable in order for AFH to work. There is no AFH when connecting and discovering devices. Avoid making Bluetooth connections and discoveries during critical 802.11b communications. AFH for Bluetooth can be broken-down into four main sections:

- **Channel Classification** - A method of detecting an interference on a channel-by-channel basis, or pre-defined channel mask.
- **Link Management** - Coordinates and distributes the AFH information to the rest of the Bluetooth network.
- **Hop Sequence Modification** - Avoids the interference by selectively reducing the number of hopping channels.
- **Channel Maintenance** - A method for periodically re-evaluating the channels.

When AFH is enabled, the Bluetooth radio “hops-around” (instead of through) the 802.11b high-rate channels. AFH coexistence allows vehicle computers to operate in any infrastructure. AFH is always enabled in the VC5090.

The Bluetooth radio in this vehicle computer operates as a Class 2 device power class. The maximum output power is 2.5mW and the expected range is up to 32.8 feet (10 meters). A definitive definition of ranges based on power class is difficult to obtain due to power and device differences, and whether one measures open space or closed office space.
Security

The current Bluetooth specification defines security at the link level. Application-level security is not specified. This allows application developers to define security mechanisms tailored to their specific need. Link-level security is really between devices not users, while application-level security can be implemented on a per-user basis. The Bluetooth specification defines security algorithms and procedures needed to authenticate devices, and if needed, encrypt the data flowing on the link between the devices. Device authentication is a mandatory feature of Bluetooth while link encryption is optional.

Pairing of Bluetooth devices is accomplished by creating an initialization key that is used to authenticate the devices and create a link key for them. Entering a common PIN number in the devices being paired generates the initialization key. The PIN number is never sent over the air. By default, the Bluetooth stack responds with no key when a key is requested (it is up to user to respond to the key request event). Authentication of Bluetooth devices is based-upon a challenge-response transaction. Bluetooth allows for a PIN number or passkey that is used to authenticate the pairing devices. Also worthy of note is the limited range and fast frequency hopping of the Bluetooth radios that makes long-distance eavesdropping difficult.

It is recommended:
- Perform pairing in a secure environment
- Keep PIN codes private and don't store the PIN codes in the vehicle computer
- Implement application-level security.

Turning the Bluetooth Radio Mode On and Off

Turn off the Bluetooth radio to save power or if entering an area with radio restrictions (e.g., an airplane). When the radio is off, the vehicle computer can not be seen or connected to by other Bluetooth devices. Turn on the Bluetooth radio to exchange information with other Bluetooth devices (within range). Communicate only with Bluetooth radios in close proximity.

NOTE To achieve the best battery life in vehicle computers with multiple radios, turn off the radios that are not being used.

Disabling Bluetooth

To disable Bluetooth, tap > Disable Bluetooth. The Bluetooth icon changes to indicate that Bluetooth is disabled. An exclamation point appears with the icon.

Figure 5-1 Disable Bluetooth

Enabling Bluetooth

To enable Bluetooth, tap > Enable Bluetooth. The Bluetooth icon changes to indicate that Bluetooth is enabled.
Bluetooth Power States

**Cold Boot**

When a cold boot is performed on the vehicle computer, Bluetooth turns off. It is normal to see the Bluetooth icon appear and disappear, as well as a wait cursor, when initialization proceeds in all modes.

**Warm Boot**

When a warm boot is performed on the vehicle computer, Bluetooth returns to the disabled state (off).

**Suspend**

When the vehicle computer suspends, Bluetooth turns off.

> **NOTE** When the vehicle computer is placed in suspend mode, the Bluetooth radio mode powers off and the piconet (Bluetooth connection) is dropped. When the vehicle computer resumes, it could take up to 10 seconds for the Bluetooth radio driver to re-initialize the radio.

**Resume**

When the vehicle computer resumes, Bluetooth turns on if it was on prior to suspend. Note that any Bluetooth connection that was dropped during a suspend needs to be reconnected after a resume.

---

**Bluetooth Profiles**

The VC5090 vehicle computer is loaded with a number of Bluetooth services profiles. These profiles can be loaded or removed from memory. If a profile is not used, it can be removed to save memory. To load or remove profiles:

1. If **BTExplorer** is running, tap 📱 > Disable Bluetooth.

2. Tap 📱 > Programs > BTProfileSelector. The **ProfileSelector** window appears.
3. Tap a check box next to the profile to load (activate).

   The Serial Port profile is always active and cannot be removed. Profiles that are grey-out are not supported by
   the vehicle computer.

4. Tap **Select All** to select all profiles or tap **Deselect All** to deselect all profiles.

5. Tap **Apply** to activate the profiles and then **Close** to exit the application.

6. Tap **Enable Bluetooth** to enable **BTExplorer** application.

See *Services Tab on page 5-19* for more information on selecting services.
Modes

The BTExplorer application has two modes for managing Bluetooth connections: Wizard Mode and Explorer Mode. The Wizard Mode is for novice Bluetooth users and the Explorer Mode is for experienced Bluetooth users.

Wizard Mode

Wizard Mode provides a simple step-by-step process for discovering and connecting to Bluetooth devices. The wizard takes you through the entire process.

1. Tap > Show BTExplorer. The BTExplorer window appears.

Figure 5-4  New Connection Wizard Window

3. Select an action from the drop-down list. In this example, Explore Services on Remote Device is selected.
4. Tap Next. The BTExplorer searches for Bluetooth devices in the area and displays the devices in the Select Remote Device window.
Figure 5-5    Select Remote Device Window

5. Select a device from the list and then tap Next. The Connection Favorite Options window appears.

Figure 5-6    Connection Favorite Options Window

6. Select Save As Favorite check box to save this service in the Favorite view.

7. In the Favorite Name text box, enter a name for this service that will appear in the Favorite list.

8. Tap Next. The Connection Summary window appears.

Figure 5-7    Connection Summary Window

9. Tap Connect to connect to the service.

NOTE Devices discovered previously are listed to save time. To start a new device discovery, tap and hold and select Discover Devices from the menu.
The following actions are available in the drop-down list (actions may vary depending upon configurations):

- Explore Services on Remote Device
- Pair with a Remote Device
- Active Sync via Bluetooth
- Browse Files on Remote Device
- Connect to Internet Using Access Point
- Connect to Internet Using Phone/Modem
- Connect to a Personal Area Network
- Send or Exchange Objects
- Associate Serial Port.

**Explorer Mode**

The **BTExplorer** window is streamlined and easy to navigate and provides greater control to users familiar with Bluetooth functionality. The menu bar provides quick access to the options and tools used to connect to devices.

![BTExplorer Window]

**Figure 5-8  Explorer Mode Window**

You can also use the “tap and hold” technique to view available options. Scroll bars and view options are like those you’re familiar with on your Windows desktop. The tree structure lists the following sub-items:

- Local Device - This VC5090 vehicle computer
- Remote Device - Other Bluetooth devices
  - Trusted Devices - Bonded (paired) Bluetooth devices
  - Untrusted Devices - Discovered devices that are not bonded
- Favorites - Selected services that are set as being *Favorite* for quick access.

**NOTE**  When switching between Wizard Mode and Explorer Mode, all active connections are closed.
Discovering Bluetooth Device(s)

Follow the steps below to discover Bluetooth devices. The vehicle computer can receive information from discovered devices, without bonding. However, once bonded, an exchange of information between the vehicle computer and a bonded device occurs automatically when the Bluetooth radio is turned on.

To find Bluetooth devices in the area:

1. Ensure that the Bluetooth device being looked for is in discoverable mode.

2. Ensure that the two devices are within 30 feet (10 meters) of one another.

3. Tap > Show BTExplorer. The BTExplorer window appears.

4. Tap and hold Remote Devices and select Discover Devices from the pop-up menu. The vehicle computer searches for Bluetooth devices in the area.

5. The discovered devices display in the Untrusted Devices folder.
Bonding with Discovered Device(s)

A bond is a relationship created between the vehicle computer and another Bluetooth device in order to exchange information in a secure manner. Creating a bond involves entering the same PIN on the two devices to bond. Once a bond is created, and the Bluetooth radios are turned on, the devices recognize the bond and are able to exchange information without re-entering a PIN.

To bond with a discovered Bluetooth device:

1. Discover remote devices. See Discovering Bluetooth Device(s) on page 5-8.

2. In the Untrusted Devices folder, tap and hold on a device to pair with.

3. Select Pair from the pop-up menu.

4. On the vehicle computer, the PIN Code Request window appears.
5. In the PIN Code: text box, enter the PIN number (between 1 and 16 characters) and then tap OK.

6. On the remote device, enter the same PIN number.

7. The devices are successfully paired. The device name moves to the Trusted Devices folder.

**Renaming a Bonded Device**

If it is necessary to rename a bonded device, it can be done from the BTExplorer window.

1. Launch BTExplorer.

2. Tap and hold the device to rename and select Rename in the pop-up menu.
3. The **Change Device Name** window appears.

4. Enter a new name for the bonded device in the text box. Tap **OK**.

### Deleting a Bonded Device

If it is no longer necessary to connect with a device, delete it from the **Bluetooth Bonded Devices** window.

1. Launch **BTExplorer**.

2. Tap and hold the device to delete and select **Delete** in the pop-up menu.
Figure 5-17  Delete a Bonded Device

3. A confirmation dialog appears. Tap Yes.

Accepting a Bond

When a remote device wants to bond with a vehicle computer you give permission by entering a PIN when requested.

1. Ensure that the vehicle computer is set to discoverable and connectable. See Bluetooth Settings on page 5-19.
2. When prompted to bond with the remote device the PIN Code Request window appears.

Figure 5-18  PIN Code Request Window

✓  **NOTE**  Connections to untrusted devices are a security risk.

3. In the PIN Code: text box, enter the same PIN that was entered on the device requesting the bond. The PIN must be between 1 and 16 characters.
4. In the Device Name: text box, edit the name of the device requesting the bond, if desired.
5. Tap OK.
6. The bond is created and the vehicle computer can now exchange information with the other device.
Discovering Services

Before services can be used, you must first discover remote devices and then bond to those devices.

To determine what services are available on a bonded remote device:

1. Tap > Show BTExplorer.

2. In BTExplorer window, tap and hold on the remote device and select Explore from the pop-up menu.

3. The vehicle computer communicates with the remote device and then lists the services under the device name.

Some examples of available services are:
- File Transfer Services
- Headset and Hands-free Services
- OBEX Object Push Services
- Serial Port Services.

Not all services are available on the VC5090. Some of these services are discussed in the following paragraphs.
File Transfer Services

NOTE Shared folders are a security risk.

To transfer files between the vehicle computer and another Bluetooth enabled device:

1. Ensure the vehicle computer is discoverable and connectable. See Bluetooth Settings on page 5-19.
2. Discover and bond (pair) with the remote access point. See Bonding with Discovered Device(s) on page 5-9.
3. In BTExplorer, select the Remote Devices folder.
4. Select the Trusted Devices folder.
5. Tap the remote device folder.
6. Tap and hold on the remote device and select Explore from the pop-up menu.
7. Tap and hold on File Transfer and select Connect. The remote device's accessible folders appear.
8. Select a folder. The contents of the folder appear in the sub-window.

![Remote Device Folders](image)

Figure 5-21 Remote Device Folders

10. Select the action to perform:
    a. New - create a new file or folder on the remote device
    b. Delete - delete the selected file on the remote device.
    c. Get File - copy the file from the remote device to the vehicle computer.
    d. Put File - copies a file from the vehicle computer to the remote device.

Create New File or Folder

To create a new folder or file on the remote device:

1. Tap and hold on the file and select New > Folder or New > File. The Create New Folder or Create New File window appears.
2. Enter the name for the new folder or file. Tap OK.
3. A new folder or file is created on the remote device.
Delete File
To delete a file from the remote device:
1. Tap and hold on the file and select Delete.
2. In the Delete Remote Device File dialog box tap OK.

Get File
To copy a file from a remote device:
1. Tap and hold on the file and select Get. The Save Remote File window appears.
2. Navigate to the directory to save the file.
3. Tap Save. The file is transferred from the remote device to the vehicle computer.

Put File
To copy a file to a remote device:
1. Tap and hold on the file and select Put. The Send Local File window appears.
2. Navigate to the directory to save the file and select a file.
3. Tap Open. The file is transferred from the vehicle computer to the remote device.

Connect to Internet Using Access Point
This section explains how to access a Bluetooth-enabled LAN access point (AP) for a network connection. With this method of communication the Internet Explorer can be used to connect to a server.
1. Ensure the vehicle computer is discoverable and connectable. See Bluetooth Settings on page 5-19.
2. Discover and bond (pair) with the remote access point. See Bonding with Discovered Device(s) on page 5-9.
3. In BTExplorer, select the Remote Devices folder.
4. Select the Trusted Devices folder.
5. Tap the remote device folder.
6. Tap and hold on the remote device and select Explore from the pop-up menu.
7. Tap and hold LAN Access using PPP service and select Connect from the pop-up menu.
8. The vehicle computer connects with the Access Point.
9. Tap > Internet Explorer. The Internet Explorer window appears.
10. In the address field, enter an internet address and tap the Enter button. The web page loads.

OBEX Object Push Services
Object Exchange (OBEX) is a set of protocols allowing objects such as Contacts or pictures to be shared using Bluetooth.
To exchange contact information with another Bluetooth enabled device:
1. Ensure the vehicle computer is discoverable and connectable. See *Bluetooth Settings on page 5-19*.
2. Discover and bond (pair) with the remote device. See *Bonding with Discovered Device(s) on page 5-9*.
3. In **BTExplorer**, select the **Remote Devices** folder.
4. Select the **Trusted Devices** folder.
5. Tap the remote device folder.
6. Tap and hold on **OBEX Object Push** and select **Connect**. The **OBEX Object Push** window appears.
7. In the **Action** drop-down list, select one of the options: **Send Contact Information**, **Swap Contact Information**, **Fetch Contact Information** or **Send a Picture**.

### Send a Picture

To send a picture to another device:

1. Ensure the vehicle computer is discoverable and connectable. See *Bluetooth Settings on page 5-19*.
2. Discover and bond (pair) with the remote device. See *Bonding with Discovered Device(s) on page 5-9*.
3. In **BTExplorer**, select the **Remote Devices** folder.
4. Select the **Trusted Devices** folder.
5. Tap the remote device folder.
6. Tap and hold on **OBEX Object Push** and select **Connect**. The **OBEX Object Push** window appears.
7. In the **Action** drop-down list, select **Send a Picture**.
8. Tap . The **Send Local Picture** window appears.
9. Navigate to the picture that you want to send to the other device.

10. Tap Open.

11. Tap OK. The picture is sent to the other device and a confirmation dialog box appears on the other device to accept the picture. A Send Picture dialog appears.

12. Tap Ok.

**Headset Services**

To connect to a Bluetooth headset:

1. Ensure the vehicle computer is discoverable and connectable. See *Bluetooth Settings on page 5-19*.
2. Discover and bond (pair) with the headset.
3. In BTExplorer, select the Remote Devices folder.
4. Select the Trusted Devices folder.
5. Tap the remote device folder.
6. Tap and hold on the remote device and select Explore. A headset service item appears.
7. Tap and hold on the headset service name and select Connect.
8. The vehicle computer connects to the headset. Refer to your headset user manual for instruction on communicating with a Bluetooth device.

   **NOTE** If the vehicle computer goes into suspend mode, the Bluetooth headset disconnects from the vehicle computer.

To adjust the microphone gain:

1. Tap and hold on the headset service item and select Adjust Microphone from the pop-up menu. The Microphone Properties window appears.
2. Select the slider and adjust the gain.
3. Tap OK.
Serial Port Services

NOTE  By default, COM ports COM4, COM5 and COM9 are Bluetooth virtual ports. If an application opens one of these ports, the Bluetooth driver activates and guides you through a Bluetooth connection.

Use the wireless Bluetooth serial port connection just as you would a physical serial cable connection. You must configure the application that will use the connection to the correct serial port.

To establish a serial port connection:
1. Ensure the vehicle computer is discoverable and connectable. See Bluetooth Settings on page 5-19.
2. Discover and bond (pair) with the remote device. See Bonding with Discovered Device(s) on page 5-9.
3. In BTExplorer, select the Remote Devices folder.
4. Select the Trusted Devices folder.
5. Tap the remote device folder.
6. Tap and hold Serial Port and select Connect in the pop-up menu. The Remote Service Connection window appears.

![Remote Service Connection Window](image)

7. In the Local COM Port drop-down list select a COM port.
8. Tap OK.

Personal Area Network Services

Connect two or more Bluetooth devices to share files, collaborate or play multi player games.

To establish a Personal Area Network connection:
1. Ensure the vehicle computer is discoverable and connectable. See Bluetooth Settings on page 5-19.
2. Discover and bond (pair) with the remote device. See Bonding with Discovered Device(s) on page 5-9.
3. In BTExplorer, select the Remote Devices folder.
4. Select the Trusted Devices folder.
5. Tap the remote device folder.
6. Tap and hold Personal Area Network and select Connect in the pop-up menu.
Bluetooth Settings

Use the BTExplorer Settings window to configure the operation of the BTExplorer application. Tap Tools > Settings. The BTExplorer Settings window appears.

Device Info Tab

Use the Device Info tab to configure the vehicle computer’s Bluetooth connection modes.

![Figure 5-25  BTExplorer Settings - Device Info Tab]

Device Name Displays the name of the vehicle computer.

Discoverable Mode Allows you to set the vehicle computer to be discoverable by other Bluetooth devices or not be discoverable.

Note: For security reasons, the default is set to Non Discoverable.

Connectable Mode Allows you to set the vehicle computer to be connectable by other Bluetooth devices or not be connectable.

Note: For security reasons, the default is set to Non Connectable.

Services Tab

NOTE For security reason, by default services are not enabled.

Use the Services tab to add or delete Bluetooth services.
To add a service:

1. Tap Add. The Add Local Service window displays.

2. In the list, select a service to add.

3. Tap OK. The Edit Local Service window displays for the selected service.

4. Select the appropriate information and then tap OK. See the following paragraphs for detailed information on the available services.

**File Transfer Service**

File transfer allows files to be browsed by other Bluetooth devices.
OBEX Object Push Service

OBEX Object Push allows contacts, business cards, pictures, appointments, and tasks to be pushed to the device by other Bluetooth devices.
**Personal Area Networking Service**

Personal Area Networking hosts a Personal Area Network which allows communication with other Bluetooth devices.

Service Name Displays the name of the service.

Service Security Select the type of security from the drop-down list; None, Authenticate or Authenticate/Encrypt.

Support Group Ad-Hoc Networking TBD

**Serial Port Service**

Serial port allows COM ports to be accessed by other Bluetooth devices.

Service Name Displays the name of the service.

Service Security Select the type of security from the drop-down list; None, Authenticate or Authenticate/Encrypt.

Local COM Port Select the COM port. Select COM1 to use a modem or other device that is connected to the connector on the bottom of the vehicle computer.
Local Baud Rate  
Select the communication baud rate.

Local Port Options  
Select the port option.

**Headset Service**

Serial port allows COM ports to be accessed by other Bluetooth devices.

![Headset Service Window](image1)

**Security Tab**

To adjust the security settings for an individual service, select the **Services** tab first, then select the individual service, then **Properties**.

![BTExplorer Settings - Security Tab](image2)

- **Use PIN Code (Incoming Connecting)**  
  Select for automatic use of the PIN code entered in the **PIN Code** text box. It is recommended not to use this automatic PIN code feature. See Security on page 5-2 for more information.

- **PIN Code**  
Enter the PIN code.

- **Encrypt Link On All Outgoing Connections**  
  Select to enable or disable encryption. Use encryption whenever possible.
**Discovery Tab**

Use the **Discovery** tab to set and modify discovered devices.

![Figure 5-34 BTEplorer Settings - Discovery Tab](image)

- **Inquiry Length**
  - Sets the amount of time that the vehicle computer takes to discover Bluetooth devices in the area.
- **Name Discovery Mode**
  - Select either **Automatic** or **manual**.
- **Discovered Devices**
  - Deletes all discovered devices and link keys.

**Virtual COM Port Tab**

Use the **Virtual COM Port** tab to select the COM ports for Bluetooth communication.

![Figure 5-35 BTEplorer Settings - Virtual COM Port Tab](image)

- **COM4:Bluetooth**
  - Enable or disable COM Port 4.
- **COM5:Bluetooth**
  - Enable or disable COM Port 5
- **COM9:Bluetooth**
  - Enable or disable COM Port 9

**NOTE** If an application uses one of the COM ports assigned to Bluetooth, opening this port causes the Bluetooth stack to activate and guide you through the connection process.
Highlight Connections
Apply Text Style
Apply Text Color

Select the connection type to highlight when connected. In the Wizard Mode, the only option is Favorites or None. In the Explorer Mode the options are None, Tree View Only, List View Only or Tree and List View.

Select the text style to be applied to the connection text.

Select the text color to be applied to the connection text.
Introduction

To communicate with various host devices, install Microsoft ActiveSync (version 4.1 or higher) on the host computer. Use ActiveSync to synchronize information on the vehicle computer with information on the host computer. Changes made on the vehicle computer or host computer appear in both places after synchronization.

ActiveSync software:

- Allows working with vehicle computer-compatible host applications on the host computer. ActiveSync replicates data from the vehicle computer so the host application can view, enter, and modify data on the vehicle computer.
- Synchronizes files between the vehicle computer and host computer, converting the files to the correct format.
- Backs up the data stored on the vehicle computer. Synchronization is a one-step procedure that ensures the data is always safe and up-to-date.
- Copies (rather than synchronizes) files between the vehicle computer and host computer.
- Controls when synchronization occurs by selecting a synchronization mode, e.g., set to synchronize continually while the vehicle computer is connected to the host computer, or set to only synchronize on command.
- Selects the types of information to synchronize and control how much data is synchronized.
Installing ActiveSync

To install ActiveSync on the host computer, download version 4.1 or higher from the Microsoft web site at http://www.microsoft.com. Refer to the installation included with the ActiveSync software.

Mobile Computer Setup

\[
\text{NOTE} \quad \text{Microsoft recommends installing ActiveSync on the host computer before connecting the vehicle computer.}
\]

The vehicle computer can be set up to communicate either with a serial connection or a USB connection. Serial connection can be to the vehicle computer COM1 or COM2 port. USB connection can be made to the vehicle computer USB B Client port. Chapter 2, Installation provides the accessory setup and cable connection information for use with the vehicle computer. The vehicle computer communication settings must be set to match the communication settings used with ActiveSync.

\[
\text{NOTE} \quad \text{You cannot use a USB scanner plugged into the rugged USB port when you ActiveSync to a host computer using the USB B Client port.}
\]

1. On the vehicle computer tap > Settings > Control Panel > PC Connection icon. The PC Connection Properties window appears.

![PC Connection Properties Window](image1)

\[Figure 6-1 \quad PC Connection Properties Window\]

2. Tap the Change Connection button.

3. Select the connection type from the drop-down list.

![Change Connection Window](image2)

\[Figure 6-2 \quad Change Connection Window\]

4. Tap OK to exit the Change Connection window and tap OK to exit the PC Connection Properties window.
5. Proceed with installing ActiveSync on the host computer and setting up a partnership.

---

**Setting Up an ActiveSync Connection on the Host Computer**

To start ActiveSync:

1. Select **Programs** > **Microsoft ActiveSync** on the host computer. The **ActiveSync** window displays.

![Figure 6-3 ActiveSync Window](image)

**NOTE** Assign each vehicle computer a unique device name. Do not try to synchronize more than one vehicle computer to the same name.

2. In the **ActiveSync** window, select **File** > **Connection Settings**. The **Connection Settings** window appears.

![Figure 6-4 Connection Settings Window](image)

3. Select the appropriate check box for the type of connection used.

4. Select the **Show status icon in Taskbar** check box.

5. Select **OK** to save any changes made.

---

**Setting up a Partnership**

To set up a partnership:
1. If the Get Connected window does not appear on the host computer, select > All Programs > Microsoft ActiveSync.

![Figure 6-5 New Partnership Window](image)

2. Select if you want to create synchronize with the host computer or to connect as a guest.

3. Click Next.

![Figure 6-6 Select Synchronization Setting Window](image)

4. Select the appropriate settings and click Next.
5. Click Finish.

**Figure 6-7  Setup Complete Window**

During the first synchronization, information stored on the vehicle computer is copied to the host computer. When the copy is complete and all data is synchronized, the vehicle computer can be disconnect from the host computer.

**NOTE** The first ActiveSync operation must be performed with a local, direct connection. To retain partnerships after a cold boot, capture partnership registry information in a .reg file and save it in the Flash File System, detailed information is provided in the SMDK Help File.

For more information about using ActiveSync, start ActiveSync on the host computer, then see ActiveSync Help.
Chapter 7 Application Development and Deployment

Introduction

This chapter lists the tools required for developing applications, describes how to package applications and provides procedures for deploying applications onto the VC5090.

Software Installation on Development PC (Application Development)

To develop applications to run on the vehicle computer, use one or more of the following:

- Enterprise Mobility Developer Kit (EMDK) for C
- Enterprise Mobility Developer Kit (EMDK) for Java
- Enterprise Mobility Developer Kit (EMDK) for .NET
- Windows CE Platform SDK for VC5090
- Device Configuration Package (DCP) for VC5090.

The EMDK for C is a development tool used to create native C and C++ applications for all vehicle computers. It includes documentation, header files (.H), and library files (.LIB) for native code application development that targets value-add APIs.

The Windows CE Platform SDK for the VC5090 is used in conjunction with the SMDK for C to create Windows CE applications for the VC5090 vehicle computer. The Platform SDK installs a new Windows CE device type and its associated libraries onto the development PC. This new device is added to the Active WCE Configuration field of Microsoft eMbedded Visual C++ 4.0. Visual Studio 2005 can also be used to develop applications for the VC5090.

The Device Configuration Package (DCP) is required to create and download hex images that represent flash partitions to the vehicle computer. The DCP includes the flash partitions, Terminal Configuration Manager (TCM) and the associated TCM scripts.

Device Configuration Package

To install the DCP for VC5090:

1. Download the DCP from the Support Central web site, http://www.zebra.com/support:
b. Select Mobile Computers and then select VC5000.
c. Select the Device Configuration Package (DCP).
d. Save the .exe file to the development computer.

2. Locate the .exe file on the development computer, double-click the file, and follow the install screen prompts.

3. Once installed, access the major components of the DCP from the Device Configuration Package (DCP) for VC5000 program group of the Windows Start Menu.

Platform SDK

To download and install the Platform SDK:

1. Download the appropriate Platform SDK from the Support Central web site http://www.zebra.com/support:
   b. Select Mobile Computers and then select VC5000.
   c. Select the Platform SDK.
   d. Save the .exe file to the development computer.
2. Run the file and follow the screen prompts to install.

Enterprise Mobility Developer Kit

To install an SMDK:

1. Download the EMDK from the Support Central web site, http://www.zebra.com/support:
   b. Select Mobile Computers and then select VC5000.
   c. Select the latest version of the Enterprise Mobility Developer Kit.
   d. Save the .exe file to the development computer.
2. Double-click the executable file and follow the install screen prompts.
3. Once installed, access the major components of the SMDK from the Enterprise Mobility Developer Kit program group of the Windows Start Menu. The components include: Help, Platform Integrator, Readme, Samples, and Web Updates.
4. The sample applications provide examples of how to interface with the Symbol API functions. To build a sample application, open the Samples folder from the Windows Start menu. Open the folder for the desired sample and then open the project file. The project file has an extension of VCP. Microsoft Visual C++ v4.0 automatically launches. Select WinCE as the Active WCE Configuration. Select Win32 (WCE ARMV4I) Debug as the Active Configuration.

✓ NOTE If both Microsoft Visual C++ v3.0 and Microsoft Visual C++ v4.0 are installed on the development computer, ensure Microsoft Visual C++ v4.0 launches.
Installing Other Development Software

Developing applications for the vehicle computer may require installing other development software such as application development environments on the development PC. Follow the installation instructions provided with this software.

Software Installation on Vehicle Computer

With the appropriate accessory, software, and connection, the vehicle computer can share information with the host device. This chapter provides information about installing software and files on the vehicle computer.

Download or install software using:

- ActiveSync
- IPL
- Mobility Services Platform (MSP)
- SD Card.

ActiveSync

Use ActiveSync to copy files from a host computer to the vehicle computer.

1. Ensure that ActiveSync is installed and that a partnership has been created, see Chapter 3, ActiveSync.

2. Connect the vehicle computer to the host computer using a USB cable.

3. On the host computer, select ✈ > Programs > ActiveSync.

4. Select Explore.
5. Double-click the folder to expand the contents of the folder.

![Application Folder Contents](image)

**Figure 7-2 Application Folder Contents**

6. Use Explorer to locate the host computer directory that contains the file to download. Tap that directory in the left pane to display its contents in the right pane.

7. Drag the desired file(s) from the host computer to the desired mobile device folder.
   - *Program Files* folder: files stored in this folder are discarded after a cold boot.
   - *Application* folder: files stored in this folder are retained after a cold boot.

**SD Card**

The SD card can be used to download/upload files to and from the vehicle computer. See *Installing a Memory Card on page 2-3* for instructions for installing an SD card. To view the contents of the SD card, open Windows Explorer and select Storage Card. You can copy files from the SD card to the vehicle computer or double-tap the executable file to launch the application.

**IPL**

Use IPL to download files onto the vehicle computer, to download customized flash file system partitions to the vehicle computer and load hex files to the flash memory of the vehicle computer.

There are two types of updates supported by the vehicle computer: partitions and files. The file system used by the vehicle computer is the same as the file system used on a desktop computer. A file is a unit of data that can be accessed using a file name and a location in the file system. When a file is replaced, only the contents of the previous file are erased. The operating system must be running for a file to be updated, so the IPL cannot perform individual file updates as it is a stand-alone program that does not require the operating system to be running.

A typical partition is a group of files, combined into a single “partition” that represents a specific area of storage. Examples of partitions are the flash file systems such as Platform or Application. (Using the desktop computer comparison, these partitions are roughly equivalent to a C: or D: hard disk drive.) In addition to the “hard disk” partitions, some partitions are used for single items such as the operating system, monitor, or splash screen.
(Again using a desktop computer comparison, these partitions are roughly the equivalent of the BIOS or special hidden system files.) When a partition is updated, all data that was previously in its storage region is erased - i.e. it is not a merge but rather a replacement operation. Typically, the operating system is not running when partitions are update, so IPL can perform partition updates.

Partition images for selected partitions can be created by TCM. All partition images suitable for use by IPL are in hex file format for transfer by TCM from the development computer to the vehicle computer.

Upgrade requirements:

- The hex files to be downloaded (on development computer)
- A connection from the host computer and the vehicle computer (either serial or wireless)
- TCM (on development computer) to download the files.

Once these requirements are satisfied, the vehicle computer can be upgraded by invoking IPL and navigating the menus. See Sending the Hex Image on page 7-11 for procedures on downloading a hex file to the vehicle computer.
Creating and Loading Hex Images

Terminal Configuration Manager (TCM) is an application used to customize flash file system partitions for the vehicle computer. The most common use is to create an application partition hex file that contains the customer’s application. TCM can also be used to load hex files to the flash memory of the vehicle computer.

The program resident on the vehicle computer that receives the hex file and burns it to the flash memory is called Initial Program Loader (IPL).

The customization of partitions is controlled by TCM scripts. The scripts contain all of the necessary information for building an image. The script is a list of copy commands specifying the files to copy from the development computer to the partition.

TCM works with a pair of directory windows, one displaying the script and the other displaying the source files resident on the development computer. Using standard windows drag and drop operations, files can be added and deleted from the script window.

The DCP for VC5090w includes scripts used by Zebra to build the standard factory installed Platform and Application partitions provided on the vehicle computer. The standard Platform partition contains drivers while the Application partition contains demo applications and optional components. The standard TCM scripts can be found in the following folder: C:\Program Files\Symbol Device Configuration Packages\VC5090x\v1.0\TCM Scripts.

NOTE Before creating a script to build a hex image, identify the files required (system files, drivers, applications, etc.) and locate the files’ source directories to make the script building process easier.

The required processes for building a hex image in TCM include:

- Starting TCM
- Defining script properties
- Creating the script for the hex image
- Building the image
- Sending the hex image
- Creating a splash screen
- Flash storage.

Starting Terminal Configuration Manager

Click the Windows start menu TCM icon (Device Configuration Packages, VC5090w v1.0) to start TCM. The TCM window appears displaying two child windows: Script1 and File Explorer. The Script1 window contains a newly created script and the File Explorer window contains a file explorer view used for selecting files to be placed in the script.
Figure 7-3  TCM Startup Window

The following table lists the components of the TCM window.

Table 7-1  TCM Components

<table>
<thead>
<tr>
<th>Icon</th>
<th>Component</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image.png" alt="Script Window" /></td>
<td>Script Window</td>
<td>Displays the files to be used in the creation of the partition(s).</td>
</tr>
<tr>
<td><img src="image.png" alt="File Explorer Window" /></td>
<td>File Explorer Window</td>
<td>Used to select the files to be added to the script.</td>
</tr>
<tr>
<td><img src="image.png" alt="Create button" /></td>
<td>Create button</td>
<td>Create a new script file.</td>
</tr>
<tr>
<td><img src="image.png" alt="Open button" /></td>
<td>Open button</td>
<td>Open an existing script file.</td>
</tr>
<tr>
<td><img src="image.png" alt="Save button" /></td>
<td>Save button</td>
<td>Save the current script file.</td>
</tr>
<tr>
<td><img src="image.png" alt="Large icons button" /></td>
<td>Large icons button</td>
<td>View the current script items as large icon.</td>
</tr>
<tr>
<td><img src="image.png" alt="Small icons button" /></td>
<td>Small icons button</td>
<td>View the current script items as small icon.</td>
</tr>
<tr>
<td><img src="image.png" alt="List button" /></td>
<td>List button</td>
<td>View the current script items as a list.</td>
</tr>
<tr>
<td><img src="image.png" alt="Details button" /></td>
<td>Details button</td>
<td>View the current script items with more details.</td>
</tr>
<tr>
<td><img src="image.png" alt="About button" /></td>
<td>About button</td>
<td>Display version information for TCM.</td>
</tr>
<tr>
<td><img src="image.png" alt="Properties button" /></td>
<td>Properties button</td>
<td>View/change the current script properties.</td>
</tr>
</tbody>
</table>
Defining Script Properties

Before a script is created, the script properties must be defined. This defines the type of vehicle computer, flash type, number of disks being created and the memory configuration of each disk partition.

To define the script properties:

1. Select the Script window to make it active.
2. Click the Properties button. The Script Properties window - Partition Data tab appears.

3. In the Terminal drop-down list, the VC5090w entry is already selected.
4. Use the default Flash Type.
5. In the Disks drop-down list, select the number of disk partitions to create.
6. Select the (memory) Size for each partition. Note that adding space to one disk partition subtracts it from another.
7. In the Access drop-down list for each disk partition, determine and select the Read/Write access option.
8. Click the **Options** tab. The **Script Properties** window > **Options** tab appears.

![Script Properties Window - Options Tab](image)


10. Click **OK**.

**Creating the Script for the Hex Image**

On start-up, **TCM** displays the **TCM** window with the **Script1** window and **File Explorer** window pointing to the following directory:

$ \Program Files\Symbol Device Configuration Packages\VC5090w\v0.1\TCMScripts\n
The **Script1** window directory pane displays two partitions: **Platform** and **Application**. Depending on the type of flash chip, the number of partitions may change. Files can be added to each of the partitions. **TCM** functionality includes:

- Opening a new or existing script file
- Copying components to the script window
- Saving the script file.

**Opening a New or Existing Script**

A script file can be created from scratch or based on an existing script file. Click **Create** to create a new script or click **Open** to open an existing script (for example, a script provided in the DCP for VC5090w). If an existing script is opened and changes are made, saving the changes overwrites the original script. To use an original or **Zebra** supplied standard script as a base and save the changes in a new script, use the **Save As** function to save the script using a different file name.

** Updating TCM 1.X Scripts**

Script files that were created with older versions of **TCM** can be upgraded to **TCM 2.0** scripts. Click **Open** to open an existing script created with an older version of **TCM**. The **Conversion** window appears automatically.
Figure 7-6   Conversion Window - Upgrading to TCM 2.0

Copying Components to the Script

Script contents are managed using standard file operations such as New Folder, Delete and Rename. Items can be added to the script by clicking files and folders in the File Explorer window and dragging them to the Script window. The File Explorer window supports standard windows; multiple files may be selected by clicking while holding the SHIFT or CTRL keys.

Saving the Script

Modifications to a script file can be saved using the Save or the Save As function. Saving changes to an existing script writes over the original script. To use a Zebra-supplied standard script as a base and save the changes in a new script, use the Save As function.

Building the Image

Once the script is created, the hex image defined by the script can be built.

As part of the build, TCM performs a check on the script which verifies that all files referenced in the script exist. This check is important for previously created scripts to ensure that files referenced in the script are still in the designated locations.

To build scripts:

1. Click Build on the TCM toolbar. The Configure Build window appears.

2. Select the items (partitions) to build using the check box(es) to the left of each named partition.

3. The Build Path defines where to store all built partitions.

4. Select (hex image) COMPRESSION to reduce the size and speed up the download.
5. Click **OK** and follow the on-screen instructions.

6. If one of the partitions being built is the ESSID, a prompt appears requesting the ESSID value. Deselect the HR (High Rate) check box when building ESSID images for a device with an FH radio.

![Build ESSID Partition Window](image)

**Figure 7-8  Build ESSID Partition Window**

7. If one of the partitions being built is the Splash Screen, a prompt appears requesting both the source Bitmap file and the destination HEX file.

8. A check is performed and if there are no errors, the partition hex files are created.

If the build fails, the hex files are not be created and TCM displays an error message. Two of the most common reasons for a build failure are:

- Files defined in the script can not be found. This error can occur when the files referenced by the script are no longer stored on the development computer or the folders where they are stored were renamed.

- The total amount of flash memory space required by the script exceeds the image size. To correct this, reduce the number of files in the partition or increase the size of the partition. See *Defining Script Properties on page 7-8* for more information about setting the image size appropriately.

---

**Sending the Hex Image**

Once the hex file is built, it can be downloaded to the vehicle computer.

**Using TCM**

To load the hex files on to the vehicle computer:

1. For downloads using an RS232 serial connection, connect the rugged RS232 cable to the COM1 port on the vehicle computer and the other end to the development computer.

   or

   For downloads using a USB connection, connect the standard USB cable to the USB B (Client) port on the vehicle computer and the other end to the development computer.

2. Press and hold the **Backlight Control** button on the control panel.

3. Hold the **Backlight Control** button until the vehicle computer resets into IPL mode.

4. When the **Initial Program Loader** menu appears, release the **Backlight Control** button.
5. Scroll to select the partition to download or choose Auto Select, then press P2.

Table 7-2  IPL Menu Partitions

<table>
<thead>
<tr>
<th>Partition Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Platform</td>
<td>Contains the files in the Platform folder.</td>
</tr>
<tr>
<td>Application</td>
<td>Contains the files in the Application folder.</td>
</tr>
<tr>
<td>Config Block</td>
<td>Contains information to correctly configure the Operating System for the mobile computer. This information is loaded by the manufacturer. Note: Great care should be taken to ensure that an incorrect config block is not loaded into the mobile computer. Loading an incorrect config block prevents the correct operation of the computer.</td>
</tr>
<tr>
<td>Windows CE</td>
<td>Contains the operating system for the vehicle computer.</td>
</tr>
<tr>
<td>Monitor</td>
<td>Contains the Monitor and IPL programs.</td>
</tr>
<tr>
<td>Splash Screen</td>
<td>Contains the splash screen that displays while booting the vehicle computer. Note: Splash screens are generated from .bmp images and must be less than or equal to 240 pixels wide and 296 pixels deep. For mono displays, the bmp image must be 4 bpp and for color screens the color depth must be 8 bpp. Note: 8 bits per pixel only applies to splash screen images. Once Windows CE is running, the color density is 16 bits per pixel.</td>
</tr>
</tbody>
</table>
Table 7-2  IPL Menu Partitions (Continued)

<table>
<thead>
<tr>
<th>Partition Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power Micro</td>
<td>The Power Micro is a small computer contained within the vehicle computer that controls several system resources. In the unlikely event that the Power Micro Firmware needs updating, selecting this item allows the device to be programmed.</td>
</tr>
<tr>
<td>Partition Table</td>
<td>Contains the partition information for all other partitions. Note: The partition table should never need changing unless the sizes of the platform and application images are changed within TCM. If this is done, then the new partition table should be loaded first, followed by both platform and application in any order.</td>
</tr>
<tr>
<td>Command File</td>
<td>Select to load a command file. A command file is a file that allows you to automatically load a number of partitions in a batch process.</td>
</tr>
<tr>
<td>System Reset</td>
<td>Selecting this item provides a simple method to exit IPL and to boot the operating system.</td>
</tr>
<tr>
<td>Auto Select</td>
<td>Selecting this item allows one or more files to be downloaded without having to manually select the destination. (The content of the files being downloaded automatically directs the file to the correct destination.) For technical reasons, Auto Select cannot be used to download Monitor, Power Micro, or Partition Table. These items must be specifically selected.</td>
</tr>
</tbody>
</table>

6. IPL displays the **Select Transport** menu which lists the available methods of downloading the file.

![Select Transport Menu](image)

7. Scroll to select **USB** or **Lighthouse 0 - Serial** transport, then press **P2**.

   > **NOTE** You must disable USB ActiveSync on the development computer.

8. If you selected the **Lighthouse 0 - Serial** transport method:
   - a. the **Baud Rate Menu** appears.

   ![Baud Rate Menu](image)

   b. Scroll to select the appropriate baud rate, then press **P2**.
9. If you selected USB transport method press P2. If this is the first time using USB transport, you might need to install the Zebra USB driver. Follow the screen prompts. The Zebra USB driver is supplied with the DCP.

10. The Download File? menu appears.

![Download File? Menu](image)

11. Use the P1 and P3 buttons to select Show Parms to verify the file to download. Press P2 to display the Parameters screen.

![Parameters Screen](image)

- **Partition Name** is the name of the partition selected in the Initial Program Loader menu.
- **Device Parameters** is the device selected in the Select Transport menu with the baud rate for serial downloads.

12. Press P2 to return to the Download File? menu.

13. Use the up and down scroll buttons to select Download. Press P2. The Downloading screen appears.

![Downloading Screen](image)

Before the download starts Waiting for Data appears in the Device Status field.

14. On the development computer, click Load on the TCM toolbar. The Load Terminal window - Serial tab appears.
15. In the Image Files To Load field, select the hex file or files to download.

16. In the Comm Port field, select the port on the vehicle computer that the development computer is connected to.

17. In the Baud Rate field, select the baud rate. Only available on serial RS232 downloads.

18. Click Download.

19. During download, the Downloading screen on vehicle computer displays the Device Status and a progress bar.

20. When complete, Device Status displays Result was Success, or in the case of an error, the cause of the error.

21. On completion, press P2 to return to the IPL menu to select the next partition to download.

22. To exit IPL, select the System Reset item from the IPL menu.

Using SD Card

NOTE If you are using an SD card to load a hex image onto the vehicle computer, you must first copy the files to the SD card and install the SD card into the memory slot on the back of the vehicle computer. See Installing a Memory Card on page 2-3 for instructions for installing an SD card.

To load the hex files on to the vehicle computer:

1. Install the SD card. See Installing a Memory Card on page 2-3 for instructions for installing an SD card.

2. Press and hold the Backlight Control button on the control panel.

3. Hold the Backlight Control button until the vehicle computer resets into IPL mode.

4. When the Initial Program Loader menu appears, release the Backlight Control button.
5. Choose Auto Select or scroll to select the partition to download, then press P2. See Table 7-2 on page 7-12.

6. IPL displays the Select Transport menu which lists the available methods of downloading the file.

7. Scroll to select SD/MMC transport, then press P2. The vehicle computer scans the memory card for files.

8. Scroll to select the file to download.

10. The **Download File?** menu appears.

<table>
<thead>
<tr>
<th>Download File?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Download</td>
</tr>
<tr>
<td>Cancel</td>
</tr>
<tr>
<td>Show Parms</td>
</tr>
<tr>
<td>Previous</td>
</tr>
<tr>
<td>Top</td>
</tr>
</tbody>
</table>

*Figure 7-19  Download File? Menu*

11. Use the P1 and P3 buttons to select **Show Parms** to verify the file to download. Press P2 to display the **Parameters** screen.

Download:
“Partition Name” via
“Device Parameters”
Press Enter to Continue

*Figure 7-20  Parameters Screen*

- **Partition Name** is the name of the partition selected in the **Initial Program Loader** menu.
- **Device Parameters** is the device selected in the **Select Transport** menu with the **baud rate** for serial downloads.

12. Press P2 to return to the **Download File?** menu.

13. Use the up and down scroll buttons to select **Download**. Press P2. The **Downloading** screen appears.

<table>
<thead>
<tr>
<th>Downloading:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Partition Name</td>
</tr>
</tbody>
</table>

Device Parameters

Device Status

*Figure 7-21  Downloading Screen*

14. During download, the **Downloading** screen on vehicle computer displays the **Device Status** and a progress bar.

15. When complete, **Device Status** displays **Result was Success**, or in the case of an error, the cause of the error.

16. On completion, press P2 to return to the IPL menu to select the next partition to download.

17. To exit IPL, select the **System Reset** item from the IPL menu.
TCM Error Messages

TCM validates the cells in the partition table when the Execute button is clicked. Cells highlighted in red contain an error. Partition loading is disabled until all errors are corrected.

<table>
<thead>
<tr>
<th>Error</th>
<th>Description/Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Failed to build images: flash file system DLL not loaded!</td>
<td>TCM could not load the DLL required to build images for the targeting flash file system. Reinstall TCM or recover the DLL.</td>
</tr>
<tr>
<td>Failure finding directory xxx</td>
<td>Building process failed because directory xxx was not found.</td>
</tr>
<tr>
<td>Failure creating volume</td>
<td>Building process failed because a certain disk volume could not be created.</td>
</tr>
<tr>
<td>Failure adding system file to image</td>
<td>Build process failed because TCM failed to add a certain system file to the disk image.</td>
</tr>
<tr>
<td>INVALID PATH</td>
<td>The path for the image file to build is not valid.</td>
</tr>
<tr>
<td>Nothing Selected To Build</td>
<td>In the Config Build window, no item is selected to build.</td>
</tr>
<tr>
<td>Illegal ESS ID</td>
<td>In the Build ESSID Partition window, no ESS ID was entered or the ESS ID entered was illegal.</td>
</tr>
<tr>
<td>Disk Full</td>
<td>TCM failed to create Hex image file at the selected path. Check available disk space.</td>
</tr>
<tr>
<td>Target Disk Full</td>
<td>Build process failed because TCM failed to add file to the image of a disk volume. Remove some files or increase the disk size.</td>
</tr>
<tr>
<td>Hex file is READ ONLY</td>
<td>The Hex image file to be created exists and is read-only. Delete the existing file or change its attribute.</td>
</tr>
<tr>
<td>Error opening the file xxx with write access</td>
<td>TCM could not open file xxx with write access. Check if file is in use.</td>
</tr>
<tr>
<td>Failure creating binary file</td>
<td>TCM failed to open/create an intermediate binary file.</td>
</tr>
<tr>
<td>Hex File To load is missing or invalid</td>
<td>In Load Terminal window, the file selected to load has invalid status.</td>
</tr>
<tr>
<td>Could not locate vehicle computer name in TCM.ini file</td>
<td>While loading the Script Properties window, TCM could not find the TCM.ini section corresponding to the vehicle computer type specified by the current opening script. Either TCM.ini or the script file is invalid.</td>
</tr>
<tr>
<td>Incorrect disk sizes in TCM.ini file</td>
<td>The total disk size specified in the script does not match the total disk size defined in the corresponding TCM.ini section. Check if the script is corrupt or the TCM.ini has changed after the script was created.</td>
</tr>
<tr>
<td>INVALID DIRECTORY</td>
<td>In Script Properties window, the selected System File Path is not a valid directory.</td>
</tr>
<tr>
<td>One of the disk sizes is one sector in size</td>
<td>In Script Properties window, one of the disks is too small (one sector in size). This may cause problem while building images, especially when cushion is enabled. Increase the disk size.</td>
</tr>
</tbody>
</table>
Table 7-3  TCM Error Messages (Continued)

<table>
<thead>
<tr>
<th>Error</th>
<th>Description/Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>INVALID VOLUME NAME</td>
<td>In Script Properties window, one of the volume labels is not valid.</td>
</tr>
<tr>
<td>Corrupt TCM.INI file! (Invalid value of VolumeDivisor)</td>
<td>The VolumeDivisor entry is missing or invalid in the TCM.ini. Reinstall TCM or recover TCM.ini.</td>
</tr>
<tr>
<td>Invalid version of TCM script file</td>
<td>The TCM script was not created by this version of TCM.</td>
</tr>
<tr>
<td>Corrupt or missing TCM.ini file</td>
<td>TCM could not find TCM.ini file.</td>
</tr>
<tr>
<td>FAILED CONNECTION TO COM PORT (Could not get status)</td>
<td>While downloading images to vehicle computer, TCM failed to connect to the selected COM port. Check if the COM port is free and is properly configured.</td>
</tr>
<tr>
<td>FAILED CONNECTION TO TERMINAL (Terminal Not Connected Properly/Terminal Not Ready to Receive)</td>
<td>While downloading images, TCM failed to connect to the vehicle computer. Check if the correct flow control protocol is selected and the vehicle computer is properly connected and is in a listening state.</td>
</tr>
</tbody>
</table>
IPL Error Detection

While receiving data, IPL performs many checks on the data to ensure that the data is received correctly. If an error is detected, IPL immediately aborts the download, and reports the error on an error screen.

Error screens may vary depending on the action being performed. A sample error screen may look like the screen pictured below:

```
Downloading:
Platform
via Serial Port 115200
Error # -2: Messages:
Cancelled by user

Press any key to continue
```

Figure 7-22  IPL Error Screen

This error message screen displays until you press any key. Once the screen is acknowledged, IPL returns to the Initial Program Loader main menu to wait for a new selection.

To find the probable cause of the error, use the error number and/or the error text displayed on the screen to look up the error in Table 7-4.

Table 7-4  IPL Errors

<table>
<thead>
<tr>
<th>Error Text</th>
<th>Error Number</th>
<th>Probable Cause</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unknown error</td>
<td>-1</td>
<td>A general error occurred. Retry the download. If the failure persists, it is most likely due to a hardware failure; the vehicle computer requires servicing.</td>
</tr>
<tr>
<td>Cancelled by user</td>
<td>-2</td>
<td>The user canceled the download.</td>
</tr>
<tr>
<td>Can't open the source</td>
<td>-7</td>
<td>An error occurred opening the source device (either radio card or Serial port). Check source device connectivity and retry.</td>
</tr>
<tr>
<td>Can't open the destination</td>
<td>-8</td>
<td>An error occurred opening the destination device (either flash ROM or Power Micro). Retry the download. If the failure persists, it is most likely due to a hardware failure; the vehicle computer requires servicing.</td>
</tr>
<tr>
<td>Can't read from the source device</td>
<td>-9</td>
<td>The source device (either radio card or Serial port) could not be read from. Check source device connectivity and retry.</td>
</tr>
<tr>
<td>Can't write to the destination device</td>
<td>-10</td>
<td>The destination device (either flash ROM or Power Micro) could not be written to. Retry the download. If the failure persists, it is most likely due to a hardware failure; the vehicle computer requires servicing.</td>
</tr>
<tr>
<td>Transmission checksum error</td>
<td>-11</td>
<td>An error occurred during transmission from the source device (either radio card or Serial port) and the checksum check failed. Check source device connectivity and retry.</td>
</tr>
<tr>
<td>Error Text</td>
<td>Error Number</td>
<td>Probable Cause</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>--------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Readback checksum error</td>
<td>-12</td>
<td>A checksum, generated from reading back data that was written to the destination device, was incorrect. An error during transmission or a write error to the destination device could cause this.</td>
</tr>
<tr>
<td>There is no more heap space available</td>
<td>-14</td>
<td>There is no more heap space available for the download procedure. Restart IPL and retry the download. If the failure persists, contact service with details of what is being downloaded.</td>
</tr>
<tr>
<td>Insufficient data available to complete record</td>
<td>-21</td>
<td>A Symbol HEX file download was attempted but the HEX file is invalid. Ensure the file is in Symbol HEX file format.</td>
</tr>
<tr>
<td>Invalid Symbol HEX file</td>
<td>-23</td>
<td>A Symbol HEX file download was attempted but the HEX file is invalid. Ensure the file is in Symbol HEX file format.</td>
</tr>
<tr>
<td>Unrecognized or unsupported HEX record</td>
<td>-24</td>
<td>The Symbol HEX file being downloaded contains an invalid or unrecognized HEX record. Ensure the file is in proper Symbol HEX file format.</td>
</tr>
<tr>
<td>Invalid data in HEX file</td>
<td>-25</td>
<td>The Symbol HEX file being downloaded contains invalid data. Ensure the file is in proper Symbol HEX file format with valid HEX data.</td>
</tr>
<tr>
<td>Exceeded max size</td>
<td>-26</td>
<td>The download file is too large to fit into the space allocated for it. Either make the file smaller or increase the space allocated for it by altering the partition table.</td>
</tr>
<tr>
<td>Partition is not valid on this device</td>
<td>-27</td>
<td>The downloaded file specifies a partition entry that does not exist on the device. Only download files that are valid for this device, or change the partition table so that the new file is valid on the device.</td>
</tr>
<tr>
<td>Wrong destination code</td>
<td>-28</td>
<td>A specific partition was chosen from the Main Menu (not Auto Select) but the file selected for download was for another partition. Ensure that the partition selected from the Main Menu matches the file selected for download.</td>
</tr>
<tr>
<td>File type does not support IPL Auto Select</td>
<td>-29</td>
<td>Monitor, Power Micro and Partition Table cannot be loaded with Auto Select. Select the appropriate area, and try again.</td>
</tr>
<tr>
<td>Non-contiguous record found</td>
<td>-30</td>
<td>A Symbol HEX file download was attempted but the HEX file is invalid. Ensure the file is in Symbol HEX file format.</td>
</tr>
<tr>
<td>Timed Out - No data</td>
<td>-31</td>
<td>IPL was waiting for data from the source device but timed out before receiving any. Check the source device connectivity and retry.</td>
</tr>
<tr>
<td>Fail: Buffer Overrun</td>
<td>-32</td>
<td>The serial port device could not keep up with incoming data. Retry the serial download with a lower baud rate.</td>
</tr>
<tr>
<td>Partition Table not Valid</td>
<td>-33</td>
<td>The size of flash memory is different than that described in the partition table. Retry the download with the correct partition table file.</td>
</tr>
<tr>
<td>Invalid file format</td>
<td>-34</td>
<td>The file format is invalid. Only Symbol HEX files are supported by IPL.</td>
</tr>
</tbody>
</table>
Creating a Splash Screen

The source bitmap files used to create the default splash screens for the vehicle computer are supplied with the DCP for VC5090c50. These files can be modified using any of the standard windows image editors, allowing customization for particular customers.

To create a custom splash screen, perform the following steps:

1. Open the Splashcolor.bmp file supplied with the DCP for VC5090c50 using an image editor.
2. Modify the bitmap file and save.
3. Create a splash partition using the steps shown in the *Building the Image on page 7-10*.

Splash Screen Format

If the default files are not used to create the new splash screens, be sure to preserve the image format. The formats are as follows:

<table>
<thead>
<tr>
<th>Screen Type</th>
<th>Dimensions</th>
<th>Color Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color</td>
<td>490x296</td>
<td>8 bits per pixel*</td>
</tr>
</tbody>
</table>

* 8 bits per pixel only applies to splash screen images. Once Windows CE is running, the color density is 16 bits per pixel.

See *Sending the Hex Image on page 7-11* for information about loading the splash screen using TCM and IPL.

Flash Storage

In addition to the RAM-based storage standard on Windows CE vehicle computers, the vehicle computer is also equipped with a non-volatile Flash-based storage area which can store data (partitions) that can not be corrupted by a cold boot. This Flash area is divided into two categories: Flash File System (FFS) Partitions and Non-FFS Partitions.

FFS Partitions

The vehicle computer includes two FFS partitions. These partitions appear to the vehicle computer as a hard drive that the OS file system can write files to and read files from. Data is retained even if power is removed.

The two FFS partitions appear as two separate folders in the Windows CE file system and are as follows:

- **Platform**: The Platform FFS partition contains Zebra-supplied programs and Dynamic Link Libraries (DLLs). This FFS is configured to include DLLs that control system operation. Since these drivers are required for basic vehicle computer operation, only experienced users should modify the content of this partition.
- **Application**: The Application FFS partition is used to store application programs needed to operate the vehicle computer.
Working with FFS Partitions

Because the FFS partitions appear as folders under the Windows CE file system, they can be written to and read like any other folder. For example, an application program can write data to a file located in the Application folder just as it would to the Windows folder. However, the file in the Application folder is in non-volatile storage and is not lost on a cold boot (e.g., when power is removed for a long period of time).

Standard tools such as ActiveSync can be used to copy files to and from the FFS partitions. They appear as the “Application” and “Platform” folders to the ActiveSync explorer. This is useful when installing applications on the vehicle computer. Applications stored in the Application folder are retained even when the vehicle computer is cold booted.

There are two device drivers included in the Windows CE image to assist developers in configuring the vehicle computer following a cold boot: RegMerge and CopyFiles.

**RegMerge.dll**

RegMerge.dll is a built-in driver that allows registry edits to be made to the Windows CE Registry. Regmerge.dll runs very early in the boot process and looks for registry files (.reg files) in certain Flash File System folders during a cold boot. It then merges the registry changes into the system registry located in RAM.

Since the registry is re-created on every cold boot from the default ROM image, the RegMerge driver is necessary to make registry modifications persistent over cold boots.

RegMerge is configured to look in the root of two specific folders for .reg files in the following order:

- `\Platform`
- `\Application`

Regmerge continues to look for .reg files in these folders until all folders are checked. This allows folders later in the list to override folders earlier in the list. This way, it is possible to override Registry changes made by the Platforms partitions folders. Take care when using Regmerge to make Registry changes. The DCP for VC5090w contains examples of .reg files.

**NOTE** Regmerge only merges the .reg files on cold boots. The merge process is skipped during a warm boot.

Typically, do not make modifications to registry values for drivers loaded before RegMerge. However, these values may require modification during software development. Since these early loading drivers read these keys before RegMerge gets a chance to change them, the vehicle computer must be cold booted. The warm boot does not re-initialize the registry and the early loading driver reads the new registry values.

Do not use Regmerge to modify built-in driver registry values, or merge the same Registry value to two files in the same folder, as the results are undefined.

**CopyFiles**

Windows CE expects certain files to be in the Windows folder, residing in volatile storage. Windows CE maintains the System Registry in volatile storage. CopyFiles copies files from one folder to another on a cold boot. Files can be copied from a non-volatile partition (Application or Platform) to the Windows or other volatile partition during a cold boot. During a cold boot CopyFiles looks for files with a .CPY extension in the root of the Platform and Application FFS partitions (Platform first and then Application). These files are text files containing the source and destination for the desired files to be copied separated by ">". The following example from the file application.cpy is contained on the demo application partition included in the DCP for VC5090w. It can also be obtained from the Support Central web site at http://www.zebra.com/support.
Files are copied to the Windows folder from the Flash File System using copy files (*.cpy) in the following order:

- Platform
- Application

Example:

\Application\ScanSamp2.exe>\Windows\ScanSamp2.exe

This line directs CopyFiles to copy the ScanSamp2.exe application from the \Application folder to the \Windows folder.

**Non-FFS Partitions**

Non-FFS Partitions include additional software and data pre-loaded on the vehicle computer that can be upgraded. Unlike FFS Partitions, these partitions are not visible when the operating system is running. They also contain system information. Non-FFS partitions include the following:

- **Windows CE**: The complete Windows CE operating system is stored on Flash devices. If necessary, the entire OS image may be downloaded to the vehicle computer using files provided by Zebra. The current OS partition on the vehicle computer is included as part of the TCM installation package. Any upgrades must be obtained from Zebra. This partition is mandatory for the vehicle computer.

- **Splash Screen**: A bitmap smaller than 16 Kb (and limited to 8 bits per pixel) is displayed as the vehicle computer cold boots. To download a customized screen to display, see [Creating a Splash Screen on page 7-22](#).

- **IPL**: This program interfaces with the host computer and allows downloading via serial cable any or all of the partitions listed above, as well as updated versions of IPL. Use caution downloading updated IPL versions; incorrect downloading of an IPL causes permanent damage to the vehicle computer. IPL is mandatory for the vehicle computer.

- **Partition Table**: Identifies where each partition is loaded in the vehicle computer.

**Downloading Partitions to the Vehicle Computer**

TCM is used to specify a hex destination file for each partition and download each file to the vehicle computer. This download requires a program loader stored on the vehicle computer. The vehicle computer comes with a program loading utility, Initial Program Loader (IPL), stored in the vehicle computer’s write-protected flash.
Chapter 8 Staging and Provisioning

Introduction

The MSP 3 Client Software is a set of software components that come pre-installed on the VC5090. The MSP 3 Client software consists of the following three components:

Refer to the Mobility Services Platform 3.2 User’s Guide, p/n 72E-100158-06, for instructions for using the Rapid Deployment, AirBEAM Smart and MSP3 Agent clients.

Rapid Deployment (RD) Client

The RD Client provides support for MSP 3 Staging functionality, provides support for the MSP 3 Legacy Staging process, and provides support for backward-compatible legacy MSP 2.x Legacy Staging functionality.

AirBEAM Smart Client

The AirBEAM Smart Client provides backward-compatible legacy AirBEAM functionality and backward-compatible legacy MSP 2.x Level 2 Agent functionality.

MSP 3 Agent

The MSP 3 Agent provides MSP 3 Provisioning functionality and Control functionality when used with MSP 3.2 Control Edition.
Chapter 9 Maintenance and Troubleshooting

Introduction

This chapter includes instructions on cleaning and storing the vehicle computer, and provides troubleshooting solutions for potential problems during vehicle computer operation.

Maintaining the Vehicle Computer

For trouble-free service, observe the following tips when using the vehicle computer:

- Take care not to scratch the screen of the vehicle computer. When working with the vehicle computer, use your finger tip or plastic-tipped pens intended for use with a touch-sensitive screen. Never use an actual pen or pencil or other sharp object on the surface of the vehicle computer screen.
- Use screen protector at all time. See Accessories on page 1-4 for replacement screen protectors.
- Although the vehicle computer is water and dust resistant, do not expose it to rain or moisture for an extended period of time. In general, treat the vehicle computer as you would any other electronic device.
- The screen of the vehicle computer is glass. Do not to drop the vehicle computer or subject it to strong impact.
- Protect the vehicle computer from temperature extremes.
- Do not store or use the vehicle computer in any location that is extremely dusty, damp, or wet.
- Use a soft lens cloth to clean the vehicle computer. If the surface of the vehicle computer screen becomes soiled, clean it with a soft cloth moistened with a diluted window-cleaning solution.
- Periodically check nuts and bolts to ensure they are tightened to the proper torque.
- Ensure that you have spare screws when changing desiccant bags and SD cards.

NOTE Whenever the VC5090 is being replaced on a fork lift, ensure that the VC5090 is compatible with the power cable installed on the truck.
Returning the Vehicle Computer for Service

**NOTE** Zebra has taken great care to ensure environmental conditions such as humidity will not affect the stability of the vehicle computer. This is accomplished my means of desiccant bags which can be inserted by the user upon receipt of the vehicle computer. In the event, the vehicle computer needs to be shipped by air carrier to Zebra for repair or maintenance, it is essential that the user remove the desiccant door cover before the vehicle computer is packaged for shipment. The reason for this step is to avoid compromising the vehicle computer as a result of pressurization during air transit. The user must simply remove the screws associated with the desiccant door on the back of the unit. Discard the used desiccant bags. Upon receipt of the repaired vehicle computer, the user should insert new desiccant bags (if used) and reseal the doors using new screws.

## Troubleshooting

**Table 9-1  Vehicle Computer Problems**

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vehicle computer does not power on or shuts off</td>
<td>Main power switch on top of vehicle computer is in the Off position.</td>
<td>Turn the main power switch on.</td>
</tr>
<tr>
<td>suddenly.</td>
<td>Power cable not connected properly or unplugged.</td>
<td>Connect power cable to power cable portion underside of vehicle computer. Turn the main power switch on.</td>
</tr>
<tr>
<td></td>
<td>If the vehicle computer is powered by a vehicle battery, the vehicle battery is depleted.</td>
<td>Replace or charge the vehicle battery.</td>
</tr>
<tr>
<td></td>
<td>The power cable ignition sense wire (yellow) is not connected properly.</td>
<td>Verify that the power cable is connected properly. See on page 2-14.</td>
</tr>
<tr>
<td>Cannot see characters on display.</td>
<td>Vehicle computer not powered on or suspended (Power LED is off).</td>
<td>Press the Power switch on the Quick Access Panel.</td>
</tr>
<tr>
<td></td>
<td>Screen is too bright/dark.</td>
<td>Adjust the brightness; see Adjusting the Brightness on page 3-9.</td>
</tr>
<tr>
<td></td>
<td>Display not adjusted properly.</td>
<td>Select Display in the Control Panel settings and adjust the display.</td>
</tr>
<tr>
<td></td>
<td>The vehicle computer is in Suspend mode (Power LED is off).</td>
<td>Press the Power button on the Quick Access Panel to turn on the vehicle computer.</td>
</tr>
<tr>
<td>Touchscreen not working.</td>
<td>Display not properly calibrated.</td>
<td>Recalibrate the screen through the Control Panel Calibration utility. If problem continues, contact Zebra Support. See Service Information on page xvi.</td>
</tr>
<tr>
<td></td>
<td>Replacement screen protector was not applied correctly.</td>
<td>Replace or re-apply screen protector.</td>
</tr>
</tbody>
</table>
Table 9-1  Vehicle Computer Problems  (Continued)

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optional scanner does not operate.</td>
<td>Scanner is not properly connected to the vehicle computer.</td>
<td>Connect the scanner to the COM1 or COM2 port. Ensure the proper COM port is selected in the SerialWedge application, see Installing a Scanner on page 2-20. If the problem continues, refer to the scanner Product Reference Guide.</td>
</tr>
<tr>
<td></td>
<td>SerialWedge application is not enabled or set to the correct COM Port.</td>
<td>Ensure that the SerialWedge application is enabled and set to the correct port. See Scanner Setup on page 2-27.</td>
</tr>
<tr>
<td>No sound is heard when you tap the touchscreen or press a key.</td>
<td>Volume is turned down.</td>
<td>Adjust the volume in the Control Panel.</td>
</tr>
<tr>
<td></td>
<td>Application currently running disabled the sound.</td>
<td>Configure the application to enable the sound.</td>
</tr>
<tr>
<td></td>
<td>Faulty speaker.</td>
<td>Contact Zebra Support. See Service Information on page xvi.</td>
</tr>
<tr>
<td>Missing pixels on the display.</td>
<td>Faulty LCD.</td>
<td>Contact Zebra Support. See Service Information on page xvi.</td>
</tr>
<tr>
<td>COM1 or COM2 port is not working.</td>
<td>Another application, ActiveSync or SerialWedge is using the port.</td>
<td>Stop the application using the port, disconnect the ActiveSync cable from the host, or change the SerialWedge COM port setting.</td>
</tr>
<tr>
<td>No response when ActiveSync is initiated.</td>
<td>ActiveSync cable not connected properly.</td>
<td>Connect the ActiveSync cable.</td>
</tr>
<tr>
<td></td>
<td>ActiveSync is not configured properly.</td>
<td>Configure ActiveSync in the Control Panel. See Setting Up an ActiveSync Connection on the Host Computer on page 6-3.</td>
</tr>
<tr>
<td>No keys are working on the optional or built-in keyboard.</td>
<td>The optional keyboard is not properly connected to the vehicle computer.</td>
<td>Check the cable connections between the keyboard and the vehicle computer.</td>
</tr>
<tr>
<td></td>
<td>The application does not require keyboard input.</td>
<td>Configure the application to use the keyboard.</td>
</tr>
<tr>
<td></td>
<td>Vehicle computer is not responding.</td>
<td>Warm boot the vehicle computer.</td>
</tr>
<tr>
<td>COMM LED is off.</td>
<td>Lost network connection.</td>
<td>If problem continues, contact Zebra Support. See Service Information on page xvi.</td>
</tr>
<tr>
<td></td>
<td>COMM LED is turned off.</td>
<td>Enable the COMM LED using the Control Panel. See COMM LED on page 3-2</td>
</tr>
</tbody>
</table>
Vehicle computer cannot find any Bluetooth devices nearby.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Too far from other Bluetooth devices.</td>
<td>Move closer to the other Bluetooth device(s), within a range of 10 meters.</td>
<td></td>
</tr>
<tr>
<td>The Bluetooth device(s) nearby are not turned on.</td>
<td>Turn on the Bluetooth device(s) you wish to find.</td>
<td></td>
</tr>
<tr>
<td>The Bluetooth device(s) are not in discoverable mode.</td>
<td>Set the Bluetooth device(s) to discoverable mode. If needed, refer to the device’s user documentation for help.</td>
<td></td>
</tr>
</tbody>
</table>

There is a delay in the Bluetooth stack re-initializing during a resume from suspend.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>This is the normal behavior.</td>
<td>No solution required.</td>
<td></td>
</tr>
</tbody>
</table>
## Technical Specifications

The following tables summarize the vehicle computer’s intended operating environment and general technical hardware specifications.

### Vehicle Computer

The following table summarizes the vehicle computer’s intended operating environment.

<table>
<thead>
<tr>
<th>Table A-1</th>
<th>Technical Specifications</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Item</th>
<th>Full-Screen</th>
<th>Half-Screen</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Physical and Environmental Characteristics</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Dimension</td>
<td>12.2 in W x 4.5 in. D x 10.6 in. H</td>
<td>12.2 in W x 5.04 in. D x 11.28 in. H</td>
</tr>
<tr>
<td></td>
<td>30.9 cm W x 11.4 cm D x 26.9 cm H</td>
<td>30.9 cm W x 12.8 cm D x 28.6 cm H</td>
</tr>
<tr>
<td>Weight</td>
<td>14.5 lbs. (6.85 kg)</td>
<td>16.3 lbs. (7.4 kg)</td>
</tr>
<tr>
<td>Keyboard</td>
<td>Optional</td>
<td>Built-In</td>
</tr>
<tr>
<td>Display</td>
<td>12.1 in. full SVGA color display</td>
<td>10.4 in. half-SVGA color display</td>
</tr>
<tr>
<td>Power</td>
<td>10 - 96 VDC</td>
<td>10 - 96 VDC</td>
</tr>
<tr>
<td><strong>Performance Characteristics</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CPU</td>
<td>Intel XScale PXA270 processor at 624MHz</td>
<td></td>
</tr>
<tr>
<td>Operating System</td>
<td>Microsoft Windows CE 5.0 Professional</td>
<td></td>
</tr>
<tr>
<td>Memory (RAM/ROM)</td>
<td>128/128 MB SDRAM, 64 MB XIP Flash, 128 MB NAND Flash</td>
<td></td>
</tr>
<tr>
<td>Expansion</td>
<td>SD Card, up to 1 GB. See Table 1-1 on page 1-4 for a list of approved SD cards.</td>
<td></td>
</tr>
<tr>
<td>Application Development</td>
<td>PSDK, DCP and SMDK available through Support Central Web Site</td>
<td></td>
</tr>
<tr>
<td>Data Capture Options</td>
<td>Optional external scanner</td>
<td></td>
</tr>
<tr>
<td>Item</td>
<td>Full-Screen</td>
<td></td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>User Environment</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Operating Temperature</td>
<td>-22°F to 122°F (-30°C to 50°C)</td>
<td></td>
</tr>
<tr>
<td>Storage Temperature</td>
<td>-40°F to 158°F (-40°C to 70°C)</td>
<td></td>
</tr>
<tr>
<td>Battery Charging Temperature</td>
<td>32 °F to 104 °F (0 °C to +40 °C) ambient temperature range.</td>
<td></td>
</tr>
<tr>
<td>Humidity</td>
<td>5% to 95% condensing</td>
<td></td>
</tr>
<tr>
<td>Environmental Sealing</td>
<td>IP66</td>
<td></td>
</tr>
<tr>
<td>ESD</td>
<td>+/−20kVDC air discharge</td>
<td></td>
</tr>
<tr>
<td></td>
<td>+/−8kVDC direct discharge</td>
<td></td>
</tr>
<tr>
<td></td>
<td>+/−2kVDC indirect discharge</td>
<td></td>
</tr>
<tr>
<td>Wireless Data Communications</td>
<td></td>
<td></td>
</tr>
<tr>
<td>WLAN</td>
<td>802.11a/b/g</td>
<td></td>
</tr>
<tr>
<td>Output Power</td>
<td>100mW U.S. and International</td>
<td></td>
</tr>
<tr>
<td>Data Rate</td>
<td>802.11a: up to 54Mb per second</td>
<td></td>
</tr>
<tr>
<td></td>
<td>802.11b: up to 11Mb per second</td>
<td></td>
</tr>
<tr>
<td></td>
<td>802.11g: up to 54Mb per second</td>
<td></td>
</tr>
<tr>
<td>Antenna</td>
<td>Two internal antennas with diversity; external antenna connector; one internal antenna for Bluetooth</td>
<td></td>
</tr>
<tr>
<td>Frequency Range:</td>
<td>802.11a: 5 GHz</td>
<td></td>
</tr>
<tr>
<td></td>
<td>802.11b: 2.4 GHz</td>
<td></td>
</tr>
<tr>
<td></td>
<td>802.11g: 2.4 GHz</td>
<td></td>
</tr>
<tr>
<td>Bluetooth</td>
<td>Bluetooth Version 1.2. A full featured SDK is available for download from Support Central.</td>
<td></td>
</tr>
</tbody>
</table>
Vehicle Computer Connectors

Note The connectors are the same on both the full screen and half screen configurations.

Table A-2 Power Connector Pin-Outs

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>+12 VDC</td>
<td>12V output from AC supply/battery</td>
</tr>
<tr>
<td>B</td>
<td>Ignition Sense</td>
<td>Ignition Sense input from forklift</td>
</tr>
<tr>
<td>C</td>
<td>GND</td>
<td>Ground</td>
</tr>
<tr>
<td>D</td>
<td>CGND</td>
<td>Chassis ground</td>
</tr>
</tbody>
</table>

Mating connector: Amphenol p/n S996F-16-9S-RH
### Table A-3  USB Connector Pin-Outs

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>USB+</td>
<td>USB positive signal</td>
</tr>
<tr>
<td>2</td>
<td>USB-</td>
<td>USB negative signal</td>
</tr>
<tr>
<td>3</td>
<td>Vcc</td>
<td>5 VDC USB power (500 mA)</td>
</tr>
<tr>
<td>4</td>
<td>GND</td>
<td>Ground</td>
</tr>
<tr>
<td>5</td>
<td>HPWR</td>
<td>Keyboard heater</td>
</tr>
<tr>
<td>6</td>
<td>BLEN</td>
<td>Backlight enable signal</td>
</tr>
</tbody>
</table>

Mating connector: Amphenol p/n C091-31D006-100-2

### Table A-4  COM1 and COM2 Connector Pin-Outs

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>RxD</td>
<td>Serial data input to VC5090</td>
</tr>
<tr>
<td>2</td>
<td>TxD</td>
<td>Serial data output to VC5090</td>
</tr>
<tr>
<td>3</td>
<td>RTS</td>
<td>Request To Send output from VC5090</td>
</tr>
<tr>
<td>4</td>
<td>CTS</td>
<td>Clear To Send input to VC5090</td>
</tr>
<tr>
<td>5</td>
<td>DCD</td>
<td>Data Carrier Detect input to VC5090</td>
</tr>
<tr>
<td>6</td>
<td>DTR</td>
<td>Data Terminal Ready output from VC5090</td>
</tr>
<tr>
<td>7</td>
<td>Ext Vcc</td>
<td>5 VDC switched power output to peripherals (500 mA)</td>
</tr>
<tr>
<td>8</td>
<td>GND</td>
<td>Ground</td>
</tr>
</tbody>
</table>

Mating connector: Amphenol p/n C091-31D008-100-2
### Table A-5  Audio Connector Pin-Outs

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>MIC+</td>
<td>Audio input from microphone</td>
</tr>
<tr>
<td>2</td>
<td>MIC-</td>
<td>Audio input from microphone</td>
</tr>
<tr>
<td>3</td>
<td>HPOUT</td>
<td>Audio output to headphone ear piece</td>
</tr>
<tr>
<td>4</td>
<td>AGND</td>
<td>Analog ground</td>
</tr>
<tr>
<td>5</td>
<td>SPKR+</td>
<td>Audio output to handset speaker</td>
</tr>
<tr>
<td>6</td>
<td>SPKR-</td>
<td>Audio output to handset speaker</td>
</tr>
<tr>
<td>7</td>
<td>PTT</td>
<td>Push-to-Talk button signal from handset</td>
</tr>
</tbody>
</table>

Mating connector: Amphenol p/n C091-31D007-100-2

### Table A-6  USB A and B Connector Pin-Outs

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>VCC</td>
<td>+5 VDC USB power</td>
</tr>
<tr>
<td>2</td>
<td>USB -</td>
<td>USB negative signal</td>
</tr>
<tr>
<td>3</td>
<td>USB +</td>
<td>USB positive signal</td>
</tr>
<tr>
<td>4</td>
<td>GND</td>
<td>Ground</td>
</tr>
</tbody>
</table>
Appendix B Software Configuration

Introduction

This chapter provides special instructions required for third-party software that can be used with the VC5090 vehicle computer.

Wavelink TelnetCE

When using a serial scanner in a Wavelink TelnetCE session, the Wavelink Client communications parameters must be updated to reflect the connection of a scanner to one of the vehicle computer COMM ports. Serial options; such as baud rate, data bits, stop bits and parity, of the host session and the scanner must match.

The Wavelink Client defaults are:

- Baud: 9600
- Data bits: 8
- Stop bits: 1
- Parity: None.

Ensure that scanner default parameters match the Wavelink parameters. If they do not, configure the scanner accordingly. Refer to the scanner Product Reference Guide for information on the default scanner settings.

Citrix ICA Client

To install Citrix ICA Client on the vehicle computer, web services must be disabled.

1. Turn off CE web services:
   a. Tap Start > Run.
   b. Enter CMD and tap OK. The Command Prompt window appears.
   c. Enter "services stop HTTP:.
   d. Tap Enter.
e. Enter "exit".
f. Tap Enter to close the window.

2. Install Citrix ICA Client software.
   a. Download the client software from the Citrix web site.
   b. Follow the instructions that come with the software.

---

Setting Up Remote Desktop Client in AppCenter

To set up the Remote Desktop Client in AppCenter:

1. In App Center (version 1450 or higher):
   a. Tap File > New Program. The Edit Program Dialog window displays.
   b. Tap the ... button. The Running Programs Dialog window appears.
   c. Select the Services program icon.
   d. Tap OK.
   e. In the Descr text box, enter a name.
   f. In the Approved Window Titles: text box, enter *|*.
   g. Tap Save.

2. On the VC5090:
   a. On the desktop, double-tap the Remote Desktop icon.
   b. Enter the Remote Desktop connection information.
   c. Tap Save As.
   d. Navigate to the Application directory.
   e. In the Name: text box, enter a name for the connection.
   f. Tap OK.
   g. Close the Remote Desktop Connection window.

3. In AppCenter:
   a. Tap File > New Program. The Edit Program Dialog window displays.
   b. Tap the ... button. The Running Programs Dialog window appears.
   c. Select the Remote Desktop Connection program icon.
   d. Tap OK.
   e. In the Args: text box, enter \Application\ and the name of the rdp file saved in step 2e.
   f. In the Approved Window Titles: text box, enter Remote Desktop Connection|*.
   g. Tap Save.

4. Tap Tools > Create Registry File.

5. Tap OK.
6. Tap Tools > Log out.

Disabling the VC5090 Heater

The VC5090 vehicle computer and the optional keyboard contain internal heaters. By default the heaters are enabled. When the vehicle computer or optional keyboard temperature falls below the threshold level, the heater turns on. The heater can be disabled. Use the following registry settings to disable the heater:

For the optional keyboard:

[HKEY_CURRENT_USER\ControlPanel\SystemManagement\KeyboardHeater]
  KbdHeaterEnabled"=dword:1 - Making it 0 will never turn on the Keyboard heater.
  UsbKbdCheckReqd"=dword:1

For the vehicle computer:

[HKEY_CURRENT_USER\ControlPanel\SystemManagement\DisplayHeater]
  DispHeaterEnabled"=dword:1 - Making it 0 will never turn on the Display heater.

Scanning through Remote Desktop

1. Setup the scanner. See *Installing a Scanner on page 2-20*.

2. On VC5090 desktop, double-tap the Remote Desktop Connection icon.

   ![Remote Desktop Connection Window](image)

   **Figure B-1** Remote Desktop Connection Window

3. Tap Options >> to expand the window.

4. Tap the General tab.

5. In the Logon Settings section, enter the information for the computer to connect to.

6. Tap Save As.

7. Enter a name for the connection in the Name field. Save the file in the Application directory to make it persistent. Ensure the connection launches and connects to the desired computer or server.

8. Tap OK.
9. Double tap the **Remote Desktop** icon in application folder to launch connection.

10. Once connected to the remote computer, open an application such as Notepad or WordPad.

11. Position the cursor in the application window.

12. Scan a bar code. The data appears in the window.

---

**Figure B-2**  *Remote Computer Application*
Often Used Registry Settings

AutoHide Task Bar

Key Name: [HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Shell\AutoHide]

- Name: Default
- Data Type: dword
- Description: Controls the AutoHide feature of the Taskbar.
- Default Value: 00000000: AutoHide is off.
- Options:
  - 00000000: AutoHide is off.
  - 00000001: AutoHide is on.

Toggle Function Key

Key Name: [HKEY_LOCAL_MACHINE\HARDWARE\DEVICEMAP\KEYBD\{full-screen configurations}
[HKEY_LOCAL_MACHINE\HARDWARE\DEVICEMAP\KEYBD\Configurations\VC5090-QWERTY]
(half-screen configurations)

- Name: EnableToggleForFunc
- Data Type: dword
- Description: Controls the action of the Function key. By default, the Function key remains on once pressed (toggleing is disabled) and is turned off when pressed again. When toggle is enabled, the Function key turns off after another key is pressed.
- Default Value: 00000000: Toggle is disabled
- Options:
  - 00000000: Function key toggle is off (disabled).
  - 00000001: Function key toggle is on (enabled).

Toggle Shift Key

Key Name: [HKEY_LOCAL_MACHINE\HARDWARE\DEVICEMAP\KEYBD\{full-screen configurations}
[HKEY_LOCAL_MACHINE\HARDWARE\DEVICEMAP\KEYBD\Configurations\VC5090-QWERTY]
(half-screen configurations)

- Name: EnableToggleForShift
- Data Type: dword
- Description: Controls the action of the Shift key. By default, the Shift key remains on once pressed (toggleing is disabled) and is turned off when pressed again. When toggle is enabled, the Shift key turns off after another key is pressed.
- Default Value: 00000000: Toggle is disabled
- Options:
  - 00000000: Shift key toggle is off.
  - 00000001: Shift key toggle is on.
Power Suspend

To make the power suspend settings persistent:

**Key Name:** [HKEY_LOCAL_MACHINE\System\CurrentControlSet\Control\Power\Timeouts]

- **Name:** ACSuspendTimeout
  - **Data Type:** dword
  - **Description:** To suspend the device when not used for a certain period of time when operating on external power.
  - **Default Value:** 00000000: 0 seconds (never)
  - **Options:**
    - 00000000: Never.
    - 00000060: 1 minute.
    - 00000120: 2 minutes.
    - 00000180: 3 minutes.
    - 00000300: 5 minutes.
    - 00000600: 10 minutes.
    - 00000900: 15 minutes.
    - 00001800: 30 minutes.

- **Name:** BattSuspendTimeout
  - **Data Type:** dword
  - **Description:** To suspend the device when not used for a certain period of time when operating on battery power.
  - **Default Value:** 00000015: 15 seconds
  - **Options:**
    - 00000000: Never.
    - 00000030: 30 seconds.
    - 00000060: 1 minute.
    - 00000120: 2 minutes.
    - 00000180: 3 minutes.
    - 00000240: 4 minutes.
    - 00000300: 5 minutes.
    - 00000360: 6 minutes.

External Antenna

**Key Name:** [HKEY_CURRENT_USER\ControlPanel\SystemManagement\Antenna Selection]

- **Name:** SelectedAntenna
  - **Data Type:** dword
  - **Description:** Selects internal or external antenna.
  - **Default Value:** 00000000: Internal antenna.
  - **Options:**
    - 00000000: Internal antenna.
    - 00000001: External antenna.
Ignition Timeout

**Key Name:** [HKEY_CURRENT_USER\ControlPanel\SystemManagement\UPS]

- **Name:** Ignition Timeout
- **Data Type:** dword
- **Description:** Forklift ignition timeout
- **Default Value:** 00000180: 3 minutes.
- **Options:**
  - 00000000: Never.
  - 00000060: 1 minute.
  - 00000120: 2 minutes.
  - 00000180: 3 minutes.
  - 00000300: 5 minutes.
  - 00000600: 10 minutes.
  - 00000900: 15 minutes.
  - 00001800: 30 minutes.

Registry Values for P1/P2/P3 Keys

**Key Name:**
- [HKEY_LOCAL_MACHINE\SOFTWARE\symbol\ProgrammableKeys\P1]
- [HKEY_LOCAL_MACHINE\SOFTWARE\symbol\ProgrammableKeys\P2]
- [HKEY_LOCAL_MACHINE\SOFTWARE\symbol\ProgrammableKeys\P3]

- **Name:** Action
- **Data Type:** REG_dword
- **Description:** Sets the function of the Px key.
- **Default Value:** 00000000: No action.
- **Options:**
  - 00000000: No action.
  - 00000001: Launch Application.
  - 00000002: Simulate Key Press.
  - 00000003: Toggle SIP.
  - 00000004: Toggle Touch.
  - 00000005: Toggle Keylight.
  - 00000006: Play Key Sequence.
  - 00000007: Launch calibration.

- **Name:** ApplicationPath
- **Data Type:** String
- **Description:** Used to specify which application to invoke with the press of Px key. Required only when action is Launch Application.

- **Name:** CommandLine
- **Data Type:** String
- **Description:** Used to specify any command line argument to the application to be invoked with the press of Px key. Required only when action is Launch Application.
- **Name**: Modifier
  - **Data Type**: dword
  - **Description**: Used to specify modifier key for the simulated key press P1. Required only when action is Simulate Keypress.

- **Name**: RepeatKey
  - **Data Type**: dword
  - **Description**: Used to specify if repeat key is on or off. Required only when action is Simulate Keypress.

- **Name**: KeyPress
  - **Data Type**: String
  - **Description**: Used to specify key press for Simulate Key press. Required only when action is Simulate Keypress.

- **Name**: KeySequence
  - **Data Type**: String
  - **Description**: Used to specify key press for Simulate Key press. Required only when action is Simulate Keypress.
System Configuration Manager

System Configuration Manager (SCM) is a utility that runs on the host computer and is used to create configuration files. These files, when deployed to an vehicle computer, set configuration parameters for that device. The configurable options for a vehicle computer are defined in an XML file that is available on the Support Central. SCM is also available on Support Central.

SCM eliminates the potential user errors that occur when manually editing registry settings.

File Types

SCM uses three types of files:

- System Configuration Template (.SCT) files are XML files that define the configurable parameters for a device.
- Registry Configuration Service Provider XML files for device provisioning.
- CAB Provisioning Format (.CPF) file which is a .CAB archive that contains the provisioning XML. This file is downloaded to the EDA and merged upon a cold boot.

User Interface

SCM's user interface consists of a tree control on the left side of the window which displays all the configuration categories, and a data grid table on the right which displays all the configurable controls for the selected category. Figure B-3 shows the main window for a device’s .sct file.
Main SCM Window

Menu Functions

Use the main menu to access the program functionality described in Table B-1.

Table B-1  SCM Menu Functions

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Menu</td>
<td></td>
</tr>
<tr>
<td>Open Config File</td>
<td>Open a saved configuration file (.SCD).</td>
</tr>
<tr>
<td>Save Config Changes</td>
<td>Save changes to the currently loaded configuration file.</td>
</tr>
<tr>
<td>Restore All Defaults</td>
<td>Restore all parameter values to the default state. The default values are</td>
</tr>
<tr>
<td></td>
<td>stored in a System Configuration template file (i.e., VC5090.sct).</td>
</tr>
<tr>
<td>Get Defaults from Device</td>
<td>Load all parameter values from the current device.</td>
</tr>
<tr>
<td>Export Changes to .reg</td>
<td>Export the changed parameter values to a reg file.</td>
</tr>
<tr>
<td>Export Changes to .xml</td>
<td>Export the changed parameter values to an XML file.</td>
</tr>
</tbody>
</table>
The first column of the data table displays parameter state indicators. The state indicators display one of the states in Table B-2 for a particular parameter:

### Table B-2  Parameter Status Indicators

<table>
<thead>
<tr>
<th>Icon</th>
<th>Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Modified" /></td>
<td>Modified</td>
<td>This parameter was changed from its initial factory setting.</td>
</tr>
<tr>
<td><img src="image" alt="Invalid" /></td>
<td>Invalid</td>
<td>This parameter is not valid for the selected device type. This can occur when a configuration file for one type of device is loaded and the device type is changed using the Device menu. Values marked “invalid” are not included in an exported.</td>
</tr>
</tbody>
</table>
Window Status Bar

The SCM status bar found on the bottom right corner of the window contains the items in Table B-3 from left to right:

Table B-3 Window Status Bar Items

<table>
<thead>
<tr>
<th>Status Bar Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Invalid Count</td>
<td>Number of parameters not valid for the selected device.</td>
</tr>
<tr>
<td>Modified Count</td>
<td>Number of parameters modified from the factory defaults.</td>
</tr>
<tr>
<td>Device Type</td>
<td>Device type - version.</td>
</tr>
</tbody>
</table>

Figure B-4 Sample Status Bar

The sample status bar in Figure B-4 shows that the current configuration file contains 3 modified parameters.

File Deployment

The .reg file created by the SCM export function must be deployed to the VC5090.

1. Select File > Export changes to .reg to create a .reg file for only the changes made or select File > Export all to .reg to create a .reg file for all settings.

2. Copy the .reg file to the vehicle computer. See Working with FFS Partitions on page 7-23 for more information.

3. Tap the filename to install.

4. Certain applications and settings require a cold boot to take affect. In these cases, cold boot the VC5090. Refer to the Windows Mobile Version 5.0 Help file for more information.
Glossary

A

API. An interface by means of which one software component communicates with or controls another. Usually used to refer to services provided by one software component to another, usually via software interrupts or function calls.

Application Programming Interface. See API.

ASCII. American Standard Code for Information Interchange. A 7 bit-plus-parity code representing 128 letters, numerals, punctuation marks and control characters. It is a standard data transmission code in the U.S.

B

BIOS. Basic Input Output System. A collection of ROM-based code with a standard API used to interface with standard PC hardware.

Bit. Binary digit. One bit is the basic unit of binary information. Generally, eight consecutive bits compose one byte of data. The pattern of 0 and 1 values within the byte determines its meaning.

Bits per Second (bps). Bits transmitted or received.

bps. See Bits Per Second.

Byte. On an addressable boundary, eight adjacent binary digits (0 and 1) combined in a pattern to represent a specific character or numeric value. Bits are numbered from the right, 0 through 7, with bit 0 the low-order bit. One byte in memory is used to store one ASCII character.

boot or boot-up. The process a computer goes through when it starts. During boot-up, the computer can run self-diagnostic tests and configure hardware and software.
C

Cold Boot. A cold boot restarts the vehicle computer and erases all user stored records and entries.

COM port. Communication port; ports are identified by number, e.g., COM1, COM2.

D

Data Communications Equipment (DCE). A device (such as a modem) which is designed to attach directly to a DTE (Data Vehicle Computer Equipment) device.

DCE. See Data Communications Equipment.

DCP. See Device Configuration Package.

Device Configuration Package. The Device Configuration Package provides the Product Reference Guide (PRG), flash partitions, Vehicle Computer Configuration Manager (TCM) and the associated TCM scripts. With this package hex images that represent flash partitions can be created and downloaded to the vehicle computer.

DRAM. Dynamic random access memory.

DTE. See Data Vehicle Computer Equipment.

E

ENQ (RS-232). ENQ software handshaking is also supported for the data sent to the host.

ESD. Electro-Static Discharge

F

Flash Disk. An additional megabyte of non-volatile memory for storing application and configuration files.

Flash Memory. Flash memory is nonvolatile, semi-permanent storage that can be electronically erased in the circuit and reprogrammed. The vehicle computers use Flash memory to store the operating system, the vehicle computer emulators, and the Citrix ICA Client.

File Transfer Protocol (FTP). A TCP/IP application protocol governing file transfer via network or telephone lines. See TCP/IP.

FTP. See File Transfer Protocol.

Flash Memory. Flash memory is responsible for storing the system firmware and is non-volatile. If the system power is interrupted the data is not be lost.
H

Hard Reset. See Cold Boot.

Hz. Hertz; A unit of frequency equal to one cycle per second.

Host Computer. A computer that serves other vehicle computers in a network, providing such services as computation, database access, supervisory programs and network control.

I

IDE. Intelligent drive electronics. Refers to the solid-state hard drive type.

IEEE Address. See MAC Address.

IOCTL. Input/Output Control.

Internet Protocol Address. See IP.

I/O Ports. interface The connection between two devices, defined by common physical characteristics, signal characteristics, and signal meanings. Types of interfaces include RS-232 and PCMCIA.

Input/Output Ports. I/O ports are primarily dedicated to passing information into or out of the vehicle computer’s memory. VC5090 vehicle computers include Serial and USB ports.

IP. Internet Protocol. The IP part of the TCP/IP communications protocol. IP implements the network layer (layer 3) of the protocol, which contains a network address and is used to route a message to a different network or subnetwork. IP accepts “packets” from the layer 4 transport protocol (TCP or UDP), adds its own header to it and delivers a “datagram” to the layer 2 data link protocol. It may also break the packet into fragments to support the maximum transmission unit (MTU) of the network.

IP Address. (Internet Protocol address) The address of a computer attached to an IP network. Every client and server station must have a unique IP address. A 32-bit address used by a computer on an IP network. Client workstations have either a permanent address or one that is dynamically assigned to them each session. IP addresses are written as four sets of numbers separated by periods; for example, 204.171.64.2.

IPX/SPX. Internet Package Exchange/Sequential Packet Exchange. A communications protocol for Novell. IPX is Novell’s Layer 3 protocol, similar to XNS and IP, and used in NetWare networks. SPX is Novell’s version of the Xerox SPP protocol.

IS-95. Interim Standard 95. The EIA/TIA standard that governs the operation of CDMA cellular service. Versions include IS-95A and IS-95B. See CDMA.

L

LCD. See Liquid Crystal Display.
**LED Indicator.** A semiconductor diode (LED - Light Emitting Diode) used as an indicator, often in digital displays. The semiconductor uses applied voltage to produce light of a certain frequency determined by the semiconductor’s particular chemical composition.

**Liquid Crystal Display (LCD).** A display that uses liquid crystal sealed between two glass plates. The crystals are excited by precise electrical charges, causing them to reflect light outside according to their bias. They use little electricity and react relatively quickly. They require external light to reflect their information to the user.

**Light Emitting Diode.** See LED.

---

**M**

**MDN.** Mobile Directory Number. The directory listing telephone number that is dialed (generally using POTS) to reach a mobile unit. The MDN is usually associated with a MIN in a cellular telephone -- in the US and Canada, the MDN and MIN are the same value for voice cellular users. International roaming considerations often result in the MDN being different from the MIN.

**MIN.** Mobile Identification Number. The unique account number associated with a cellular device. It is broadcast by the cellular device when accessing the cellular system.

---

**N**

**NVM.** Non-Volatile Memory.

---

**O**

**ODI.** See Open Data-Link Interface.

**Open Data-Link Interface (ODI).** Novell’s driver specification for an interface between network hardware and higher-level protocols. It supports multiple protocols on a single NIC (Network Interface Controller). It is capable of understanding and translating any network information or request sent by any other ODI-compatible protocol into something a NetWare client can understand and process.

**Open System Authentication.** Open System authentication is a null authentication algorithm.

---

**P**

**PAN.** Personal area network. Using Bluetooth wireless technology, PANs enable devices to communicate wirelessly. Generally, a wireless PAN consists of a dynamic group of less than 255 devices that communicate within about a 33-foot range. Only devices within this limited area typically participate in the network.

**Parameter.** A variable that can have different values assigned to it.
PING. (Packet Internet Groper) An Internet utility used to determine whether a particular IP address is online. It is used to test and debug a network by sending out a packet and waiting for a response.

Print Contrast Signal (PCS). Measurement of the contrast (brightness difference) between the bars and spaces of a symbol. A minimum PCS value is needed for a bar code symbol to be scannable. PCS = (RL - RD) / RL, where RL is the reflectance factor of the background and RD the reflectance factor of the dark bars.

Programming Mode. The state in which a scanner is configured for parameter values. See Scanning Mode.

Q

QWERTY. A standard keyboard commonly used on North American and some European PC keyboards. “QWERTY” refers to the arrangement of keys on the left side of the third row of keys.

R

RAM. Random Access Memory. Data in RAM can be accessed in random order, and quickly written and read.

Reflectance. Amount of light returned from an illuminated surface.

Resolution. The narrowest element dimension which is distinguished by a particular reading device or printed with a particular device or method.

RF. Radio Frequency.

ROM. Read-Only Memory. Data stored in ROM cannot be changed or removed.

Router. A device that connects networks and supports the required protocols for packet filtering. Routers are typically used to extend the range of cabling and to organize the topology of a network into subnets. See Subnet.

RS-232. An Electronic Industries Association (EIA) standard that defines the connector, connector pins, and signals used to transfer data serially from one device to another.

S

Scanner. An electronic device used to scan bar code symbols and produce a digitized pattern that corresponds to the bars and spaces of the symbol. Its three main components are: 1) Light source (laser or photoelectric cell) - illuminates a bar code; 2) Photodetector - registers the difference in reflected light (more light reflected from spaces); 3) Signal conditioning circuit - transforms optical detector output into a digitized bar pattern.

SDK. Software Development Kit

Shared Key. Shared Key authentication is an algorithm where both the AP and the MU share an authentication key.

SID. System Identification code. An identifier issued by the FCC for each market. It is also broadcast by the cellular carriers to allow cellular devices to distinguish between the home and roaming service.
SMDK. Symbol Mobility Developer’s Kit.

Soft Reset. See Warm Boot.

Subnet. A subset of nodes on a network that are serviced by the same router. See Router.

Subnet Mask. A 32-bit number used to separate the network and host sections of an IP address. A custom subnet mask subdivides an IP network into smaller subsections. The mask is a binary pattern that is matched up with the IP address to turn part of the host ID address field into a field for subnets. Default is often 255.255.255.0.

Substrate. A foundation material on which a substance or image is placed.

SVTP. Symbol Virtual Vehicle Computer Program.

TCP/IP. (Transmission Control Protocol/Internet Protocol) A communications protocol used to internetwork dissimilar systems. This standard is the protocol of the Internet and has become the global standard for communications. TCP provides transport functions, which ensures that the total amount of bytes sent is received correctly at the other end. UDP is an alternate transport that does not guarantee delivery. It is widely used for real-time voice and video transmissions where erroneous packets are not retransmitted. IP provides the routing mechanism. TCP/IP is a routable protocol, which means that all messages contain not only the address of the destination station, but the address of a destination network. This allows TCP/IP messages to be sent to multiple networks within an organization or around the world, hence its use in the worldwide Internet. Every client and server in a TCP/IP network requires an IP address, which is either permanently assigned or dynamically assigned at startup.

Telnet. A vehicle computer emulation protocol commonly used on the Internet and TCP/IP-based networks. It allows a user at a vehicle computer or computer to log onto a remote device and run a program.

Terminal Computer Emulation. A “terminal computer emulation” emulates a character-based mainframe session on a remote non-mainframe terminal computer, including all display features, commands and function keys. The VC5090 Series supports Terminal Computer Emulations in 3270, 5250 and VT220.

TFTP. (Trivial File Transfer Protocol) A version of the TCP/IP FTP (File Transfer Protocol) protocol that has no directory or password capability. It is the protocol used for upgrading firmware, downloading software and remote booting of diskless devices.

Tolerance. Allowable deviation from the nominal bar or space width.

Transmission Control Protocol/Internet Protocol. See TCP/IP.

Trivial File Transfer Protocol. See TFTP.

UDP. User Datagram Protocol. A protocol within the IP protocol suite that is used in place of TCP when a reliable delivery is not required. For example, UDP is used for real-time audio and video traffic where lost packets are simply ignored,
because there is no time to retransmit. If UDP is used and a reliable delivery is required, packet sequence checking and error notification must be written into the applications.

V

VC. Vehicle Computer.

Vehicle Computer. In this text, vehicle computer refers to the VC5090 vehicle computer. It can be set up to run as a stand-alone device, or it can be set up to communicate with a network, using wireless radio technology.

W

Warm Boot. A warm boot restarts the vehicle computer by closing all running programs. All data that is not saved to flash memory is lost.
Index

**Numerics**

<table>
<thead>
<tr>
<th>Term</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>128-Bit WEP</td>
<td>4-16</td>
</tr>
<tr>
<td>40-Bit WEP</td>
<td>4-16</td>
</tr>
<tr>
<td>802.11 ESSID</td>
<td>4-5</td>
</tr>
<tr>
<td>802.11a/b/g</td>
<td>1-2</td>
</tr>
<tr>
<td>AC power supply</td>
<td>2-16</td>
</tr>
<tr>
<td>accessories</td>
<td>1-4</td>
</tr>
<tr>
<td>active tasks</td>
<td>3-13</td>
</tr>
<tr>
<td>ActiveSync</td>
<td>6-1</td>
</tr>
<tr>
<td>downloading files</td>
<td>7-3</td>
</tr>
<tr>
<td>installing</td>
<td>6-2</td>
</tr>
<tr>
<td>setting up a connection</td>
<td>6-3</td>
</tr>
<tr>
<td>ActiveSync connection</td>
<td>2-38</td>
</tr>
<tr>
<td>Ad Hoc</td>
<td>4-6</td>
</tr>
<tr>
<td>Adaptive Frequency Hopping</td>
<td>5-1</td>
</tr>
<tr>
<td>ad-hoc</td>
<td>4-6</td>
</tr>
<tr>
<td>ad-hoc networks</td>
<td>4-34</td>
</tr>
<tr>
<td>Advanced Encryption Standard</td>
<td>4-16</td>
</tr>
<tr>
<td>AES</td>
<td>4-16</td>
</tr>
<tr>
<td>AFH</td>
<td>5-1</td>
</tr>
<tr>
<td>allocating memory</td>
<td>3-10</td>
</tr>
<tr>
<td>antennas</td>
<td>1-2</td>
</tr>
<tr>
<td>AP networks</td>
<td>4-34</td>
</tr>
<tr>
<td>authentication</td>
<td>4-8</td>
</tr>
<tr>
<td>EAP-TLS</td>
<td>4-9</td>
</tr>
<tr>
<td>LEAP</td>
<td>4-9</td>
</tr>
<tr>
<td>none</td>
<td>4-9</td>
</tr>
<tr>
<td>PEAP</td>
<td>4-9</td>
</tr>
<tr>
<td>backup battery</td>
<td>3-22</td>
</tr>
<tr>
<td>battery check status</td>
<td>3-22</td>
</tr>
<tr>
<td>battery icon</td>
<td>3-11</td>
</tr>
<tr>
<td>battery status</td>
<td>3-11</td>
</tr>
<tr>
<td>Bluetooth</td>
<td>5-1</td>
</tr>
<tr>
<td>disable</td>
<td>5-2</td>
</tr>
<tr>
<td>enable</td>
<td>5-2</td>
</tr>
<tr>
<td>turning off</td>
<td>5-2</td>
</tr>
<tr>
<td>turning on</td>
<td>5-2</td>
</tr>
<tr>
<td>bluetooth</td>
<td></td>
</tr>
<tr>
<td>adaptive frequency hopping</td>
<td>5-1</td>
</tr>
<tr>
<td>ad-hoc mode</td>
<td>4-6</td>
</tr>
<tr>
<td>bonding</td>
<td>5-9</td>
</tr>
<tr>
<td>deleting bonded device</td>
<td>5-11</td>
</tr>
<tr>
<td>discovering devices</td>
<td>5-8</td>
</tr>
<tr>
<td>icon</td>
<td>3-12</td>
</tr>
<tr>
<td>renaming bonded device</td>
<td>5-10</td>
</tr>
<tr>
<td>Bluetooth scanner</td>
<td>2-30</td>
</tr>
<tr>
<td>Bluetooth security</td>
<td>5-2</td>
</tr>
<tr>
<td>bonding, bluetooth</td>
<td>5-9</td>
</tr>
<tr>
<td>boot</td>
<td></td>
</tr>
<tr>
<td>cold</td>
<td>3-16</td>
</tr>
<tr>
<td>warm</td>
<td>5-3</td>
</tr>
<tr>
<td>bullets</td>
<td>xvi</td>
</tr>
<tr>
<td>buttons</td>
<td></td>
</tr>
<tr>
<td>P keys</td>
<td>3-3</td>
</tr>
<tr>
<td>CAB files</td>
<td>B-9</td>
</tr>
<tr>
<td>cables</td>
<td></td>
</tr>
<tr>
<td>routing</td>
<td>2-9</td>
</tr>
<tr>
<td>calibration</td>
<td>3-18</td>
</tr>
<tr>
<td>CHAP</td>
<td>4-10</td>
</tr>
<tr>
<td>cleaning</td>
<td>9-1</td>
</tr>
<tr>
<td>clock, display</td>
<td>3-14</td>
</tr>
</tbody>
</table>

**A**

- AC power supply ........................................ 2-16
- accessories .............................................. 1-4
  - connecting ............................................. 2-38
- active tasks ............................................ 3-13
- ActiveSync .............................................. 6-1
  - downloading files .................................... 7-3
  - installing ............................................. 6-2
  - setting up a connection ............................... 6-3
- ActiveSync connection .................................. 2-38
- Ad Hoc .................................................... 4-6
- Adaptive Frequency Hopping ............................ 5-1
- ad-hoc .................................................... 4-6
- ad-hoc networks ........................................ 4-34
- Advanced Encryption Standard .......................... 4-16
- AES ........................................................ 4-16
- AFH .......................................................... 5-1
- allocating memory ....................................... 3-10
- antennas .................................................. 1-2
- AP networks .............................................. 4-34
- authentication .......................................... 4-8
  - EAP-TLS ................................................ 4-9
  - LEAP .................................................... 4-9
  - none .................................................... 4-9
  - PEAP .................................................... 4-9
- backup battery .......................................... 3-22
- battery check status .................................... 3-22
- battery icon .............................................. 3-11
- battery status .......................................... 3-11
- Bluetooth ................................................ 5-1
  - disable ............................................... 5-2
  - enable ................................................. 5-2
  - turning off ........................................... 5-2
  - turning on ............................................. 5-2
- bluetooth ............................................... .......
  - adaptive frequency hopping .......................... 5-1
  - ad-hoc mode .......................................... 4-6
  - bonding .............................................. 5-9
  - deleting bonded device ............................... 5-11
  - discovering devices ................................ 5-8
  - icon ................................................... 3-12
  - renaming bonded device ............................... 5-10
- Bluetooth scanner ...................................... 2-30
- Bluetooth security ...................................... 5-2
- bonding, bluetooth ...................................... 5-9
- boot ....................................................... 3-16
  - cold ................................................... 5-3
  - warm .................................................... 5-3
- buttons ................................................... xvi
- bullets ....................................................
- P keys .................................................... 3-3

**B**

- backlight control ....................................... 3-3
- backup battery .......................................... 3-22
- battery check status .................................... 3-22
- battery icon .............................................. 3-11
- battery status .......................................... 3-11
- Bluetooth ................................................ 5-1
  - disable ............................................... 5-2
  - enable ................................................. 5-2
  - turning off ........................................... 5-2
  - turning on ............................................. 5-2
- Bluetooth ............................................... .......
  - adaptive frequency hopping .......................... 5-1
  - ad-hoc mode .......................................... 4-6
  - bonding .............................................. 5-9
  - deleting bonded device ............................... 5-11
  - discovering devices ................................ 5-8
  - icon ................................................... 3-12
  - renaming bonded device ............................... 5-10
- Bluetooth scanner ...................................... 2-30
- Bluetooth security ...................................... 5-2
- bonding, bluetooth ...................................... 5-9
- boot ....................................................... 3-16
  - cold ................................................... 5-3
  - warm .................................................... 5-3
- bullets ................................................... xvi
- buttons ...................................................
cold boot .............................................. 3-16, 5-3, 7-23
COMM LED ........................................ 3-2
configurations ..................................... xiv
connecting a scanner .............................. 2-38
connecting accessories ............................ 2-38
contrast .............................................. 3-9
conventions
  notational ....................................... xv
country code ....................................... 4-7
cpf file ............................................. B-9
creating cpf file
  SCM .............................................. B-9
creating splash screen ............................ 7-22
critical suspend ................................... 3-16
current time ....................................... 3-11

data capture .................................... xiv
date/time ......................................... 3-11
DCP .................................................. 7-1
DCP for VC5090c ................................ xvi, 7-6, 7-9, 7-22, 7-23
default gateway ................................... 4-18
deleting bluetooth bond ........................... 5-11
deployment
  file ............................................... B-12
desiccant kit ..................................... 1-2
desk-mounted ....................................... 2-16
Device Configuration Package ................. 7-1
Device Configuration Package for VC5090c xvi, 7-6, 7-9, 7-22, 7-23
dhcp ................................................. 4-18
display .............................................. xiv, 1-2
display clock ....................................... 3-14
DNS ................................................. 4-18, 4-19
downloading files ................................ 7-3
DS3408 serial scanner
  installing ........................................ 2-20
DS3408 USB scanner
  installing ........................................ 2-21
DS3478 USB scanner
  installing ........................................ 2-24
DS378 serial scanner
  installing ........................................ 2-23

EAP TLS ............................................. 4-8
EAP-TLS ............................................ 4-9
EMDK for .NET ..................................... 7-1
EMDK for Java ..................................... 7-1
encryption ........................................ 4-16
open system ...................................... 4-16, 4-18

TKIP (WPA) ............................................. 4-16
end task ............................................ 3-16
Enterprise Mobility Developer Kit for .NET 7-1
Enterprise Mobility Developer Kit for Java 7-1
error messages .................................... 7-18, 7-20
ESSID ............................................. 4-5
external antenna .................................. 2-31
external keyboard ............................... 2-18
external speaker .................................. 2-38

favorites ......................................... 3-12
file deployment .................................. B-12
file explorer ..................................... 7-6
files
  saving ........................................... 3-10
flash file system ................................. 7-22, 7-24
copyfile .......................................... 7-23
downloading partitions ........................... 7-24
non-FFS partitions ............................... 7-24
partitions ......................................... 7-22
regmerge ......................................... 7-23
flash storage ...................................... 7-22
forklift ............................................ 2-5
frequency-hopping spread spectrum .......... 5-1
fuse holder ....................................... 2-13, 2-15
fuses .............................................. 2-13

gateway .......................................... 4-19

hard reset ........................................ 3-16, 5-3
help ................................................ 3-12

icons
  bluetooth ....................................... 3-12
ignition sense .................................... 2-13, 2-14, 2-15, 3-22
Industry Scientific and Medical ............... 5-1
information, service ........................... xvi
infrastructure .................................... 4-6
Initial Program Loader .......................... 7-24
installation ....................................... 2-5
installing development tools ................. 7-3
installing the vehicle computer ............. 2-13
installing your vehicle computer ............. 2-5
IP address ........................................ 4-19
IP config
  DNS ............................................. 4-19
gateway .......................... 4-19
IP address .......................... 4-19
subnet mask .......................... 4-19
WINS .......................... 4-19
IPL .................................. 7-24
error messages .......................... 7-20
error screen .......................... 7-20

K
keyboard ........................................ 3-5
descriptions ........................................ 3-6
keyboard backlight ................................ 3-10
keyboard input panel .......................... 3-11
keypad ........................................ xiv

L
LEAP ........................................ 4-8, 4-9
LS3203 serial scanner .......................... 2-20
installing ........................................ 2-20
LS3408 serial scanner .......................... 2-20
installing ........................................ 2-20
LS3408 USB scanner .......................... 2-21
installing ........................................ 2-21
LS3478 serial scanner .......................... 2-23
installing ........................................ 2-23
LS3478 USB scanner .......................... 2-24
installing ........................................ 2-24

M
maintenance ........................................ 9-1
MD5 ........................................ 4-10
memory ........................................ xiv, 1-2
allocation ........................................ 3-10
mobile computer .......................... cold boot ........................................ 3-10
mode ........................................ 802.11 ESSID ........................................ 4-5
ad-hoc ........................................ 4-6
country ........................................ 4-7
infrastructure ........................................ 4-6
operating ........................................ 4-6
profile name ........................................ 4-5
mounting bracket ........................................ 1-2, 2-4
MS CHAP ........................................ 4-10
MS CHAP v2 ........................................ 4-10

N
non-FFS ........................................ 7-24
non-FFS partitions .......................... 7-24
IPL ........................................ 7-24
splash screen ........................................ 7-24

O
open system ........................................ 4-16, 4-18
operating environment, mobile computer ........................................ A-1
operating mode ........................................ 4-6
operating system ........................................ xiv

P
P keys ........................................ 3-3
PAP ........................................ 4-10
partitions ........................................ 7-24
downloading ........................................ 7-24
FFS ........................................ 7-22
non-FFS ........................................ 7-24
PEAP ........................................ 4-8, 4-9
pin-outs ........................................ A-4
positioning the vehicle computer ........................................ 2-5
power button ........................................ 3-1
power LED ........................................ 3-2
power to the vehicle computer ........................................ 2-16
print ........................................ 1-2
profile ........................ create new ........................................ 4-23
delete ........................................ 4-24
edit ........................................ 4-23
profile name ........................................ 4-5
program menu ........................................ 3-13
programmable keys ........................................ 3-3
programs ........................ flash file system ........................................ 7-22
properties ........................................ 3-13
providing power ........................................ 2-16

Q
quick access panel ........................................ 3-1

R
radios ........................................ xiv
renaming bluetooth bond ........................................ 5-10
reset ........................ hard ........................................ 3-16, 5-3
soft ........................................ 5-3
resetting ........................................ 3-16
resume ........................................ 5-3
routing electrical cables ........................................ 2-9
run ........................................ 3-12

IPL ........................................ 7-24
splash screen ........................................ 7-24
open system ........................................ 4-16, 4-18
operating environment, mobile computer ........................................ A-1
operating mode ........................................ 4-6
operating system ........................................ xiv

P keys ........................................ 3-3
PAP ........................................ 4-10
partitions ........................................ 7-24
downloading ........................................ 7-24
FFS ........................................ 7-22
non-FFS ........................................ 7-24
PEAP ........................................ 4-8, 4-9
pin-outs ........................................ A-4
positioning the vehicle computer ........................................ 2-5
power button ........................................ 3-1
power LED ........................................ 3-2
power to the vehicle computer ........................................ 2-16
print ........................................ 1-2
profile ........................ create new ........................................ 4-23
delete ........................................ 4-24
edit ........................................ 4-23
profile name ........................................ 4-5
program menu ........................................ 3-13
programmable keys ........................................ 3-3
programs ........................ flash file system ........................................ 7-22
properties ........................................ 3-13
providing power ........................................ 2-16
quick access panel ........................................ 3-1
radios ........................................ xiv
renaming bluetooth bond ........................................ 5-10
reset ........................ hard ........................................ 3-16, 5-3
soft ........................................ 5-3
resetting ........................................ 3-16
resume ........................................ 5-3
routing electrical cables ........................................ 2-9
run ........................................ 3-12

saving files ........................................... 3-10
scanner
  Bluetooth ........................................ 2-20
  connecting ..................................... 2-38
  disable ......................................... 2-29
  enable .......................................... 2-29
  setup ........................................... 2-27
scanners ........................................... 2-20
SCM
  file deployment ................................ B-12
  file types ...................................... B-9
  menu ............................................. B-10
  parameter indicators .......................... B-11
  user interface ................................ B-9
  XML provisioning ............................... B-9
screen brightness ................................ 3-9
screen calibration ................................ 3-18
scripts
  creating ........................................ 7-9
  saving ......................................... 7-10
SerialWedge ....................................... 2-28
service information ................................ xvi
setting up a partnership
  partnership ..................................... 6-3
settings .......................................... 3-12
show clock ....................................... 3-14
signal strength ................................. 4-2, 4-26
soft input panel ................................ 3-6
soft keyboard ................................... 3-11
soft reset ........................................ 5-3
speakers .......................................... 1-2
spectrum24 status ................................ 3-11
splash screen .................................... 7-24
  creating ....................................... 7-22
start menu ....................................... 3-12
static ............................................. 4-18
status ............................................. 3-11
status icon ...................................... 3-11
StoneStreet One .................................. 5-1
subnet mask ...................................... 4-19
suspend .......................................... 3-12, 3-16, 5-3
suspending vehicle computer operation
  API .............................................. 3-16
  manual ......................................... 3-16
Symbol configuration manager
  file deployment ................................ B-12
  file types ...................................... B-9
  menu ............................................ B-10
  parameter indicators ........................ B-11
  user interface ................................ B-9
  XML provisioning .............................. B-9

T

  task manager ................................... 3-13
  taskbar ......................................... 3-13
  status icons ................................... 3-10

TCM
  building hex image ............................. 7-6, 7-10, 7-11
  creating script ................................ 7-9
  defining properties ........................... 7-8
  error messages ................................ 7-18
  hex image download ............................ 7-11
  saving script ................................... 7-10
  starting ......................................... 7-6

technical specifications, mobile computer .. A-1
TKIP (WPA) ......................................... 4-16
TLS ................................................. 4-10
troubleshooting ................................ 9-2
can't see screen ................................ 9-2
vehicle computer fails to power up ........ 9-2
TTLS ............................................... 4-8

U

  USB .............................................. 2-38

V

  vehicle
    12-24V gasoline, diesel, propane ........ 2-13
  vehicle battery ................................ 2-13, 2-15

vehicle computer
  calibration ..................................... 3-18
  charging ....................................... 3-11
  contrast ....................................... 3-9
  installation ................................... 2-5
  installing ...................................... 2-13
  keyboard ...................................... 3-5
  keyboard descriptions ........................ 3-6
  memory allocation ................................ 3-10
  pin-outs ....................................... A-4
  positioning .................................... 2-5
  providing power ................................ 2-16
  routing electrical cables .................... 2-9
  volume ......................................... 3-10
vehicle computer charging ..................... 3-11
vehicle in-motion detector cable ............. 2-32
vehicle power cable ................................ 1-2
Visual Studio 2005 ................................ 7-1
volume .......................................... 3-10
  adjusting ...................................... 3-10

W

  wakeup .......................................... 3-17
warm boot ........................................ 3-16, 5-3
Windows CE .NET 5.0 Professional ........ 3-13
WINS ............................................. 4-18, 4-19
wireless local area networks .............. 4-1
WLAN radio
turn off ........................................... 4-2
turn on .......................................... 4-3

X

XML provisioning
SCM .......................................... B-9